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0003 1. Descrizione generale

Configurazione del sistema

Pacchetto 
microfono 
wireless  
UWP-D21 
UWP-D22 
UWP-D26

Ricevitore 
microfono 
wireless 
URX-P03D

Adattatore slitta 
Multi-interface 
SMAD-P5 
SMAD-P3D

Adattatore 
A-mount 
LA-EA3 
LA-EA4

Adattatore per 
ottiche B4 
LA-EB1

Obiettivo con 
innesto E-mount

Microfono 
ECM-MS2

Unità 
telecomando 
RM-30BP

Telecomando a 
infrarossi (fornito) 
RMT-845

Impugnatura di telecomando (fornita)

PXW-FS7M2

Aste di supporto a spalla leggere 
VCT-FS7

Modulo LAN 
wireless USB  
IFU-WLM3 (fornito)

Kit adattatore 
XLR 
XLR-K2M 
XLR-K3M

Luce video 
HVL-LBPC

Scheda di memoria XQD  
serie S/N/M/H/G

Pacco batteria  
serie BP-U 
(BP-U35 fornito)

Unità di 
estensione 
XDCA-FS7

Lettore schede XQD 
MRW-E90

Adattatore CA/caricabatterie 
BC-U1A (fornito), BC-U2A

Unità di interfaccia  
HXR-IFR5

Unità di estensione Piastra di appoggio 
a spalla

CBK-FS7BK

Mirino

Piastra superiore

Registratore portatile 
a scheda di memoria 
AXS-R5

Adattatore wireless 
CBK-WA100

[Nota]
È possibile che alcuni dei dispositivi periferici ed accessori mostrati nelle figure non siano più in produzione. Per consigli sulla 
scelta dei dispositivi, rivolgersi al proprio rivenditore Sony o a un rappresentante commerciale Sony.
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Posizione e funzione delle parti
Lato sinistro, lato anteriore e maniglia

8
9
10
11
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15 16 17 18
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3
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6
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7

1.	 Maniglia (pagina 5)

2.	 Connettore mirino (pagina 15)

3.	 Connettore REMOTE (pagina 18)

4.	 Selettore INPUT1 (LINE/MIC/MIC+48V) 
(pagina 36)

5.	 Appoggio per riprese a spalla (pagina 20)

6.	 Selettore INPUT2 (LINE/MIC/MIC+48V) 
(pagina 36)

7.	 Attacco impugnatura (pagina 18)

8.	 Connettore modulo LAN wireless USB 
(pagina 44)

9.	 Indicatore registrazione (pagina 78)
Lampeggia quando la capacità rimanente del 
supporto di registrazione o della batteria è bassa.

10.	 Blocchetto della ghiera di blocco obiettivo 
(pagina 18)

11.	 Gancio per metro a nastro
Il gancio del metro a nastro si trova sullo stesso 
piano del sensore immagine. Per misurare 

con precisione la distanza tra il camcorder e il 
soggetto, utilizzare questo gancio come punto 
di riferimento. Fissare l’estremità di un metro a 
nastro a questo gancio per misurare la distanza del 
soggetto.

12.	 Pulsante WB SET (impostazione 
bilanciamento del bianco) (pagina 35)

13.	 Perno di blocco obiettivo (pagina 18)

14.	 Ghiera di blocco obiettivo (pagina 18)

15.	 Slitta accessori (pagina 4)

16.	 Pulsante START/STOP registrazione della 
maniglia

Il pulsante di registrazione non può essere 
azionato quando la levetta di blocco si trova in 
posizione di blocco.

17.	 Levetta dello zoom sulla maniglia 
(pagina 57)

18.	 Slitta Multi-interface

Per informazioni dettagliate sulla gamma di 
accessori utilizzabili con la slitta Multi-interface, 
rivolgersi al proprio rappresentante di vendita.

Montaggio della slitta accessori

1	 Sollevare il bordo anteriore della molla della 
slitta e tirare la molla nella direzione opposta a 
quella indicata dalla freccia incisa sulla slitta 
stessa.

Molla della slitta

Slitta accessori

1

2	 Posizionare la slitta accessori sulla sua sede di 
montaggio, allineando le sporgenze della slitta 
con il punti corrispondenti della sede di 
montaggio, quindi serrare le quattro viti.

3	 Inserire la molla della slitta nella direzione della 
freccia in modo che la porzione a forma di U si 
inserisca in fondo alla slitta.

3 22

Molla della slitta

Slitta accessori
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Rimozione della slitta accessori

Rimuovere la molla della slitta come descritto 
al passo 1 del paragrafo “Montaggio della slitta 
accessori” (pagina 4), svitare le quattro viti e 
rimuovere la slitta accessori.

Montaggio della piastra di protezione del modulo 
LAN wireless USB

1	 Rimuovere la vite di montaggio della maniglia.

2	 Montare la piastra di protezione, quindi 
stringere la vite.

1 2

Rimozione della maniglia

Per rimuovere la maniglia dal camcorder, svitare le 
sue quattro viti di fissaggio.

Montaggio del coperchietto di protezione del 
connettore della maniglia (in dotazione)

Quando si usa il camcorder senza la maniglia, 
proteggere il connettore con il coperchietto di 
protezione in dotazione.

Protezione dei terminali del connettore

Montare il coperchietto sui connettori non 
utilizzati per proteggere i terminali del connettore.

Lato superiore

1

2

1.	 Fori filettati per estensioni (3/8 di pollice)
Compatibili con viti UNC 3/8-16 (lunghezza max. 
10,0 mm).

2.	 Fori filettati per estensioni (1/4 di pollice)
Compatibili con viti UNC 1/4-20 (lunghezza max. 
7,0 mm).
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Lato destro
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1.	 Pulsante FULL AUTO (pagina 31)

2.	 Selettore HOLD (pagina 78)

3.	 Pulsante START/STOP registrazione

4.	 Manopola ND FILTER (pagina 35)

5.	 Pulsanti programmabili ASSIGN. da 1 a 3 
(pagina 38)

6.	 Selettore PRESET/VARIABLE (pagina 35)

7.	 Selettore ND/IRIS  

8.	 Manopola ND/IRIS
La manopola ND è attiva quando il selettore ND/
IRIS si trova sulla posizione ND. La manopola 
ND è attiva quando il selettore ND/IRIS si trova 
sulla posizione IRIS. È possibile assegnare un’altra 
funzione alla manopola IRIS (pagina 38) .

9.	 Pulsante IRIS (pagina 34)

10.	 Pulsante PUSH AUTO IRIS (pagina 34)

11.	 Selettore FOCUS (pagina 32)

12.	 Pulsante PUSH AUTO FOCUS (pagina 32)

13.	 Indicatore POWER (pagina 31)

14.	 Interruttore POWER (pagina 13)

15.	 Pulsanti programmabili ASSIGN. da 7 a 10 
(pagina 38)

16.	 Selettore CH1 LEVEL CONTROL (pagina 36)

17.	 Manopola CH1 INPUT LEVEL (pagina 36)

18.	 Selettore CH2 LEVEL CONTROL (pagina 36)

19.	 Manopola CH2 INPUT LEVEL (pagina 36)

20.	 Pulsante SLOT SELECT (selezione della 
scheda di memoria XQD) (pagina 24)

21.	 Pulsante CANCEL/BACK (pagina 48)

22.	 Pulsante MENU (pagina 50)

23.	 Pulsante THUMBNAIL (pagina 47)

24.	 Pulsante destro
Consente di impostare valori numerici e spostare 
il cursore a destra nelle schermate delle miniature 
e nei menu.

25.	 Manopola SEL/SET (seleziona/imposta)
Ruotare la manopola per spostare il cursore 
verso l’alto o il basso e selezionare voci di menu 
o impostazioni. Premere per applicare la voce 
selezionata.

26.	 Pulsante sinistro
Consente di impostare valori numerici e spostare 
il cursore a sinistra nelle schermate delle miniature 
e nei menu.

27.	 Pulsante SHUTTER (pagina 34)

28.	 Selettore WHT BAL (selezione memoria 
bilanciamento del bianco) (pagina 35)

29.	 Pulsante WHT BAL (bilanciamento del 
bianco) (pagina 35)

30.	 Selettore ISO/GAIN (pagina 34)

31.	 Pulsante ISO/GAIN (pagina 34)

32.	 Pulsante DISPLAY (pagina 9)

33.	 Pulsante STATUS CHECK (pagina 11)
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Slot schede, lato posteriore e terminali
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1.	 Jack cuffie (pagina 33)

2.	 Slot scheda XQD A (pagina 23)

3.	 Slot scheda UTILITY SD (pagina 26)

4.	 Indicatore di accesso XQD (A) (pagina 24)

5.	 Indicatore di accesso scheda SD 
(pagina 26)

6.	 Indicatore di accesso XQD (B (pagina 24)

7.	 Connettore USB
Consente il collegamento a un computer 
mediante un cavo USB per accedere ai supporti di 
registrazione inseriti in uno slot per schede XQD 
del camcorder.

8.	 Slot scheda XQD B (pagina 24)

9.	 Altoparlante incorporato (pagina 33)

10.	 Pulsante rilascio coperchio schede 
(pagina 24)

11.	 Connettore unità di estensione (pagina 27)

12.	 Indicatore registrazione posteriore 
(pagina 31)

13.	 Connettore DC IN (pagina 13)

14.	 Pulsante BATT RELEASE (pagina 13)

15.	 Batteria (pagina 13)

16.	 Attacco pacco batteria (pagina 13)

17.	 Sensore ricevitore telecomando infrarossi 
(pagina 29)

18.	 Microfono interno (pagina 36)
Microfono di narrazione per la registrazione 
dell’audio ambientale.

19.	 Connettore INPUT1 (ingresso audio 1) 
(pagina 36)

20.	 Connettore INPUT2 (ingresso audio 2) 
(pagina 36)

21.	 Connettore SDI OUT 1 (pagina 82)

22.	 Connettore SDI OUT 2 (pagina 82)

23.	 Connettore HDMI OUT (pagina 82)

Lato inferiore

1

1.	 Fori filettati di montaggio del treppiede 
(1/4 poll., 3/8 poll.)

Consente il montaggio su un treppiede (opzionale, 
vite di lunghezza max. 5,5 mm) che utilizza viti 1/4-
20 UNC o 3/8-16 UNC.

Mirino

Per informazioni dettagliate sul montaggio di 
mirino (in dotazione) e oculare, pagina 15.

1
2
3

4 5

1.	 Manopola CONTRAST

2.	 Pulsante PEAKING

3.	 Pulsante ZEBRA

4.	 Selettore MIRROR

5.	 Ganci di montaggio oculare

Oculare

Per informazioni dettagliate sul montaggio 
dell’oculare (in dotazione), pagina 16.

1 2

1.	 Manopola di regolazione diottrica

2.	 Coppa dell’oculare
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Paraluce del mirino

Per informazioni dettagliate sul montaggio 
del paraluce del mirino (in dotazione), vedere 
pagina 17.

Impugnatura di telecomando

Per informazioni dettagliate sul montaggio 
dell’impugnatura di telecomando (in dotazione), 
pagina 18.

1
2
3

4

5
6
7
8

1.	 Levetta dello zoom

2.	 Pulsante programmabile ASSIGN 4

3.	 Manopola programmabile

4.	 Pulsante programmabile ASSIGN 6

5.	 Pulsante START/STOP registrazione

6.	 Multiselettore

7.	 Pulsante di rotazione impugnatura

8.	 Pulsante programmabile ASSIGN 5 

Telecomando ad infrarossi

8

9

10

11
12

13

1
2
3
4
5
6

7

1.	 Pulsante DATA CODE
Non utilizzato in questa versione.

2.	 Pulsante TC RESET

3.	 Pulsante SCAN/SLOW

4.	  Pulsanti / (PREV/NEXT) 

5.	 Pulsante PLAY

6.	 Pulsante STOP

7.	 Pulsante DISPLAY

8.	 Trasmettitore del telecomando

9.	 Pulsante START/STOP

10.	 Levetta dello zoom

11.	 Pulsante PAUSE

12.	 Pulsante MODE
Non utilizzato in questa versione.

13.	  Pulsanti ////ENTER

Unità di estensione (opzione)

Per informazioni dettagliate sul montaggio 
dell’unità di estensione (opzione), pagina 27.

1

2
3
4

7
8
9
10

5
6

1.	 Pulsante BATT RELEASE

2.	 Connettore della batteria

3.	 Connettore GENLOCK IN

4.	 Connettore DC IN

5.	 Connettore DC OUT

6.	 Indicatore di registrazione

7.	 Connettore REF OUT

8.	 Connettore TC IN/OUT

9.	 Selettore TC IN/OUT

10.	 Connettore RAW OUT
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Visualizzazione a schermo
Schermo del mirino

Durante la ripresa (registrazione/standby) e la riproduzione, le informazioni sullo stato del camcorder e le 
sue impostazioni sono sovraimposte all’immagine visualizzata nel mirino.
È possibile visualizzare o nascondere queste informazioni premendo il pulsante DISPLAY.
È inoltre possibile scegliere quali voci devono essere visualizzate indipendentemente dalle altre 
(pagina 68).
L’immagine con rapporto di formato 17:9 acquisita dal sensore immagine è visualizzata nel mirino.
Nei formati di registrazione 16:9, le porzioni scure sui bordi destro e sinistro non vengono registrate.

Informazioni visualizzate a schermo durante le riprese

1 2 3 4 5 6 7 8 9 10 11

12
13
14
15
16
17
18
19
20
21

222324252627

36
37
38
39
40

35
34
33
32
31
30
29
28

1.	 Indicatore modalità otturatore / velocità 
otturatore (pagina 35)

2.	 Indicatore filtro ND (pagina 35)

3.	 Indicatore guadagno (pagina 34)
Visualizzato come valore EI quando Base Setting 
(pagina 74) >Shooting Mode nel menu System 
è impostato su Cine EI.

4.	 Indicazione posizione di messa a fuoco
Visualizza la posizione di messa a fuoco (se è 
montato un obiettivo che supporta questa 
funzione).

5.	 Indicatori di modalità di registrazione, icona 
slot A/B e stato

Visualizzazione Significato

/  Rec Registrazione

/  Stby Standby

S&Q /  Rec Registrazione Slow & Quick 
Motion, modalità High Frame 
Rate

S&Q /  Stby Slow & Quick Motion, modalità 
High Frame Rate standby

Int /  Rec Registrazione Interval Rec

Visualizzazione Significato

Int /  Stby Standby caricamento 
immagine Interval Rec

Int /  Stby Standby registrazione Interval 
Rec

/   Registrazione cache immagine

/  Cache Cache immagine standby

6.	 Icona Slot B e indicatori di stato

Visualizzazione Significato

 Rec Registrazione

 Stby Standby

7.	 Indicatore registrazione RAW esterna 
(pagina 42)

8.	 Indicatore di profondità di campo

9.	 Indicatore temperatura di colore 
(pagina 35)

10.	 Indicatore frequenza fotogrammi S&Q 
Motion (pagina 38)/Visualizzazione 
intervallo registrazione Interval Rec 
(pagina 39)

11.	 Indicatore carica residua della batteria/
tensione DC IN (pagina 13)

12.	 Indicatore formato di registrazione 
(dimensioni immagine) (pagina 22, 75)

Visualizza le dimensioni immagine per la 
registrazione su schede di memoria XQD.
Alla sinistra delle dimensioni immagine è indicata 
la modalità di scansione del sensore immagini (F: 
2K Full, C: 2K Center). Se Codec è impostato su 
RAW, è indicata solo la modalità di scansione (2KF: 
2K Full, 2KC: 2K Center).

13.	 Indicatore formato di registrazione 
(frequenza fotogrammi e metodo di 
scansione)

14.	 Indicatore formato di registrazione (codec) 
(pagina 34)

Visualizza il nome del formato di registrazione su 
schede di memoria XQD.

15.	 Indicatore LUT monitor/gamma 
(pagina 60, 65)

Visualizza le impostazioni di gamma. Quando 
Shooting Mode (pagina 74) è impostato su Cine 
EI, visualizza le impostazioni LUT monitor o gamma 
per la registrazione di video su schede di memoria 
XQD.

16.	 Indicatore formato uscita RAW esterna 
(pagina 42)

17.	 Indicatore di blocco esterno codice 
temporale

Visualizza “EXT-LK” quando l’apparecchio è 
sincronizzato sul codice temporale di un 
dispositivo esterno.

18.	 Indicatore di stato della connessione Wi-Fi 
(pagina 44)

Visualizzato quando la funzione Wi-Fi è impostata 
su Enable. Se non è montato un modulo IFU-
WLM3 sul camcorder,  non viene visualizzato.

19.	 Indicatore stato GPS (pagina 42)
Visualizza lo stato della funzione GPS.

20.	 Indicatore Focus Assist di assistenza alla 
messa a fuoco (pagina 32)

Visualizza un riquadro di rilevazione (indicatore 
zona di messa a fuoco) che indica la zona in cui 
viene rilevata la messa a fuoco e una barra di livelli 
(indicatore Focus Assist) che segnala il grado di 
messa a fuoco all’interno della zona indicata.

21.	 Monitor segnale video 
Visualizza forma d’onda, vettorscopio e 
istogramma (pagina 41).

22.	 Indicatore stato/capacità rimanente 
supporto in slot A/B (pagina 25)

Indica il supporto di registrazione quando il lato 
sinistro dell’icona è di colore arancione.
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Indica il supporto di riproduzione quando è 
illuminato l’indicatore verde in alto a destra 
sull’icona.

23.	 Indicatore di livellamento
Visualizza l’orizzontalità trasversale e longitudinale 
in incrementi di ±1° fino a un massimo di ±20°.

24.	 Indicatore di livello audio
CH3 e CH4 possono essere monitorati sulla 
schermata di stato.

25.	 Visualizzazione nome clip (pagina 47)

26.	 Indicatore Focus Assist di assistenza alla 
messa a fuoco (pagina 32)

27.	 Indicatore dati temporali (pagina 37)

28.	 Indicatore scheda UTILITY SD (pagina 26)

29.	 Indicatore di stato controllo uscita SDI/
HDMI/indicatore Parallel Rec (pagina 43)

30.	 Indicazione modalità bilanciamento del 
bianco (pagina 35)

Visualizzazione Significato

W:P Modalità predefinita

W:A Modalità memoria A

W:B Modalità memoria B

31.	 Indicatore della modalità AE (pagina 34)

32.	 Indicatore diaframma automatico (Auto Iris) 
(pagina 34)

33.	 Indicatore filtro ND Auto(pagina 35)

34.	 Indicatore AGC (pagina 34)

35.	 Indicatore otturatore automatico 
(pagina 34)

36.	 Indicatore della modalità di messa a fuoco

37.	 Indicatore della modalità di stabilizzazione 
dell’immagine

38.	 Indicatore della zona di messa a fuoco
Visualizza la zona di messa a fuoco per la messa a 
fuoco automatica.

Quando è disponibile la funzione Push Auto 
Focus

Durante la messa a fuoco automatica

Non visualizzato quando Focus Area (pagina 55) 
è impostata su Wide.

39.	 Indicazione posizione di zoom
Visualizza il valore di zoom nel campo da 0 
(grandangolo) a 99 (teleobiettivo) (se è montato 
un obiettivo che supporta questa funzione).
Visualizzabile anche come un grafico a barre 
(pagina 68).

40.	 Indicazione valore di diaframma
Visualizza il valore di diaframma (se è montato un 
obiettivo che supporta questa funzione).

Informazioni visualizzate sullo schermo durante la riproduzione

Le seguenti informazioni vengono sovraimposte sull’immagine riprodotta.

1 2 3

4

5

6

7

8

910

1.	 Numero clip / Numero totale dei clip

2.	 Modalità di riproduzione

3.	 Indicatore della carica residua della batteria

4.	 Indicatore formato di riproduzione 
(dimensioni immagine)

5.	 Indicatore formato di riproduzione 
(frequenza fotogrammi)

6.	 Indicatore formato di riproduzione (codec)

7.	 Indicatore di stato della connessione Wi-Fi 
(pagina 44)

Visualizzato quando la funzione Wi-Fi è impostata 
su Enable. Se non è montato un modulo IFU-
WLM3 sul camcorder,  non viene visualizzato.

8.	 Indicatore supporto

9.	 Indicatore del livello audio
Visualizza l’indicatore di livello audio durante la 
registrazione.

10.	 Indicatore dati temporali
Quando Display On/Off >Timecode nel menu VF è 
impostato su On, visualizza i dati temporali quando 
si preme il pulsante DISPLAY.
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Schermata di stato

La schermata di stato consente di controllare le 
impostazioni e lo stato del camcorder.

Per visualizzare la schermata di stato:
ˎˎ Premere il pulsante STATUS CHECK.

Per cambiare schermata di stato:
ˎˎ Ruotare la manopola SEL/SET.
ˎˎ Spostare il multiselettore verso l’alto o verso il 
basso.

Per nascondere la schermata di stato:
ˎˎ Premere il pulsante STATUS CHECK.

Schermata Camera Status

Visualizza le impostazioni dell’otturatore 
elettronico del camcorder e lo stato dell’obiettivo.

Voce visualizzata Descrizione

ISO/Gain<H> Impostazione ISO/Gain<H>

ISO/Gain<M> Impostazione ISO/Gain<M>

ISO/Gain<L> Impostazione ISO/Gain<L>

Gamma Impostazione Gamma Select

Matrix Matrix >Impostazione Preset 
Select

ND<Preset1> Impostazione Preset1

ND<Preset2> Impostazione Preset2

ND<Preset3> Impostazione Preset3

Zebra1 Impostazione Zebra1 On/Off e 
livello

Zebra2 Impostazione Zebra2 On/Off e 
livello

AE Speed Impostazione velocità di 
controllo AE

AGC Limit Valore di guadagno massimo 
della funzione AGC

A.SHT Limit Velocità otturatore massima 
della funzione auto shutter

Voce visualizzata Descrizione

White Modalità e impostazioni di 
bilanciamento del bianco

Focal Length Valore di lunghezza focale 
ottenuto dall’obiettivo

Schermata Audio Status

Visualizza le impostazioni di ingresso, l’indicatore di 
livello audio e le impostazioni del filtro di riduzione 
del rumore del vento per ciascun canale.

Voce visualizzata Descrizione

CH1 level meter Indicatore di livello audio del 
canale 1

CH1 Source Sorgente di ingresso del canale 
1

CH1 Ref./Sens. Livello di riferimento di 
ingresso del canale 1

CH1 Wind Filter Valore di riduzione del filtro 
antivento del microfono del 
canale 1

CH2 level meter Indicatore di livello audio del 
canale 2

CH2 Source Sorgente di ingresso del canale 
2

CH2 Ref./Sens. Livello di riferimento di 
ingresso del canale 2

CH2 Wind Filter Valore di riduzione del filtro 
antivento del microfono del 
canale 2

CH3 level meter Indicatore di livello audio del 
canale 3

CH3 Source Sorgente di ingresso del canale 
3

CH3 Wind Filter Valore di riduzione del filtro 
antivento del microfono del 
canale 3

CH4 level meter Indicatore di livello audio del 
canale 4

CH4 Source Sorgente di ingresso del canale 
4

Voce visualizzata Descrizione

CH4 Wind Filter Valore di riduzione del filtro 
antivento del microfono del 
canale 4

Audio Input Level Impostazioni di ingresso audio

Monitor CH Impostazione di monitoraggio 
del canale

HDMI Output CH Impostazione combinazione 
canali audio HDMI di uscita.

Headphone Out Impostazione del tipo di uscita 
cuffie

Schermata System Status

Visualizza le impostazioni del segnale video.

Voce visualizzata Descrizione

Country Impostazioni regionali NTSC o 
PAL

Rec Format Formato di registrazione su 
schede di memoria XQD

Picture Size Dimensioni immagine per la 
registrazione su schede di 
memoria XQD

Frame Rate Frequenza fotogrammi per la 
registrazione su schede di 
memoria XQD

Rec Function Impostazioni e formato di 
registrazione speciale attivo

Simul Rec Stato Simul Rec On/Off

Picture Cache Rec Stato Picture Cache Rec On/Off

Video Light Set Indicatore luce video HVL-LBPC 
on/off

Imager Scan Modalità di scansione del 
sensore immagine

Schermata Video Output Status

Visualizza le impostazioni di uscita SDI, HDMI e 
video.

Voce visualizzata Descrizione

SDI1 Dimensioni immagine di uscita

Spazio colore

Uscita visualizzazione a 
schermo

Gamma

SDI2 Dimensioni immagine di uscita

Spazio colore

Uscita visualizzazione a 
schermo

Gamma

HDMI Dimensioni immagine di uscita

Spazio colore

Uscita visualizzazione a 
schermo

Gamma

REF Dimensioni immagine di uscita

RAW Dimensioni immagine di uscita

Schermata di stato dei pulsanti programmabili

Visualizza le funzioni assegnate ai pulsanti 
programmabili.

Voce visualizzata Descrizione

1 Funzione assegnata al pulsante 
ASSIGN 1

2 Funzione assegnata al pulsante 
ASSIGN 2

3 Funzione assegnata al pulsante 
ASSIGN 3

4 Funzione assegnata al pulsante 
ASSIGN 4

5 Funzione assegnata al pulsante 
ASSIGN 5

6 Funzione assegnata al pulsante 
ASSIGN 6

7 Funzione assegnata al pulsante 
ASSIGN 7

8 Funzione assegnata al pulsante 
ASSIGN 8
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Voce visualizzata Descrizione

9 Funzione assegnata al pulsante 
ASSIGN 9

10 Funzione assegnata al pulsante 
ASSIGN 10

IRIS Dial Funzione assegnata alla 
manopola IRIS

Assignable Dial Funzione assegnata alla 
manopola programmabile

Schermata Battery Status

Visualizza informazioni sulla batteria e la sorgente 
di alimentazione collegata al connettore DC IN.

Voce visualizzata Descrizione

Detected Battery Tipo di batteria

Remaining Capacità rimanente (%)

Charge Count Numero di ricariche

Capacity Capacità rimanente (Ah)

Voltage Tensione (V)

Manufacture Date Data di fabbricazione della 
batteria

Video Light 
Remaining

Visualizza la capacità rimanente 
della batteria della luce video.

Power Source Sorgente di alimentazione

Supplied Voltage Tensione fornita dalla sorgente 
di alimentazione.

Schermata Media Status

Visualizza la capacità rimanente e il tempo 
di registrazione rimanente dei supporti di 
registrazione (schede di memoria XQD A e B).

Voce visualizzata Descrizione

Informazioni 
scheda A

Visualizza l’icona della scheda 
quando è inserito un supporto 
di registrazione nello slot A.

Voce visualizzata Descrizione

Protezione scheda 
A

Visualizza l’icona di blocco 
quando il supporto di 
registrazione inserito nello slot 
A è protetto.

[Nota]
Non è possibile proteggere schede 
di memoria XQD con il camcorder.

Indicatore capacità 
rimanente scheda 
A

Visualizza la capacità rimanente 
del supporto di registrazione 
inserito nello slot A come 
percentuale su una barra.

Tempo di 
registrazione 
rimanente scheda 
A

Visualizza il tempo stimato di 
registrazione rimanente sul 
supporto di registrazione 
inserito nello slot A in minuti 
nelle condizioni di 
registrazione attuali.

Informazioni 
scheda B

Visualizza l’icona della scheda 
quando è inserito un supporto 
di registrazione nello slot B.

Protezione scheda 
B

Visualizza l’icona di blocco 
quando il supporto di 
registrazione inserito nello slot 
B è protetto.

[Nota]
Non è possibile proteggere schede 
di memoria XQD con il camcorder.

Indicatore capacità 
rimanente scheda 
B

Visualizza la capacità rimanente 
del supporto di registrazione 
inserito nello slot B come 
percentuale su una barra.

Tempo di 
registrazione 
rimanente scheda 
B

Visualizza il tempo stimato di 
registrazione rimanente sul 
supporto di registrazione 
inserito nello slot B in minuti 
nelle condizioni di 
registrazione attuali.

Informazioni 
scheda SD

Visualizza l’icona della scheda 
quando è inserito un supporto 
di memoria nello slot per 
schede UTILITY SD.

Voce visualizzata Descrizione

Protezione della 
scheda SD

Visualizza l’icona di blocco 
quando il supporto di memoria 
inserito nello slot per schede 
UTILITY SD è protetto.

Indicatore capacità 
rimanente scheda 
SD

Visualizza la capacità rimanente 
del supporto di memoria 
inserito nello slot per schede 
UTILITY SD come percentuale 
su una barra.

Capacità 
rimanente scheda 
SD

Visualizza la capacità rimanente 
del supporto di memoria 
inserito nello slot per schede 
UTILITY SD in GB.

Schermata delle impostazioni del pulsante di 
registrazione

Visualizza le impostazioni dei pulsanti di START/
STOP registrazione sul corpo e sulla maniglia 
(pagina 31).

Voce visualizzata Descrizione

Rec Button Visualizza gli slot per la 
registrazione comandata 
mediante il pulsante di 
START/STOP 
registrazione.

Handle Rec Button Visualizza gli slot per la 
registrazione comandata 
mediante il pulsante di 
START/STOP 
registrazione della 
maniglia.
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Alimentazione
È possibile utilizzare un pacco batteria o 
un’alimentazione CA da un adattatore CA.
Per sicurezza, utilizzare esclusivamente i seguenti 
pacchi batterie e adattatori CA Sony.

Pacchi batteria agli ioni di litio
Serie BP-U*

*	 Con l’unità è fornito il modello BP-U35.

Adattatori CA/caricabatterie 
BC-U1A (in dotazione)
BC-U2A

[ATTENZIONE]
Non conservare i pacchi batteria in luoghi esposti 
alla luce solare diretta o a fiamme libere, oppure in 
cui siano presenti elevate temperature.

[Note]
ˎˎ Per l’alimentazione da una presa di corrente, utilizzare 

l’adattatore CA fornito.
ˎˎ Impostare sempre l’interruttore POWER su Off prima di 

rimuovere o montare un pacco batteria o un adattatore 
CA. Se viene rimosso o montato con l’interruttore 
POWER su On, in alcuni casi il camcorder potrebbe 
non avviarsi. Se non si riesce ad avviare il camcorder, 
impostare l’interruttore POWER su Off e rimuovere 
temporaneamente il pacco batteria o l’adattatore CA, 
quindi attendere circa 30 secondi prima di tentare un 
nuovo montaggio. (Se si rimuove o si monta l’adattatore 
CA mentre il camcorder è alimentato dal pacco 
batteria, o viceversa, è possibile effettuare la rimozione 
o il montaggio con l’interruttore POWER su On senza 
problemi.)

Utilizzo del pacco batteria

Per montare un pacco batteria, inserirlo fino in 
fondo nell’apposita sede (pagina 7), quindi 
spingerlo verso il basso per bloccarlo in posizione.

Per rimuovere un pacco batteria, premere e 
mantenere premuto il pulsante BATT RELEASE 
(pagina 7), fare scorrere la batteria verso l’alto e 
quindi estrarla dalla sede.

Pulsante BATT RELEASE

[Note]
ˎˎ Prima di montare un pacco batteria, ricaricarlo con il 

caricabatterie specifico BC-U1A o BC-U2A.
ˎˎ Se la batteria viene ricaricata immediatamente dopo l’uso 

mentre è ancora calda, è possibile che non si ricarichi 
completamente.

Controllo della capacità rimanente

Durante la ripresa o la riproduzione con un pacco 
batteria, la capacità rimanente della batteria viene 
visualizzata nel mirino (pagina 9).

Icona Capacità residua

91%-100%

71%-90%

51%-70%

31%-50%

11%-30%

0%-10%

Il camcorder indica la capacità rimanente 
calcolando il tempo disponibile con il pacco 
batteria sulla base del consumo attuale.

Quando si utilizza un’unità di estensione

Quando si utilizza l’unità di estensione XDCA-
FS7, viene visualizzata la tensione della batteria 
o la carica residua della batteria, a seconda della 
batteria utilizzata.

[Nota]
Non è possibile utilizzare il pacco batteria del camcorder 
quando è montata un’unità di estensione XDCA-FS7. È 
necessario montare un pacco batteria sull’unità XDCA-FS7 
oppure collegare un alimentatore esterno.

Se il livello di carica della batteria diventa 
insufficiente

Se il livello di carica rimanente della batteria 
scende al di sotto di un determinato valore 
durante l’utilizzo (stato Low BATT), viene 
visualizzato il messaggio di batteria prossima 
all’esaurimento, l’indicatore di registrazione 
comincia a lampeggiare e viene emesso un 
segnale acustico.
Se il livello di carica rimanente si abbassa oltre 
fino a raggiungere un livello al quale è impossibile 
continuare l’utilizzo dell’apparecchio (stato BATT 
Empty), viene visualizzato il messaggio di batteria 
esaurita.
Sostituire il pacco batteria esaurito con uno carico.

Modifica dei livelli di avviso

Per impostazione predefinita, il livello Low BATT 
è impostato al 10% della carica completa della 
batteria, mentre il livello BATT Empty è impostato 
sul 3%. È possibile modificare le percentuali dei 
livelli di avviso con l’opzione Camera Battery Alarm 
(pagina 79) del menu System.

Alimentazione CA

Collegando il camcorder a una presa di corrente 
elettrica, è possibile utilizzarlo senza doversi 
preoccupare di ricaricare il pacco batteria.

Esempio di connessione: quando si collega 
BC-U1A

Connettore DC IN

Cavo di 
alimentazione

BC-U1A

Alla presa di 
corrente

Collegare l’adattatore CA al connettore DC IN del 
camcorder, quindi inserire la spina del cavo di 
alimentazione (in dotazione) in una presa elettrica. 
Impostare l’interruttore di selezione della modalità 
del BC-U1A sulla posizione DC OUT.
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Se la tensione fornita dall’alimentatore CA si 
abbassa

Se durante l’utilizzo la tensione fornita 
dall’alimentatore CA scende al di sotto di un 
determinato valore (stato DC Low Voltage1), 
viene visualizzato un messaggio che segnala 
l’abbassamento della tensione dell’alimentatore, 
l’indicatore di registrazione comincia a 
lampeggiare e viene emesso un segnale acustico.
Se la tensione di uscita dell’adattatore CA 
scende al di sotto di un valore che impedisce il 
funzionamento corretto (stato DC Low Voltage2), 
viene visualizzato un messaggio che segnala che la 
tensione di uscita dell’adattatore CA è insufficiente.
In questo caso, l’adattatore CA può essere 
difettoso. Controllare l’adattatore CA secondo il 
caso.

Modifica dei livelli di avviso

Per impostazione predefinita, il livello DC Low 
Voltage1 è impostato su 11,5 V e il livello DC 
Low Voltage2 è impostato su 11,0 V. È possibile 
modificare i valori dei livelli di avviso con l’opzione 
Camera DC IN Alarm (pagina 80) del menu 
System.

Adattatori CA

ˎˎ Non collegare né utilizzare un adattatore CA in 
uno spazio ristretto, ad esempio fra una parete e 
un mobile.
ˎˎ Collegare l’adattatore CA alla presa di corrente 
più vicina. In caso di problemi durante l’uso, 
estrarre immediatamente la spina dalla presa 
elettrica.
ˎˎ Non cortocircuitare le parti metalliche dello 
spinotto dell’adattatore CA. Questo ne 
causerebbe il guasto.
ˎˎ La batteria non può essere ricaricata mentre è 
montata sul camcorder, anche se è connesso 
l’adattatore CA.
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Montaggio degli accessori
Funzionamento delle levette di 
bloccaggio

Utilizzare le levette di bloccaggio per il montaggio, 
la rimozione o la regolazione della posizione di 
microfono e mirino.
Per il montaggio, ruotare la levetta di bloccaggio in 
senso orario per fissare le aste in posizione.
Per la rimozione o la regolazione, ruotare la levetta 
di bloccaggio in senso orario per rilasciarla.
Se una levetta di bloccaggio viene a trovarsi in una 
posizione che ne rende difficoltosa la rotazione, 
estrarla e ruotarla in una posizione più comoda. 
Reinserire quindi la levetta di bloccaggio 

Levetta di bloccaggio

Regolazione della posizione del 
portamicrofono

Allentare la levetta di bloccaggio e ruotare il 
portamicrofono per spostarlo avanti o indietro 
nella posizione desiderata.

Levetta di bloccaggio

Portamicrofono e orientamento del microfono

Montare in modo che il portamicrofono e il 
microfono siano orientati come mostrato nel 
diagramma seguente.

Sostituzione dell’asta del microfono

[Note]
ˎˎ L’asta del microfono è già montata alla spedizione dalla 

fabbrica.
ˎˎ Montare e smontare l’asta del microfono solo mentre il 

camcorder è spento.
ˎˎ Montare e rimuovere sempre l’asta del microfono con il 

coperchietto di protezione del corpo montato per evitare 
possibili danni al sensore immagine.

1	 Allentare la vite.

2	 Ritirare l’asta del microfono.

3	 Montare l’asta del microfono in sequenza 
inversa.

Montaggio del mirino

[Nota]
Montare e smontare il mirino solo mentre il camcorder è 
spento.

1	 Allentare la levetta di bloccaggio del mirino e 
inserire il mirino nell’asta del microfono.

Levetta di 
bloccaggio

2	 Regolare l’orientamento laterale del mirino, 
stringere la levetta di bloccaggio e quindi 
connettere il cavetto del mirino al connettore 
del mirino del camcorder.

	 [Nota]
Controllare che il mirino sia saldamente fissato. Se la 
levetta di bloccaggio non è stata correttamente serrata, 
è possibile che il mirino possa cadere durante le riprese.

Regolazione dell’orientamento del mirino

Inclinare il mirino verso l’alto o il basso fino ad 
ottenere l’angolazione desiderata.
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È possibile orientare il mirino in modo che sia 
rivolto verso il soggetto. Spostando il selettore 
MIRROR (pagina 40) sulla posizione B/T, lo 
schermo LCD visualizza un’immagine speculare. 
L’immagine viene tuttavia registrata con 
l’orientamento corretto.

Regolazione della posizione del mirino

Regolazione in passi di 90°
Se sul giunto di connessione dell’asta è inserito 
un inserto del morsetto a sezione quadrata, 
è possibile regolare la posizione del mirino in 
incrementi di 90°.
Rimuovere il mirino, ruotare sull’angolo desiderato 
e quindi rimontare il mirino.

Regolazione libera dell’angolazione
Se sul giunto di connessione dell’asta è inserito un 
inserto del morsetto a sezione circolare, è possibile 
ruotare il mirino sull’asta stessa per regolarlo su 
qualsiasi posizione.

[Nota]
Con un inserto del morsetto a sezione circolare, utilizzare 
un’asta da Ø15 mm disponibile in commercio.

[Informazione]
Al momento della fabbricazione è montato un inserto a 
sezione circolare.

Sostituzione dell’inserto del morsetto

Per sostituire l’inserto del morsetto, allineare 
la sporgenza dell’inserto a sezione circolare o 
quadrata con la corrispondente scanalatura nel 
morsetto prima di inserirlo come illustrato nel 
seguente diagramma.

Sporgenza Sporgenza

Scanalatura
Scanalatura

[Nota]
Inserire sempre una rondella. Se non è presente una rondella, 
la forza di bloccaggio del morsetto sull’asta può risultare 
insufficiente e causare la caduta del mirino.

È possibile identificare la sezione dell’inserto come 
mostrato nelle figure seguenti.

Inserto del morsetto a sezione quadrata

Indicazione 
sezione 
quadrata

Inserto del morsetto a sezione circolare

Indicazione 
sezione circolare

Regolazione del contrasto del mirino

Ruotare la manopola CONTRAST per regolare il 
contrasto.

È possibile regolare la luminosità utilizzando 
l’opzione VF Setting >Brightness (pagina 66) del 
menu VF.

Rimozione del mirino

Allentare la levetta di bloccaggio del mirino e 
ripetere la procedura di montaggio in senso 
inverso.

Montaggio dell’oculare

[Nota]
Montare e smontare l’oculare solo mentre il camcorder è 
spento.
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1	 Inserire il gancio sulla parte superiore 
dell’oculare nel corrispondente gancio sulla 
parte superiore del mirino, quindi inserire la 
piastrina metallica sulla parte inferiore 
dell’oculare sul gancio sulla parte inferiore del 
mirino.

Agganci

2	 Spingere la piastrina di bloccaggio situata nella 
parte inferiore dell’oculare in direzione della 
freccia per bloccare l’oculare in posizione.

Piastrina di bloccaggio

Apertura dell’oculare

Premere il pulsante indicato dalla freccia.

Al rilascio del blocco, aprire l’oculare verso l’alto. 
Quando l’oculare è aperto, il mirino rimane visibile.

Rimozione dell’oculare

Sganciare il blocco dell’oculare e rimuovere 
l’oculare del mirino.

Montaggio del paraluce del mirino

[Nota]
Montare e smontare il paraluce del mirino solo mentre il 
camcorder è spento.

1	 Aprire le clip metalliche del paraluce del 
mirino.

2	 Inserire il gancio sulla parte superiore del 
paraluce del mirino nel corrispondente gancio 
sulla parte superiore del mirino, quindi inserire 
la clip metallica sulla parte inferiore del 
paraluce del mirino sul gancio sulla parte 
inferiore del mirino.

Agganci

3	 Spingere la piastrina di bloccaggio situata nella 
parte inferiore del paraluce del mirino in 
direzione della freccia per bloccare il paraluce 
del mirino in posizione.

Piastrina di bloccaggio

Apertura del paraluce del mirino

Aprire il paraluce del mirino, tirare verso di sé il lato 
inferiore del paraluce del mirino, dal centro, quindi 
sollevarlo.

[Nota]
Per lo spostamento del mirino, afferrare il mirino stesso. Non 
afferrare il paraluce del mirino.

Rimozione del paraluce del mirino

Sganciare il gancio del paraluce del mirino e 
rimuovere il paraluce dal mirino.
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Montaggio dell’obiettivo

[ATTENZIONE]
Non lasciare l’obiettivo rivolto verso il sole. La luce 
solare diretta condotta dalle ottiche dell’obiettivo 
può mettersi a fuoco all’interno del camcorder e 
causare incendi.

[Note]
ˎˎ Montare e smontare l’obiettivo solo mentre il camcorder 

è spento.
ˎˎ Gli obiettivi sono componenti di elevata precisione. Non 

appoggiare mai un obiettivo su una superficie con il suo 
innesto rivolto verso il basso. Montare il coperchietto di 
protezione fornito.

[Informazione]
Per informazioni dettagliate sugli obiettivi supportati dal 
camcorder, contattare il rappresentante dell’assistenza 
tecnica Sony.

Montaggio di un obiettivo con innesto E-mount

1	 Rimuovere il coperchietto dall’obiettivo.

2	 Rilasciare il blocchetto della ghiera di blocco 
dell’obiettivo, ruotare la ghiera di blocco 
dell’obiettivo in senso orario e rimuovere il 
coperchietto del corpo dal camcorder.

Ghiera di 
blocco 
obiettivo

Blocchetto 
della ghiera 
di blocco 
obiettivo

3	 Allineare l’indicatore (bianco) sull’innesto 
dell’obiettivo con il camcorder, inserire con 
cura l’obiettivo nell’innesto, quindi ruotare la 
ghiera di blocco dell’obiettivo per fissarlo in 
posizione.

Indicatori di allineamento (bianco)

[Note]
ˎˎ Se il blocchetto della ghiera di blocco dell’obiettivo 

non torna nella posizione di blocco dopo il montaggio 
dell’obiettivo, spostarlo nella posizione di blocco 
manualmente.
ˎˎ Durante il montaggio, allineare l’indicatore di innesto 

(bianco) sulla ghiera di blocco obiettivo con l’indicatore di 
innesto (bianco) del camcorder.

Montaggio di un obiettivo con innesto A-mount

Per poter montare un obiettivo con innesto 
A-mount, è necessario montare prima l’apposito 
adattatore (opzionale).

[Note]
ˎˎ Quando si utilizza un obiettivo con innesto A-mount, il 

diaframma è impostato su manuale.

ˎˎ Quando la messa a fuoco è impostata su AF con un 
obiettivo LA-EA2 o LA-EA4, il diaframma è impostato su 
F3.5 o completamente aperto.

Rimozione dell’obiettivo

Per rimuovere l’obiettivo, procedere come 
descritto di seguito.

1	 Rilasciare il blocchetto della ghiera di blocco 
dell’obiettivo e ruotare la ghiera di blocco 
dell’obiettivo in senso orario tenendo 
saldamente l’obiettivo.

2	 Estrarre l’obiettivo dal corpo dell’apparecchio.

[Note]
ˎˎ Durante la rimozione, allineare l’indicatore di innesto sulla 

ghiera di blocco obiettivo con l’indicatore di innesto del 
camcorder.
ˎˎ Afferrare saldamente l’obiettivo con la mano per 

impedirne la caduta.
ˎˎ Se non viene montato un altro obiettivo immediatamente, 

montare sempre il coperchietto di protezione del corpo.

Regolazioni del diaframma con obiettivi con 
selettore Auto Iris

ˎˎ Quando il selettore Auto Iris dell’obiettivo è 
impostato su AUTO, il diaframma viene regolato 
automaticamente ma può essere anche 
regolato manualmente dal camcorder.
ˎˎ Quando il selettore Auto Iris è impostato su 
MANUAL, il diaframma può essere regolato solo 
usando la ghiera dell’obiettivo. Le eventuali 
regolazioni dal camcorder non hanno alcun 
effetto.

Regolazioni della messa a fuoco con obiettivi con 
selettore di messa a fuoco

ˎˎ Quando il selettore della messa a fuoco 
dell’obiettivo è impostato su AF/MF o AF, la 
messa a fuoco viene regolata automaticamente 
ma può essere anche regolata manualmente dal 
camcorder.

ˎˎ Quando il selettore della messa a fuoco 
dell’obiettivo è impostato su Full MF o MF, la 
messa a fuoco può essere eseguita solo usando 
la ghiera dell’obiettivo. Le eventuali regolazioni 
dal camcorder non hanno alcun effetto.

Montaggio di un treppiede

Usare gli attacchi filettati di montaggio del 
treppiede sul camcorder quando si monta 
un treppiede. L’utilizzo dell’attacco treppiede 
sull’obiettivo potrebbe causare danni.

Montaggio dell’impugnatura di 
telecomando

[Nota]
Montare e smontare l’impugnatura di telecomando solo 
mentre il camcorder è spento.

1	 Montare il braccetto nell’attacco 
dell’impugnatura e stringere la vite.
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2	 Collegare il cavo dell’impugnatura di 
telecomando al connettore REMOTE del 
camcorder.

[Note]
ˎˎ Controllare che il braccetto sia fissato saldamente al 

camcorder. Se la vite è allentata, il camcorder potrebbe 
cadere durante le riprese.
ˎˎ Non sostenere mai l’intero peso del camcorder 

afferrandolo solo dall’impugnatura di telecomando.

Regolazione della posizione dell’impugnatura di 
telecomando.

ˎˎ Allentare la vite di montaggio del braccetto, 
regolare l’angolazione del braccetto (1) e serrare 
nuovamente la vite.
ˎˎ Allentare la vite di estensione del braccetto, 
regolare la lunghezza del braccetto (2) e serrare 
nuovamente la vite.
ˎˎ Premere il pulsante di rotazione 
dell’impugnatura (pagina 8) per regolare 
l’angolazione dell’impugnatura di telecomando 
(3).

2

3

1

Montaggio dell’impugnatura vicino al camcorder

1	 	Rimuovere la vite di montaggio del braccetto 
(1).

2	 Allentare la vite di estensione del braccetto (2) 
ed estendere il braccetto fino a rivelare un foro 
(3).

1

2

3

	 [Nota]
Dopo aver esteso il braccetto, stringere saldamente la 
vite.

3	 Collegare il cavo dell’impugnatura di 
telecomando al connettore REMOTE del 
camcorder.

4	 Allineare la sporgenza del braccetto con la 
scanalatura sul punto di montaggio 
dell’impugnatura e fissarlo in posizione con la 
vite rimossa al passo 1.

Smontaggio dell’impugnatura di telecomando

1	 Rimuovere il braccio dal camcorder.

2	 Scollegare il cavo dell’impugnatura di 
telecomando dal connettore REMOTE del 
camcorder.
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Regolazione della posizione 
dell’appoggio per riprese a spalla

L’appoggio per riprese a spalla può essere spostato 
in avanti o indietro. Spostare l’appoggio nella 
posizione più comoda di utilizzo del camcorder 
durante le riprese con il camcorder appoggiato 
sulla spalla.

2

1 3

Appoggio per riprese a spalla

1	 Allentare la vite dell’appoggio per le riprese a 
spalla.

2	 Spostare l’appoggio in avanti o indietro fino a 
raggiungere la posizione desiderata.

3	 Serrare saldamente la vite.
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Impostazione dell’orologio
Quando il camcorder viene acceso per la prima 
volta o se la batteria di backup si è scaricata 
completamente, nel mirino viene visualizzata la 
schermata delle impostazioni iniziali.
Impostare la data e l’ora dell’orologio interno in 
questa schermata.

Time Zone
Time Zone imposta il fuso orario, ovvero la 
differenza con l’ora UTC (Coordinated Universal 
Time). Impostare questo valore secondo il caso.

Impostazione della data e dell’ora

Ruotare la manopola SEL/SET (pagina 6) per 
selezionare voci e impostazioni, quindi premere 
la manopola SEL/SET per applicare il valore 
specificato ed avviare l’orologio.
In seguito, dopo la chiusura della schermata di 
impostazione, è possibile modificare data, ora 
e fuso orario servendosi dell’opzione Clock Set 
(pagina 78) del menu System.

[Note]
ˎˎ Se le impostazioni di data e ora sono andate perse perché 

la batteria di backup si è scaricata completamente a 
seguito di un lungo periodo di tempo in cui il camcorder 
è rimasto senza alimentazione (senza pacco batteria o 
alimentazione DC IN), verrà nuovamente visualizzata la 
schermata delle impostazioni iniziali quando si riaccende 
nuovamente il camcorder.
ˎˎ Mentre è visualizzata la schermata delle impostazioni 

iniziali non è possibile eseguire alcuna operazione (ad 
eccezione dello spegnimento) fino a quando non si siano 
completate tutte le impostazioni di questa schermata.
ˎˎ Il camcorder è dotato di una batteria ricaricabile interna 

che consente la memorizzazione di data, ora e altre 
impostazioni anche quando è spento. Per informazioni 
dettagliate sulla batteria ricaricabile interna, pagina 85.
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Configurazione delle operazioni di base del camcorder
Prima di iniziare le riprese, è necessario configurare 
il funzionamento di base del camcorder secondo 
l’applicazione specifica.

Modalità di ripresa

Sono disponibili due modalità di ripresa: “Custom 
mode”, che consente la creazione dell’immagine in 
sito con la massima flessibilità, e “Cine EI mode”, in 
cui il camcorder viene utilizzato in maniera analoga 
a una macchina cinematografica, sviluppando poi 
le riprese in sede di post produzione.
È possibile selezionare la modalità tramite Base 
Setting (pagina 74) >Shooting Mode nel menu 
System.

[Nota]
Al passaggio dalla modalità Cine EI alla modalità Custom, le 
impostazioni della modalità Cine EI vengono ereditate per 
l’impostazione della gamma.

Color Space
Color Space seleziona lo spazio colore, ovvero la 
gamma di colore di base dei segnali registrati e dei 
segnali in uscita.
Quando la modalità di ripresa è impostata su 
Custom mode, Color Space è impostato su Matrix.
ˎˎ Matrix: seleziona la gamma di colore con 
l’impostazione Matrix, simile alle videocamere 
convenzionali.

Quando la modalità di ripresa è impostata su 
Cine EI, Color Space seleziona la gamma colore 
dell’uscita video con MLUT impostato su Off.
ˎˎ S-Gamut/SLog2: Gamma colore estesa, analoga 
a quella degli apparecchi a pellicola.
ˎˎ S-Gamut3.Cine/SLog3: gamme di colore per il 
cinema digitale di facile regolazione (DCIP3).
ˎˎ S-Gamut3/SLog3: gamma colore allargata, 
compatibile con le gamme standard future, 

ottimizzata con la tecnologia di correzione delle 
distorsioni dell’immagine Sony.

È possibile selezionare la gamma colore tramite 
Base Setting (pagina 74) >Color Space nel menu 
System.

Modalità di scansione del sensore 
immagine

È possibile impostare la modalità di scansione del 
sensore immagine.
È possibile selezionare la modalità tramite Base 
Setting (pagina 75) >Imager Scan Mode nel 
menu System.
ˎˎ Normal: se non si sta utilizzando la modalità 
Slow & Quick Motion ad elevata frequenza 
di fotogrammi, questa opzione esegue la 
scansione sull’intero angolo di visuale del 
formato Super 35 mm.  
Se S&Q Motion (pagina 70) >High Frame 
Rate Mode nel menu Recording è impostato su 
Full Scan, questa opzione esegue la scansione 
sull’intero angolo di visuale del formato Super 
35mm e converte il segnale nel formato dati 
2K. Se è impostato su Center Scan, esegue la 
scansione sull’angolo di visuale 2K di mezzo 
formato Super 35mm al centro dell’immagine.
ˎˎ 2K Full: esegue la scansione sull’intero angolo di 
visuale del formato Super 35 mm e converte il 
segnale nel formato dati 2K.
ˎˎ 2K Center: esegue la scansione sull’angolo di 
visuale 2K di mezzo formato Super 35 mm al 
centro dell’immagine.

[Nota]
La risoluzione del formato di registrazione è limitata a un 
massimo di 2K quando Imager Scan Mode (pagina 75) è 
impostata su 2K Full o 2K Center.
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Utilizzo di schede di memoria XQD
Il camcorder registra audio e video su schede di memoria XQD (vendute separatamente) inserite negli 
appositi slot.

Informazioni sulle schede di memoria XQD

Utilizzare con il camcorder le schede di memoria XQD Sony elencate di seguito.
Per informazioni dettagliate sull’utilizzo disupporti di memoria di altri fabbricanti, fare riferimento alle 
relative istruzioni per l’uso o consultare le informazioni del fabbricante.
Schede di memoria XQD serie S
Schede di memoria XQD serie H
Schede di memoria XQD serie N
Schede di memoria XQD serie M
Schede di memoria XQD serie G
Non è possibile garantire il corretto funzionamento con schede di memoria diverse dalle schede di 
memoria XQD Sony.

[Informazione]
Per informazioni dettagliate sull’utilizzo e sulle precauzioni per l’uso delle schede di memoria XQD, fare riferimento alle 
istruzioni per l’uso fornite con le schede di memoria XQD stesse.

Supporti di memoria consigliati

Le condizioni operative garantite variano a seconda delle impostazioni di Rec Format e Recording.
Sì: Funzionamento supportato
No: il funzionamento corretto non è garantito.

Formato XQD G
XQD S  
(EB Stream)

XQD N  
XQD M

Non più in vendita
XQD H
XQD S 
(non EB Stream)

XAVC-I 4096×2160 – 59.94P Sì No No

50P Sì No No

29.97P Sì No No

25P Sì No No

24P Sì No No

23.98P Sì No No

Formato XQD G
XQD S  
(EB Stream)

XQD N  
XQD M

Non più in vendita
XQD H
XQD S 
(non EB Stream)

XAVC-I 3840×2160 – 59.94P Sì No No

50P Sì No No

29.97P Sì No No

25P Sì No No

23.98P Sì No No

1920×1080 Modalità 
normale o S&Q 
(eccetto HFR*1)

59.94P Sì No No

59.94i Sì Sì No

50P Sì No No

50i Sì Sì No

29.97P Sì Sì No

25P Sì Sì No

23.98P Sì Sì No

S&Q (modalità 
HFR)

59.94P Sì No No

50P Sì No No

29.97P Sì No No

25P Sì No No

23.98P Sì No No

XAVC-L 3840×2160 – 59.94P Sì Sì No

50P Sì Sì No

29.97P Sì Sì No

25P Sì Sì No

23.98P Sì Sì No

1920×1080 Modalità 
normale o S&Q 
(eccetto HFR)

59.94P Sì Sì Sì

50P Sì Sì Sì

59.94i Sì Sì Sì

50i Sì Sì Sì

29.97P Sì Sì Sì

25P Sì Sì Sì

23.98P Sì Sì Sì
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Formato XQD G
XQD S  
(EB Stream)

XQD N  
XQD M

Non più in vendita
XQD H
XQD S 
(non EB Stream)

XAVC-L 1920×1080 S&Q (modalità 
HFR)

59.94P Sì Sì No

50P Sì Sì No

29.97P Sì 50 Mbps: 
No
35 Mbps: 
Sì

No

25P Sì No No

23.98P Sì No No

MPEG 
HD 422

1920×1080 – 59.94i Sì Sì Sì

50i Sì Sì Sì

29.97P Sì Sì Sì

25P Sì Sì Sì

23.98P Sì Sì Sì

1280×720 – 59.94P Sì Sì Sì

50P Sì Sì Sì

29.97P Sì Sì Sì

25P Sì Sì Sì

23.98P Sì Sì Sì

ProRes 
422 HQ*2

1920×1080 – 59.94i Sì No No

50i Sì No No

29.97P Sì No No

25P Sì No No

23.98P Sì No No

ProRes 
422*2

1920×1080 – 59.94i Sì Sì No

50i Sì Sì No

29.97P Sì Sì No

25P Sì Sì No

23.98P Sì Sì No

*1	HFR: High Frame Rate
*2	La registrazione in formato ProRes richiede l’utilizzo 

dell’unità di estensione opzionale XDCA-FS7.

Inserimento di schede di memoria 
XQD

1	 Premere il pulsante di rilascio del coperchietto 
degli slot (pagina 7) per aprirlo.

2	 Inserire una scheda di memoria XQD con 
l’etichetta XQD rivolta a sinistra.
L’indicatore di accesso (pagina 7) si illumina 
di rosso, quindi diventa verde se la scheda è 
utilizzabile.

3	 Chiudere il coperchietto.

[Note]
ˎˎ La scheda di memoria, lo slot e i dati di immagine 

contenuti sulla scheda potrebbero subire danni se la 
scheda venisse forzata nello slot con l’orientamento errato.
ˎˎ Quando si registra su un supporto in entrambi gli slot 

della scheda XQD A e B, inserire in entrambi gli slot il 
supporto consigliato per l’uso con il formato da registrare.

Espulsione delle schede di memoria 
XQD

Premere il pulsante di rilascio del coperchietto 
degli slot (pagina 7) per aprirlo, quindi 
esercitare una leggera pressione sulla scheda 
stessa per espellerla.

[Note]
ˎˎ Se il camcorder viene spento o la scheda viene rimossa 

durante l’accesso alla scheda, non è possibile garantire 
l’integrità dei dati contenuti sulla scheda. Tutti i dati 
registrati sulla scheda potrebbero essere danneggiati. 
Assicurarsi sempre che l’indicatore di accesso sia 
illuminato in verde o spento prima di spegnere il 
camcorder o rimuovere la scheda di memoria.
ˎˎ Se si rimuove una scheda di memoria XQD 

immediatamente dopo la registrazione, è possibile che sia 
calda. Questo tuttavia non indica un problema.

Passaggio da una scheda di memoria 
XQD all’altra

Se sono presenti schede di memoria XQD in 
entrambi gli slot A e B, è possibile passare da una 
all’altra per la registrazione premendo il pulsante 
SLOT SELECT (pagina 6).
Se una scheda si riempie durante la registrazione, il 
camcorder passa automaticamente all’altra scheda.

[Nota]
Il pulsante SLOT SELECT è disabilitato durante la 
riproduzione. Non è possibile alternare fra le schede 
premendo il pulsante. Il pulsante è abilitato mentre è 
visualizzata la schermata delle miniature (pagina 47).

Formattazione (inizializzazione) di 
schede di memoria XQD

Se viene inserita una scheda di memoria XQD 
non formattata o formattata con altre specifiche, il 
mirino visualizza il messaggio “Media Needs to be 
Formatted”.
Formattare la scheda come descritto di seguito.

1	 Selezionare Format Media (pagina 72) nel 
menu Media. 

2	 Selezionare Media(A) (slot A) o Media(B) (slot 
B), quindi selezionare Execute.
Viene visualizzato un messaggio di conferma.

3	 Selezionare Execute.
Durante la formattazione è visualizzato un 
messaggio e l’indicatore di accesso si illumina 
di rosso.
Al termine della formattazione, viene 
visualizzato un messaggio per confermare che 
l’operazione è stata completata. Premere la 
manopola SEL/SET per chiudere il messaggio.
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Se la formattazione non riesce

Non è possibile formattare schede di memoria 
XQD protette o schede di memoria non 
supportate dal camcorder.
Viene visualizzato un messaggio di avvertimento. 
Seguire le istruzioni e sostituire la scheda con una 
scheda di memoria XQD supportata.

[Nota]
La formattazione di una scheda di memoria elimina tutti i 
dati che contiene, comprese le registrazioni video e i file di 
setup.

Controllo del tempo di registrazione 
rimanente

Durante la ripresa (registrazione/standby), è 
possibile monitorare la capacità rimanente sulla 
scheda di memoria XQD di ciascuno slot mediante 
gli indicatori di capacità rimanente degli slot A e B 
visualizzati nel mirino (pagina 9).
Il tempo di registrazione rimanente è calcolato 
sulla base della capacità rimanente della scheda di 
ciascuno slot e del formato video corrente (bit rate 
di registrazione) ed è indicato in minuti.

[Nota]
Se la scheda è protetta viene visualizzata l’icona .

Tempi di sostituzione delle schede di memoria 
XQD

ˎˎ Quando il tempo di registrazione rimanente 
totale sulle due schede scende al di sotto di 5 
minuti, viene visualizzato il messaggio “Media 
Near Full”, l’indicatore di registrazione comincia 
a lampeggiare e viene emesso un segnale 
acustico di avvertimento sull’uscita cuffie.  
Sostituire con una scheda con spazio libero 
sufficiente.
ˎˎ Se si prosegue con la registrazione fino a 
esaurire completamente lo spazio disponibile, 

appare il messaggio “Media Full” e la 
registrazione si arresta.

[Nota]
Su una scheda di memoria XQD può essere registrato un 
massimo di 600 clip circa.
Se il numero di clip registrati raggiunge il limite massimo, 
l’indicatore del tempo di registrazione rimanente segnalerà 
“0” e verrà visualizzato il messaggio “Media Full”.
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Utilizzo di una scheda UTILITY SD
I dati di configurazione videocamera del 
camcorder possono essere salvati su una scheda 
SD (disponibile separatamente).
È possibile anche importare da una scheda SD i file 
di dati precedentemente salvati in essa.

Schede SD supportate

Schede di memoria SDHC*

Schede di memoria SD*

*	 Indicate collettivamente come “schede SD” in questo 
manuale.

Inserimento di una scheda SD

1	 Premere il pulsante di rilascio del coperchietto 
degli slot (pagina 7) per aprirlo.

2	 Inserire la scheda di memoria SD con 
l’etichetta SD rivolta a sinistra.
L’indicatore di accesso (pagina 7) si illumina 
di rosso e quindi si spegne se la scheda è 
utilizzabile.

3	 Chiudere il coperchietto.

Espulsione della scheda SD

Premere il pulsante di rilascio del coperchietto 
degli slot (pagina 7) per aprirlo, quindi 
esercitare una leggera pressione sulla scheda SD 
per espellerla.

[Note]
ˎˎ Se il camcorder viene spento o la scheda SD viene rimossa 

durante l’accesso, non è possibile garantire l’integrità dei 
dati contenuti su di essa. Tutti i dati registrati sulla scheda 
potrebbero essere danneggiati. Assicurarsi sempre che 
l’indicatore di accesso sia spento prima di spegnere il 
camcorder o rimuovere la scheda SD.
ˎˎ Prestare attenzione per evitare che la scheda SD salti fuori 

dal camcorder durante l’inserimento o l’espulsione.

Formattazione (inizializzazione) di 
schede SD

È necessario formattare le schede SD la prima volta 
che vengono utilizzate nel camcorder.
Le schede SD da utilizzare con questo camcorder 
dovrebbero essere formattate con la funzione di 
formattazione di questo camcorder.

1	 Selezionare Format Media (pagina 72) nel 
menu Media.

2	 Specificare SD Card, quindi selezionare 
Execute.
Viene visualizzato un messaggio di conferma.

3	 Selezionare Execute.
Durante la formattazione sono visualizzati un 
messaggio e l’indicatore di avanzamento 
dell’operazione. L’indicatore di accesso è inoltre 
illuminato in rosso.
Al termine della formattazione, viene 
visualizzato un messaggio per confermare che 
l’operazione è stata completata. Premere la 
manopola SEL/SET per chiudere il messaggio.

[Nota]
La formattazione di una scheda SD elimina tutti i dati 
presenti su di essa. La scheda non può essere ripristinata.

Controllo della capacità rimanente

È possibile controllare la capacità rimanente su 
una scheda SD nella schermata Media Status 
(pagina 12).

[Nota]
Se la scheda SD è protetta viene visualizzata l’icona .

Per utilizzare con un altro dispositivo una scheda 
SD formattata con questo camcorder

Eseguire il backup di tutti i dati registrati sulla 
scheda, quindi riformattare la scheda nel 
dispositivo in cui deve essere utilizzata.
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Montando un’unità di estensione XDCA-FS7 
(opzione), è possibile aggiungere al camcorder 
ulteriori funzionalità, ad esempio una batteria 
V-shoe o un segnale di sync esterno.

Montaggio dell’unità di estensione 
XDCA-FS7

[Note]
ˎˎ Non è possibile utilizzare il pacco batteria del camcorder 

quando è montata un’unità di estensione XDCA-FS7. È 
necessario montare un pacco batteria sull’unità XDCA-FS7 
oppure collegare un alimentatore esterno.
ˎˎ Montare e smontare l’unità di estensione XDCA-FS7 solo 

mentre il camcorder è spento.

1	 Rimuovere il pacco batteria (pagina 13) 
montato sul camcorder.

2	 Rimuovere il coperchio della sezione 
connettore dell’unità di estensione.

3	 Allineare le sporgenze dell’unità di estensione 
XDCA-FS7 con le scanalature di sinistra e 
destra del camcorder, quindi inserire 
completamente. Infine spingere l’unità XDCA-
FS7 verso il basso nella sezione di connessione.

Scanalature Sporgenze

4	 Assicurare in posizione l’unità XDCA-FS7 
stringendo le due viti presenti sulla parte 
superiore dell’unità stessa.

Il coperchietto della sezione di connessione 
dell’unità di estensione può essere inserito 
nella parte superiore dell’unità di estensione.

Rimozione dell’unità di estensione 
XDCA-FS7

Allentare le due viti sulla parte superiore dell’unità 
XDCA-FS7, quindi rimuoverla dal camcorder.

Montaggio del pacco batteria

Inserire il pacco batteria nell’apposito 
alloggiamento sull’unità XDCA-FS7.

Rimozione del pacco batteria

Estrarre il pacco batteria dal suo alloggiamento 
sull’unità XDCA-FS7 mantenendo premuto allo 
stesso tempo il pulsante BATT RELEASE.

Commutazione entrata/uscita del 
codice temporale

Il selettore TC IN/OUT (pagina 8) consente di 
commutare l’entrata/uscita del codice temporale.
Per informazioni dettagliate, vedere pagina 83.

Utilizzo dell’unità di estensione XDCA-FS7
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Utilizzo di un’unità di interfaccia HXR-IFR5 e di un registratore AXS-R5
È possibile registrare video RAW (pagina 42) su 
un registratore RAW AXSR5 (opzione) utilizzando 
un’unità di interfaccia HXR-IFR5 (opzione) e 
un’unità di estensione XDCA-FS7 (opzione).
Per informazioni dettagliate su come configurare 
le unità HXR-IFR5 e AXS-R5, fare riferimento al 
manuale di istruzioni dell’unità di interfaccia HXR-
IFR5.

Connessione dell’unità di interfaccia 
HXR-IFR5 al camcorder

1	 Montare l’unità di estensione XDCA-FS7 sul 
camcorder (pagina 27).

2	 Collegare il connettore RAW OUT dell’unità 
XDCA-FS7 al connettore SDI IN (RAW) 
dell’unità HXR-IFR5 mediante un cavetto SDI.

Cavetto SDI

AXS-R5

HXR-IFR5

Rimozione dell’unità di interfaccia 
HXR-IFR5

Scollegare il cavo SDI dal connettore RAW OUT 
dell’unità XDCA-FS7.
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Utilizzo del telecomando a infrarossi
Utilizzo per la prima volta

Estrarre la pellicola di isolamento dal vano batteria 
la prima volta che si utilizza il telecomando ad 
infrarossi fornito.

Pellicola di isolamento

Al momento della spedizione, il vano batteria 
contiene una batteria al litio CR2025.

Azionamento del camcorder con il 
telecomando

Per utilizzare il telecomando, accendere il 
camcorder e quindi abilitare il funzionamento con 
telecomando.
Abilitare/disabilitare la funzione di comando a 
distanza mediante il menu di configurazione.

Abilitazione mediante il menu

Premere il pulsante MENU per attivare la modalità 
menu del camcorder, quindi impostare IR Remote 
(pagina 79) nel menu System su On.

[Note]
ˎˎ Dirigere il telecomando verso il sensore di ricezione del 

telecomando del camcorder.
ˎˎ Collocare il camcorder in modo che il sensore di 

ricezione del telecomando non sia esposto alla luce 
diretta proveniente dal sole o da altre intense sorgenti di 
illuminazione. L’esposizione a luci intense può impedire il 
funzionamento corretto tramite telecomando.
ˎˎ Durante l’uso con il camcorder, il telecomando fornito in 

dotazione potrebbe azionare erroneamente anche altri 
deck video. In tal caso, spostare il selettore di modalità 
telecomando del deck video su DVD2 oppure coprirne il 
sensore di ricezione con carta nera.

Sostituzione della batteria del 
telecomando

Il telecomando utilizza una normale batteria 
CR2025.
Utilizzare esclusivamente batterie tipo CR2025.

1	 Spingere la linguetta e rimuovere il 
portabatteria inserendo un’unghia nella 
scanalatura.

2	 Inserire la nuova batteria con il lato + rivolto 
verso l’alto.

3	 Reinserire il portabatteria fino allo scatto in 
posizione.

Linguetta

[ATTENZIONE]
Non conservare i pacchi batteria in luoghi esposti 
alla luce solare diretta o a fiamme libere, oppure in 
cui siano presenti elevate temperature.

[Nota]
La sostituzione della batteria con un’altra di tipo non 
raccomandato potrebbe causare il guasto del dispositivo. 
Sostituire sempre con il tipo di batteria specificato.
Smaltire le batterie usate in conformità con le normative 
nazionali e locali.
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Utilizzo del telecomando Wi-Fi
È possibile azionare il camcorder da un browser 
web collegando al camcorder tramite una rete 
LAN wireless uno smartphone, un tablet o un altro 
dispositivo che consente l’utilizzo di un browser 
web. Questa funzione è denominata telecomando 
Wi-Fi.
Questa funzione è utile nelle applicazioni in cui 
il camcorder è fissato in una posizione difficile 
da raggiungere, ad esempio se è montato su un 
braccio aereo.
Per informazioni dettagliate sulla procedura di 
configurazione della funzione di telecomando Wi-
Fi, vedere pagina 46.

Schermata Wi-Fi Remote 
(smartphone)

Schermata Main

ˎˎ 	Indicazione delle 
impostazioni di ripresa  
S&Q FPS, Shutter, White, 
Sensitivity/Gain/Exposure 
Index, Gamma, MLUT, 
Color Bars, Auto Black, Auto 
White, Rec Start/Stop, Lock, 
ND, Iris, Focus, Zoom, Auto 
Iris, Auto Shutter, AGC, Auto 
ND, ATW

Schermata Playback

ˎˎ Stato
ˎˎ Pulsanti di comando della 

riproduuzione  
Play/Pause, Stop, F Fwd, F 
Rev, Next, Prev

Schermata Cursor
ˎˎ Stato
ˎˎ Pulsanti di comando del 

cursore  
Su, giù, sinistra, destra, Set, 
Cancel/Back, Menu, Status, 
Thumbnail, User Menu

Schermata Assign
ˎˎ Stato
ˎˎ Pulsanti programmabili  

Pulsanti programmabili da 
1 a 10

Schermata Wi-Fi Remote (tablet)

Schermata Main

ˎˎ Indicazione delle impostazioni di ripresa  
S&Q FPS, Shutter, White, Sensitivity/Gain/Exposure Index, 
Gamma, MLUT, Color Bars, Auto Black, Auto White, Rec 
Start/Stop, Lock, ND, Iris, Focus, Zoom, Auto Iris, Auto 
Shutter, AGC, Auto ND, ATW

Schermata Playback

ˎˎ Stato
ˎˎ Pulsanti di comando della riproduuzione  

Play/Pause, Stop, F Fwd, F Rev, Next, Prev

Schermata Cursor

ˎˎ Stato
ˎˎ Pulsanti di comando del cursore  

Su, giù, sinistra, destra, Set, Cancel/Back, Menu, Status, 
Thumbnail, User Menu

Schermata Assign

ˎˎ Stato
ˎˎ Pulsanti programmabili  

Pulsanti programmabili da 1 a 10
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Operazioni di base
Di seguito si descrive la procedura per eseguire 
una semplice ripresa di base.

1	 Montare i dispositivi necessari e controllare 
che l’alimentazione sia presente.

2	 Inserire almeno una scheda di memoria.

3	 Spostare l’interruttore POWER sulla posizione 
ON.
L’indicatore POWER si illumina e l’immagine 
proveniente dal camcorder appare sul mirino.

4	 Premere il pulsante di registrazione 
(pagina 4).
L’indicatore di registrazione si illumina e il 
camcorder inizia la registrazione.

5	 Per arrestare la registrazione premere 
nuovamente il pulsante di registrazione.
La registrazione si arresta e il camcorder entra 
in modalità STBY (standby).

[Nota]
Se si preme il pulsante di registrazione entro pochi secondi 
successivi all’accensione del camcorder, l’indicatore di 
registrazione si illumina per indicare che l’unità è in stato 
di registrazione, ma, a seconda del formato di registrazione 
selezionato, potrebbe non avvenire alcuna registrazione sul 
supporto durante i primi secondi.

Ripresa (modalità Full Auto)

Premere il pulsante FULL AUTO. L’indicatore del 
pulsante si illumina.
Le funzioni Auto Iris (solo obiettivi compatibili), 
AGC, Auto Shutter e ATW (tracciamento 
automatico del bilanciamento del bianco) 
sono attivate per controllare automaticamente 
luminosità e bilanciamento del bianco (modalità 
completamente automatica).

Per regolare manualmente ciascuna funzione, 
disattivare la modalità Full Auto.

[Informazione]
Con la modalità Full Auto attiva, se la manopola del filtro ND 
non si trova nella posizione Clear della modalità di filtro ND 
variabile (pagina 35), il filtro ND viene considerato nella 
regolazione automatica dell’esposizione.

Registrazione continua con la 
sostituzione di schede di memoria 
(Relay Rec)

Quando sono presenti schede di memoria in 
entrambi gli slot A e B, la registrazione passa 
automaticamente alla seconda scheda di memoria 
poco prima che la capacità rimanente sulla prima 
scheda si esaurisca.

[Note]
ˎˎ Non espellere una scheda di memoria mentre è in corso la 

registrazione su di essa. Durante la registrazione, sostituire 
schede di memoria solo negli slot il cui indicatore di 
accesso non è illuminato.
ˎˎ Quando la capacità rimanente sulla scheda di memoria su 

cui viene eseguita la registrazione diventa inferiore a un 
minuto ed è presente una scheda di memoria registrabile 
nell’altro slot, viene visualizzato il messaggio “Will Switch 
Slots Soon”. Il messaggio scompare dopo il passaggio 
all’altro slot.
ˎˎ La registrazione relay può non essere possibile se la 

registrazione viene avviata quando la capacità rimanente 
della scheda di memoria è inferiore a un minuto. Per 
consentire il funzionamento corretto della registrazione 
relay, controllare che la capacità rimanente sulla scheda 
di memoria sia superiore a un minuto prima di iniziare la 
registrazione.
ˎˎ I video creati con la funzione di registrazione relay 

del camcorder non possono essere riprodotti senza 
interruzione sul camcorder.

Registrazione simultanea sulle 
schede di memoria A e B (Simul Rec)

È possibile registrare simultaneamente sia sulla 
scheda di memoria A che sulla scheda di memoria 
B impostando Simul Rec >Setting nel menu 
Recording su On.

[Nota]
La registrazione simultanea non è supportata nella modalità 
Slow & Quick Motion (pagina 70) e nella modalità Picture 
Cache Rec (pagina 70). Inoltre, la registrazione simultanea 
non è supportata per i formati di registrazione elencati di 
seguito (pagina 75).

NTSC Area
	 XAVC-I
	 4096×2160 59.94P, 4096×2160 29.97P, 

4096×2160 24.00P, 4096×2160 23.98P, 
3840×2160 59.94P, 3840×2160 29.97P, 
3840×2160 23.98P, 1920×1080 59.94P

	 XAVC-L
	 3840×2160 59.94P, 3840×2160 29.97P, 

3840×2160 23.98P
	 RAW (quando sono connessi unità di 

estensione XDCA-FS7, unità di interfaccia 
HXR-IFR5 e registratore AXS-R5)

	 4096×2160 59.94P, 4096×2160 29.97P, 
4096×2160 23.98P, 2048×1080 59.94P, 
2048×1080 29.97P, 2048×1080 23.98P

	 RAW & XAVC-I (quando sono connessi unità 
di estensione XDCA-FS7, unità di interfaccia 
HXR-IFR5 e registratore AXS-R5)

	 4096×2160 59.94P, 2048×1080 59.94P
	 ProRes 422 HQ, ProRes 422 (quando è 

connessa l’unità di estensione XDCA-FS7)
	 1920×1080 59.94i, 1920×1080 29.97P, 

1920×1080 23.98P

PAL Area
	 XAVC-I
	 4096×2160 50P, 4096×2160 25P, 3840×2160 

50P, 3840×2160 25P, 1920×1080 50P

	 XAVC-L
	 3840×2160 50P, 3840×2160 25P
	 RAW (quando sono connessi unità di 

estensione XDCA-FS7, unità di interfaccia 
HXR-IFR5 e registratore AXS-R5)

	 4096×2160 50P, 4096×2160 25P, 2048×1080 
50P, 2048×1080 25P

	 RAW & XAVC-I (quando sono connessi unità 
di estensione XDCA-FS7, unità di interfaccia 
HXR-IFR5 e registratore AXS-R5)

	 4096×2160 50P, 2048×1080 50P
	 ProRes 422 HQ, ProRes 422 (quando è 

connessa l’unità di estensione XDCA-FS7)
	 1920×1080 50i, 1920×1080 25P

Modifica delle impostazioni dei 
pulsanti START/STOP di registrazione 
del camcorder e della maniglia

Nella funzione di registrazione simultanea 
(Simul Rec), è possibile avviare ed arrestare la 
registrazione su ciascuna scheda di memoria 
indipendentemente utilizzando i pulsanti di 
START/STOP registrazione del camcorder e della 
maniglia.
Per impostazione predefinita, entrambi i 
pulsanti sono impostati per avviare/arrestare la 
registrazione simultaneamente su entrambe le 
schede memoria A e B.
ˎˎ “Rec Button [SlotA SlotB] Handle Rec Button 
[SlotA SlotB]”

Quando i pulsanti sono impostati per comandare 
la registrazione su schede di memoria diverse, SDI/
HDMI Rec Control e RAW Rec Control seguono lo 
stato di registrazione dello slot A.

Per modificare l’impostazione

Selezionare Simul Rec >Rec Button Set nel menu 
Recording.
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Rec Button Set Pulsanti e schede di 
memoria

“Rec Button [SlotA 
SlotB] Handle Rec 
Button [SlotA SlotB]”

Avvia/arresta la 
registrazione simultanea 
su entrambe le schede di 
memoria A e B premendo 
uno qualsiasi dei pulsanti.

“Rec Button [SlotA] 
Handle Rec Button 
[SlotB]”

Il pulsante START/STOP 
avvia/arresta la 
registrazione sulla scheda 
di memoria A mentre il 
pulsante START/STOP 
della maniglia avvia/
arresta la registrazione 
sulla scheda di memoria 
B.

“Rec Button [SlotB] 
Handle Rec Button 
[SlotA]”

Il pulsante START/STOP 
avvia/arresta la 
registrazione sulla scheda 
di memoria B mentre il 
pulsante START/STOP 
della maniglia avvia/
arresta la registrazione 
sulla scheda di memoria 
A.

Regolazione automatica della messa 
a fuoco

È necessario che sia montato un obiettivo che 
supporta la funzione di messa a fuoco automatica. 
Spostare il selettore FOCUS (pagina 6) del 
camcorder sulla posizione “AUTO”. Se l’obiettivo è 
dotato di un selettore di messa a fuoco, spostarlo 
nella posizione “AF/MF” o “AF”. Se il selettore 
si trova nelle posizioni “Full MF” o “MF” non è 
possibile eseguire la messa a fuoco dal camcorder 
(pagina 18).

[Nota]
L’adattatore opzionale LA-EA1/3 consente solo la modalità 
Push Auto Focus.

Impostazione della zona di messa a fuoco 
automatica (Focus Area)

È possibile impostare la zona di rilevamento per la 
messa a fuoco automatica mediante la voce Focus 
>Focus Area (pagina 55) del menu Camera.

[Nota]
L’adattatore opzionale LA-EA2/4 non consente l’impostazione 
della posizione.

Sospensione momentanea della messa a fuoco 
automatica (Focus Hold)

Premere il pulsante PUSH AUTO FOCUS 
(pagina 6) mentre il camcorder si trova 
in modalità di messa a fuoco automatica per 
sospendere la messa a fuoco automatica.
Questa capacità è utile, ad esempio, quando 
qualcosa attraversa la zona di ripresa fra il 
soggetto e il camcorder e non si desidera che sia 
messo a fuoco, oppure quando la messa a fuoco 
automatica viene perduta.

Regolazione manuale della messa a 
fuoco

Per regolare manualmente la messa a fuoco, 
spostare il selettore FOCUS (pagina 6) su “MAN”.
Questo consente di regolare la messa a fuoco 
manualmente secondo le condizioni di ripresa.
La messa a fuoco manuale è utile per le seguenti 
tipologie di soggetti:
ˎˎ Soggetti sull’altro lato di una finestra coperta di 
goccioline d’acqua
ˎˎ Soggetti con un basso contrasto rispetto allo 
sfondo

ˎˎ Soggetti più lontani in presenza di soggetti 
vicini

Regolazione rapida della messa a fuoco in 
modalità manuale (Push Auto Focus)

Posizionare il soggetto da mettere a fuoco al 
centro dell’immagine, quindi premere il pulsante 
PUSH AUTO FOCUS (pagina 6).
La messa a fuoco ritorna all’impostazione 
precedente non appena si rilascia il pulsante.
Questa capacità è utile quando si desidera mettere 
a fuoco rapidamente il soggetto prima di avviare 
la ripresa.
È possibile impostare la posizione per la messa a 
fuoco mediante la voce Focus >Focus Area (Push 
AF) (pagina 55) del menu Camera.

[Note]
ˎˎ La funzione Push Auto Focus non è attiva se l’obiettivo è 

impostato per la messa a fuoco manuale.
ˎˎ Durante l’utilizzo della funzione Push Auto Focus con un 

obiettivo LA-EA2/4, la modalità Full Auto è attiva.
ˎˎ Durante l’ingrandimento della messa a fuoco, la messa a 

fuoco si adatta alla posizione di visualizzazione ingrandita.

Indicatore di assistenza della messa a fuoco

Indica lo stato della messa a fuoco
ˎˎ (On): Soggetto a fuoco.
ˎˎ (Lampeggiante): Soggetto non a fuoco. Dato 
che la messa a fuoco non è automatica, 
cambiare la composizione e le impostazioni di 
messa a fuoco per mettere a fuoco il soggetto.

Messa a fuoco con vista ingrandita (Focus 
Magnifier)

Per impostazione predefinita, la funzione Focus 
Magnifier x4/x8 è assegnata al pulsante ASSIGN 4 
dell’impugnatura di telecomando (pagina 38).
Premere il pulsante ASSIGN 4 per attivare 
la funzione Focus Magnifier ed ingrandire il 
centro dell’immagine di quattro volte circa.  
Premere nuovamente il pulsante per aumentare 

l’ingrandimento a circa otto volte. Questa funzione 
è utile per controllare la messa a fuoco.
Premere nuovamente il pulsante per tornare alla 
schermata normale.
Durante l’ingrandimento della messa a fuoco, è 
possibile spostare la zona ingrandita mediante il 
multiselettore. Premere il multiselettore per tornare 
al centro dell’immagine. È possibile spostare la 
posizione anche mediante i pulsanti destro e 
sinistro e la manopola SEL/SET del camcorder, il 
telecomando a infrarossi o il telecomando Wi-Fi 
Remote.
Se viene utilizzata la funzione Push Auto Focus 
durante l’ingrandimento della messa a fuoco, 
la messa a fuoco si adatta alla posizione di 
visualizzazione ingrandita.

[Note]
ˎˎ L’ingrandimento della messa a fuoco non ingrandisce 

l’immagine registrata né l’immagine fornita sull’uscita SDI/
HDMI.
ˎˎ Durante l’ingrandimento della messa a fuoco, il pulsante 

STATUS CHECK e i pulsanti di menu non sono attivi.
ˎˎ Allo spegnimento del camcorder, il riquadro ingrandito 

torna al centro dello schermo.

Regolazione della messa a fuoco con l’ausilio 
dell’indicatore focus assist

Finestra di rilevamento della messa a fuoco
(Indicatore della zona di messa a fuoco)

Indicatore Focus Assist di assistenza 
alla messa a fuoco

La posizione di messa a fuoco corretta è indicata 
dalla massima lunghezza della barra. Regolare 
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la messa a fuoco fino a raggiungere la massima 
lunghezza della barra.

A fuoco: massima lunghezza 
raggiunta dalla barra.

[Note]
ˎˎ Nelle riprese di soggetti con superfici uniformi e senza 

variazioni oppure nelle riprese in condizioni di scarsa 
illuminazione, la lunghezza dell’indicatore di messa a 
fuoco può non variare o variare molto poco.
ˎˎ Non è possibile impostare il campo di rilevamento.

Monitoraggio audio

L’audio registrato può essere monitorato tramite 
le cuffie.
Collegando delle cuffie al relativo jack 
(pagina 7) è possibile monitorare l’audio 
durante la registrazione. L’audio di riproduzione 
(pagina 48) può essere monitorato sia tramite 
l’altoparlante incorporato (pagina 7) che le 
cuffie.
È possibile selezionare il canale audio da 
monitorare e regolare il volume con l’opzione 
Audio Output (pagina 64) del menu Audio.

Passaggio da una scheda di memoria 
XQD all’altra

Quando sono inserite due schede di memoria 
XQD, premere il pulsante SLOT SELECT 
(pagina 6) per passare da una scheda all’altra.

[Nota]
Non è possibile passare da una scheda all’altra durante 
la riproduzione. Non è inoltre possibile la riproduzione 
continuata di un clip che si estende su entrambe le schede di 
memoria dei due slot A e B.

Clip (dati registrati)
Quando si arresta la registrazione, il video, 
l’audio e i dati accessori dall’inizio alla fine della 
registrazione vengono salvati come un unico “clip” 
sulla scheda di memoria XQD.

Nome dei clip
Ai clip registrati dal camcorder viene 
automaticamente assegnato un nome 
composto dalla parola “Clip” e da un numero 
di 4 cifre. Il numero di 4 cifre è incrementato 
automaticamente ad ogni registrazione.
Per modificare il prefisso “Clip”, utilizzare la voce 
Clip del menu Media.

Durata massima dei clip
Fino a 6 ore per clip.
Nella funzione di registrazione relay, vengono 
registrati più clip in successione l’uno dopo 
l’altro. Tuttavia la registrazione si arresta 
automaticamente dopo circo 13 ore.
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Modifica delle impostazioni di base
È possibile modificare le impostazioni in base 
all’applicazione o alle condizioni di registrazione.

Selezione della modalità di 
registrazione

I formati disponibili e selezionabili variano 
a seconda del paese di utilizzo e del codec 
specificato.
Selezionare un formato tramite l’opzione Rec 
Format >Video Format nel menu System.

[Nota]
Dopo aver cambiato codec, controllare sempre 
l’impostazione Video Format.

Regolazione della luminosità

I

G H

A

B
C

E
F

D

È possibile regolare la luminosità variando 
opportunamente i valori di diaframma, guadagno, 
velocità dell’otturatore, nonché regolando il livello 
di luce mediante i filtri ND. È anche possibile 
effettuare tali regolazioni automaticamente.

Il livello ottimale di regolazione automatica della 
luminosità si imposta mediante l’opzione Auto 
Exposure (pagina 55) >Level del menu Camera. 
La funzione Auto Exposure Level può essere 
assegnata anche a un pulsante programmabile 
(pagina 38).

[Nota]
Il guadagno non è regolabile in modalità Cine EI. Inoltre, non 
è possibile regolare automaticamente la luminosità mediante 
il diaframma o la velocità dell’otturatore. È supportata invece 
la regolazione automatica della luminosità tramite il filtro ND.

Regolazione del diaframma

È possibile regolare la luminosità regolando il 
diaframma.

[Nota]
Per regolare il diaframma disattivare la modalità Full Auto 
(pagina 31).

Regolazione automatica del diaframma
Questa funzione regola la luminosità in base 
al soggetto. È necessario che sia montato un 
obiettivo che supporta la funzione di regolazione 
automatica del diaframma.

1	 Se è montato un obiettivo con selettore Auto 
Iris, impostarlo su AUTO.

2	 Premere il pulsante IRIS (E) per attivare la 
modalità Auto Iris.
La funzione viene attivata o disattivata ad ogni 
pressione del pulsante IRIS.

	 [Informazione]
La funzione IRIS può essere assegnata anche a un 
pulsante programmabile (pagina 38).

	 [Nota]
Il diaframma non può essere regolato automaticamente 
su un obiettivo con innesto A-mount.

Regolazione manuale del diaframma

1	 Premere il pulsante IRIS (E) per disattivare la 
modalità Auto Iris.

La funzione viene attivata o disattivata ad ogni 
pressione del pulsante IRIS.

2	 Spostare il selettore ND/IRIS (C) sulla posizione 
IRIS.

3	 Ruotare la manopola ND/IRIS (D) per regolare il 
diaframma.

	 [Informazione]
È possibile anche assegnare la funzione IRIS a una 
manopola programmabile (pagina 38).

Regolazione automatica temporanea del diaframma
Mantenere premuto il pulsante PUSH AUTO IRIS (F) 
per attivare momentaneamente la modalità Auto 
Iris.
Il diaframma ritorna all’impostazione precedente 
non appena si rilascia il pulsante.

[Informazione]
La funzione PUSH AUTO IRIS può essere assegnata anche a 
un pulsante programmabile (pagina 38).

[Nota]
Se il selettore Auto Iris dell’obiettivo è impostato su MANUAL, 
le funzioni Auto Iris e Push Auto Iris del camcorder non 
hanno effetto. Non hanno effetto nemmeno le regolazioni 
manuali del diaframma sul camcorder.

Regolazione del guadagno

È possibile regolare la luminosità regolando il 
guadagno.

[Nota]
Per regolare il guadagno disattivare la modalità Full Auto 
(pagina 31).

Regolazione automatica del guadagno
Premere il pulsante ISO/GAIN (G) per attivare la 
funzione AGC.
Oppure, selezionare Auto Exposure (pagina 55) 
>AGC nel menu Camera per attivare la funzione 
AGC.

Regolazione manuale del guadagno
La regolazione del guadagno è utile per regolare 
l’esposizione mentre si utilizza un valore di 
diaframma fisso oppure se si desidera evitare 
l’aumento del guadagno generato dalla funzione 
AGC.

1	 Premere il pulsante ISO/GAIN (G) per 
disattivare la funzione AGC.

2	 Spostare il selettore ISO/GAIN (I) su H, M o L.

[Informazione]
È possibile anche assegnare la funzione Push AGC 
a un pulsante programmabile per attivare AGC 
momentaneamente mantenendo premuto tale pulsante.

Regolazione fine del guadagno
Ruotare la manopola IRIS o la manopola 
programmabile (pagina 38) a cui è assegnata 
la funzione ISO/Gain/EI per regolare il valore di 
guadagno impostato dal selettore ISO/GAIN (I).
Questa funzione è utile se si desidera correggere 
l’esposizione di un passo senza tuttavia modificare 
la profondità di campo.
La regolazione del guadagno viene annullata 
spostando di nuovo il selettore ISO/GAIN (I), 
attivando la funzione AGC oppure spegnendo il 
camcorder.

Regolazione dell’otturatore

È possibile regolare la luminosità regolando 
l’otturatore.

[Nota]
Per regolare l’otturatore, disattivare la modalità Full Auto 
(pagina 31).

Regolazione automatica dell’otturatore
Premere il pulsante SHUTTER (H) per regolare 
automaticamente la velocità dell’otturatore in 
risposta alla luminosità dell’immagine.
Se è visualizzata la schermata delle impostazioni, 
premere nuovamente il pulsante.
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Oppure impostare Auto Exposure (pagina 55) 
>Auto Shutter nel menu Camera su On.

Regolazione automatica dell’otturatore
È possibile eseguire riprese con una velocità di 
otturatore fissa.
Premere il pulsante SHUTTER (H) per visualizzare 
una schermata con i valori di otturatore disponibili, 
quindi selezionare ed impostare il valore 
desiderato mediante la manopola SEL/SET. Se si 
preme nuovamente il pulsante SHUTTER invece 
della manopola SEL/SET, viene attivata la funzione 
di otturatore automatico Auto Shutter.

[Informazione]
È anche possibile impostare l’angolazione e regolare la 
frequenza (pagina 56).

Regolazione del livello di luce (filtro ND)

In condizioni di illuminazione troppo intensa, è 
possibile ottenere la luminosità corretta utilizzando 
un filtro ND.
Il camcorder offre due modalità di filtro ND. Per 
passare da una modalità all’altra, utilizzare il 
selettore PRESET/VARIABLE (B).

Regolazione in modalità preset
Spostare il selettore PRESET/VARIABLE (B) sulla 
posizione PRESET e spostare la manopola ND 
FILTER (A) su una delle posizioni indicate di seguito.
Clear: Nessun filtro ND
1: Trasmittanza specificata da ND Filter >Preset1 
(pagina 54) nel menu Camera.
2: Trasmittanza specificata da ND Filter >Preset2 
(pagina 54) nel menu Camera.
3: Trasmittanza specificata da ND Filter >Preset3 
(pagina 54) nel menu Camera.

Regolazione in modalità variabile
Spostare il selettore PRESET/VARIABLE (B) 
sulla posizione VARIABLE. Le posizioni 1, 2 e 3 
della manopola ND FILTER (A) selezionano il 
funzionamento del filtro ND, a prescindere dalla 
posizione della manopola.

[Nota]
Per regolare il livello disattivare la modalità Full Auto 
(pagina 31).

	 Regolazione automatica del livello di luce
	 Attivando la funzione Auto ND Filter 

viene abilitata la regolazione automatica 
dell’esposizione mediante il filtro ND.

1	 Impostare la manopola ND FILTER (A) su 1, 
2 o 3.

2	 Impostare Auto Exposure (pagina 55) 
>Auto ND Filter nel menu Camera su On.

	 Regolazione manuale del livello di luce

1	 Impostare la manopola ND FILTER (A) su 1, 
2 o 3.

2	 Impostare Auto Exposure (pagina 55) 
>Auto ND Filter nel menu Camera su Off.

3	 Spostare il selettore ND/IRIS (C) sulla 
posizione ND.

4	 Ruotare la manopola ND/IRIS (D) per 
regolare la trasmittanza del filtro.
La posizione (1, 2, o 3) della manopola ND 
FILTER non ha alcun effetto sulla 
regolazione della trasmittanza del filtro.

	 Regolazione automatica temporanea del 
diaframma

	 È possibile anche assegnare Push Auto ND 
a un pulsante programmabile (pagina 38) 
per attivare momentaneamente la funzione 
di filtro ND automatico mantenendo premuto 
tale pulsante. Al rilascio del pulsante, la 
funzione Auto ND Filter viene nuovamente 
disattivata.

	 Impostare prima la manopola ND FILTER (A) su 
1, 2 o 3.

	 [Nota]
Se viene spostata la posizione della manopola ND 
FILTER durante la ripresa, si potrebbero verificare disturbi 
nell’audio e nel video.

	 [Informazioni]
ˎˎ È possibile anche assegnare ND Filter Position a un 

pulsante programmabile (pagina 38) e premere 
tale pulsante invece di usare la manopola ND FILTER 
per modificare l’impostazione.  
Modalità preset: Clear  Preset1  Preset2  
Preset3  Clear…  
Modalità variabile: Clear  On  Clear…  
Il filtro torna all’impostazione indicata dalla manopola 
ND FILTER quando si spegne il camcorder.
ˎˎ È possibile anche assegnare Auto ND Filter a un 

pulsante programmabile (pagina 38) per attivare e 
disattivare la funzione Auto ND Filter premendo tale 
pulsante.
ˎˎ Nella ripresa di soggetti fortemente illuminati, la 

chiusura eccessiva del diaframma può dar luogo a 
sfocature per diffrazione. Questo è un fenomeno 
tipico nelle videocamere. È possibile eliminare questo 
fenomeno ed ottenere risultati migliori utilizzando il 
filtro ND.

Come ottenere colori naturali 
(bilanciamento del bianco)

A

B

È possibile selezionare la modalità di regolazione 
più adatta per le condizioni di ripresa.

Modalità ATW (bilanciamento automatico del 
bianco)

Questa funzione regola automaticamente il 
bilanciamento del bianco a un livello ottimale.
Il valore di bilanciamento del bianco viene 
automaticamente regolato quando cambia la 
temperatura di colore della sorgente luminosa.
Premendo il pulsante WHT BAL (A) si attiva o 
disattiva la funzione ATW.
È possibile selezionare la velocità di regolazione 
(cinque livelli) con l’opzione White >ATW Speed 
(pagina 59) del menu Paint.
È possibile “congelare” il valore di bilanciamento 
del bianco corrente assegnando la funzione ATW 
Hold a un pulsante programmabile (pagina 38) 
e premendo tale pulsante per sospendere 
temporaneamente la modalità ATW.

[Note]
ˎˎ La funzione ATW non è utilizzabile in modalità Cine EI.
ˎˎ A seconda delle condizioni di illuminazione e del 

soggetto, la funzione ATW può non essere in grado di 
ottimizzare sempre il colore.  
Esempi:

–– 	Quando il soggetto è dominato da un unico colore, ad 
esempio cielo, mare, prati o fiori.

–– 	Quando la temperatura di colore è estremamente alta 
o bassa.  
Se non è possibile ottenere l’effetto opportuno 
perché la velocità di regolazione automatica ATW è 
insufficiente o per altri motivi, eseguire la funzione di 
bilanciamento automatico del bianco.

Regolazione manuale del bilanciamento del 
bianco

1	 Disattivare la modalità Full Auto (pagina 31).

2	 Quando il bilanciamento del bianco è 
impostato sulla modalità ATW, premere il 
pulsante WHT BAL (A) per impostare la 
modalità manuale.
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3	 Selezionare B, A o PRESET con il selettore WHT 
BAL (B).
B: modalità memoria B*
A: modalità memoria A
PRESET: Modalità preset
*	 B può essere assegnato a ATW On.

Modalità preset
Questa modalità regola la temperatura di colore su 
un valore preimpostato (valore predefinito: 3200K).

Modalità memoria A / memoria B
Questa modalità imposta il bilanciamento del 
bianco sul valore salvato rispettivamente nella 
memoria A o B.

[Nota]
Le impostazioni del selettore WHT BAL in modalità Cine IE 
sono fissate come indicato di seguito.
B: 5500K
A: 4300K
PRESET: 3200K

Esecuzione del bilanciamento automatico del 
bianco

1	 Per salvare un valore di regolazione in 
memoria, selezionare la modalità memoria A o 
la modalità memoria B.

2	 Collocare un foglio o un altro oggetto bianco 
in una posizione con la stessa sorgente di luce 
e le stesse condizioni di illuminazione del 
soggetto, quindi zoomare sul foglio fino a 
riempire lo schermo di bianco.

3	 Regolare la luminosità.
Regolare il diaframma servendosi della 
procedura descritta in “Regolazione manuale 
del diaframma” (pagina 34).

4	 Premere il pulsante WB SET (pagina 4).
ˎˎ Se il bilanciamento automatico del bianco 
viene eseguito nella modalità di memoria, 

il valore di regolazione viene salvato nella 
memoria A o B selezionata al punto 1.
ˎˎ Se il bilanciamento automatico del bianco 
viene eseguito nella modalità ATW, la 
regolazione del bilanciamento del bianco 
torna alla modalità di bilanciamento del 
bianco ATW al termine della regolazione.

[Note]
ˎˎ Il bilanciamento automatico del bianco non può essere 

eseguito in modalità Cine EI.
ˎˎ Se la regolazione non può essere eseguita correttamente, 

viene visualizzato un messaggio di errore sullo schermo 
per circa tre secondi. Se il messaggio di errore persiste 
anche dopo ripetuti tentativi di impostazione del 
bilanciamento del bianco, rivolgersi al servizio di 
assistenza tecnica Sony.

Impostazione dell’audio da registrare

È possibile specificare l’audio da registrare 
scegliendo opportunamente i connettori di 
ingresso e utilizzando i selettori e le manopole del 
camcorder.

Connettori e selettori di ingresso audio esterno
Connettore INPUT1 (pagina 7)
Connettore INPUT2 (pagina 7)
Selettore INPUT1 (LINE/MIC/MIC+48V) 
(pagina 4)
Selettore INPUT2 (LINE/MIC/MIC+48V) 
(pagina 4)

Selettori per l’impostazione del livello audio
Selettore CH1 LEVEL CONTROL (pagina 6)
Selettore CH2 LEVEL CONTROL (pagina 6)
Manopola CH1 INPUT LEVEL (pagina 6)
Manopola CH2 INPUT LEVEL (pagina 6)

Selezione del dispositivo di ingresso audio

1	 Selezionare il connettore di ingresso audio

Selezionare l’ingresso audio mediante le voci 
Audio Input >CH1 Input Select o CH2 Input 
Select del menu Audio.
Impostare su INPUT1 o INPUT2 a seconda del 
connettore a cui è connesso il dispositivo. Se si 
utilizza un microfono con connessione a slitta 
o adattatore XLR, specificare Shoe 1 o Shoe 2 
in maniera analoga. Per informazioni 
dettagliate sull’adattatore XLR, vedere 
“Aggiunta di connettori di ingresso audio” 
(pagina 43).

	 [Nota]
Il camcorder è dotato di un microfono interno. Pur non 
essendo adeguato per la produzione dell’audio finale, 
può essere utilizzato per la sincronizzazione con altre 
apparecchiature. In tal caso, specificare Internal MIC.

2	 Selezionare la sorgente di ingresso audio
Impostare i selettori INPUT1/INPUT2 (LINE/
MIC/MIC+48V) in base ai dispositivi connessi 
rispettivamente ai connettori INPUT1/INPUT2.

Dispositivo collegato Posizione 
selettore

Sorgente audio esterna (ad 
es. mixer)

LINE

Microfono dinamico, 
microfono a batteria

MIC

Microfono con alimentazione 
phantom +48 V

MIC+48V

ˎˎ Se si seleziona MIC+48V, assicurarsi che 
il microfono connesso sia compatibile 
con una sorgente a +48 V per evitare 
di danneggiarlo. Controllare questa 
impostazione prima di procedere con il 
collegamento.
ˎˎ Se è necessario limitare l’eventuale rumore 
sui connettori ai quali non è connesso 
nessun dispositivo, impostare su LINE 
i selettori INPUT1/INPUT2 (LINE/MIC/
MIC+48V) corrispondenti.

Regolazione automatica del livello di registrazione 
audio

Spostare su AUTO i selettori CH1/CH2 LEVEL 
CONTROL dei canali da regolare automaticamente.
Per CH3/CH4, impostare Audio Input >CH3 Level 
Control e CH4 Level Control nel menu Audio su 
Auto (pagina 63).

Regolazione manuale del livello di registrazione 
audio

La seguente procedura consente di regolare il 
livello di registrazione audio per i canali CH1/CH2.

1	 Spostare su MAN i selettori CH1/CH2 LEVEL 
CONTROL dei canali da regolare manualmente.

2	 Durante la ripresa o lo standby, ruotare le 
manopole INPUT LEVEL (CH1)/(CH2) per 
regolare il livello audio del canale 
corrispondente.
ˎˎ È possibile regolare il livello di registrazione 
tramite la manopola programmabile 
(pagina 38) precedentemente assegnata 
alla funzione Audio Input Level oppure 
mediante il menu di configurazione.
ˎˎ Per CH3/CH4, impostare Audio Input >CH3 
Level Control e CH4 Level Control nel menu 
Audio su Manual, quindi impostare il livello 
di registrazione audio in CH3 Input Level e 
CH4 Input Level (pagina 63).

[Note]
ˎˎ Con determinate combinazioni di impostazioni del 

menu Audio, l’impostazione Audio Input Level potrebbe 
essere disabilitata. Per informazioni dettagliate, vedere il 
diagramma a pagina 101.
ˎˎ Se Audio Input >CH1 Input Select oppure CH2 Input 

Select nel menu Audio sono impostati su Internal MIC, 
CH2 viene commutato su automatico/manuale in base 
alla posizione del selettore CH1 LEVEL CONTROL. Inoltre, 
il livello di registrazione audio di CH2 è impostato sulla 
base dell’impostazione della manopola CH1 INPUT LEVEL 
(pagina 63).
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ˎˎ Il camcorder supporta combinazioni di varie impostazioni. 
Per informazioni dettagliate, vedere il diagramma a 
pagina 101.

Specifica dei dati temporali

Impostazione del codice temporale

Specificare il codice temporale da registrare con 
l’opzione Timecode (pagina 69) del menu TC/UB.

Visualizzazione dei dati temporali

Premere il tasto DISPLAY per visualizzare i dati 
temporali sullo schermo (pagina 9).
Specificare il codice temporale da visualizzare 
mediante l’opzione TC Display (pagina 69) 
>Display Select del menu TC/UB.
Premendo un pulsante programmabile 
(pagina 38) a cui è assegnata la funzione 
DURATION/TC/U-BIT, è possibile visualizzare in 
sequenza il codice temporale, i bit utente e la 
durata.
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Funzioni utili
Pulsanti e manopole programmabili

Il camcorder è dotato di dieci pulsanti 
programmabili (pagina 6, 8) a cui possono 
essere assegnate varie funzioni.
Quando il selettore ND/IRIS si trova sulla posizione 
IRIS, è possibile anche assegnare funzioni alla 
manopola ND/IRIS (pagina 6) del camcorder 
e alla manopola programmabile (pagina 8) 
dell’impugnatura di telecomando.

Modifica della funzione assegnata al pulsante

Utilizzare Assignable Button (pagina 11) nel 
menu System.
Le funzioni assegnate sono visualizzate nella 
schermata Assignable Button Status (pagina 11).

Funzioni predefinite assegnate ai vari pulsanti 
programmabili al momento dell’acquisto:
Pulsante 1	 S&Q Motion
Pulsante 2	 Off
Pulsante 3	 User Menu
Pulsante 4	 Focus Magnifier x4/x8
Pulsante 5	 User Menu
Pulsante 6	 Off
Pulsante 7	 Off
Pulsante 8	 Off
Pulsante 9	 Off
Pulsante 10	 Off

Funzioni assegnabili
ˎˎ Off
ˎˎ Marker
ˎˎ Zebra
ˎˎ Peaking
ˎˎ Video Signal Monitor
ˎˎ DURATION/TC/U-BIT
ˎˎ Focus Magnifier x4/x8
ˎˎ Focus Magnifier x4
ˎˎ 	Focus Magnifier x8
ˎˎ Push AF/Focus Hold
ˎˎ Focus Area

ˎˎ Focus Area (Push AF)
ˎˎ VF Mode
ˎˎ ND Filter Position
ˎˎ IRIS
ˎˎ AGC
ˎˎ Auto ND Filter
ˎˎ SHUTTER
ˎˎ Auto Exposure Level
ˎˎ Push Auto Iris
ˎˎ Push AGC
ˎˎ Push Auto ND
ˎˎ Spotlight
ˎˎ Backlight
ˎˎ ATW
ˎˎ ATW Hold
ˎˎ SteadyShot
ˎˎ Color Bars
ˎˎ User Menu
ˎˎ Rec Lamp
ˎˎ S&Q Motion
ˎˎ Picture Cache Rec
ˎˎ Rec Review
ˎˎ Thumbnail
ˎˎ Shot Mark1
ˎˎ Shot Mark2
ˎˎ Clip Flag OK
ˎˎ Clip Flag NG
ˎˎ Clip Flag Keep
ˎˎ High/Low Key

Modifica della funzione assegnata alla manopola

Utilizzare Assignable Dial (pagina 77) nel menu 
System.
Le funzioni assegnate sono visualizzate nella 
schermata Assignable Button Status (pagina 11).
La funzione IRIS è assegnata per impostazione 
predefinita.

Funzioni assegnabili
ˎˎ Off
ˎˎ IRIS
ˎˎ ISO/Gain/EI
ˎˎ ND Filter

ˎˎ Focus
ˎˎ Audio Input Level

Slow & Quick Motion

Quando il formato video (pagina 75) è 
impostato su uno dei valori elencati di seguito, è 
possibile specificare valori diversi per le frequenze 
fotogrammi di registrazione e di riproduzione.

NTSC Area
	 XAVC-I
	 4096×2160 59.94P, 4096×2160 29.97P, 

4096×2160 24.00P, 4096×2160 23.98P, 
3840×2160 59.94P, 3840×2160 29.97P, 
3840×2160 23.98P, 1920×1080 59.94P, 
1920×1080 29.97P, 1920×1080 23.98P

	 XAVC-L
	 3840×2160 59.94P, 3840×2160 29.97P, 

3840×2160 23.98P, 1920×1080 59.94P 50, 
1920×1080 59.94P 35, 1920×1080 29.97P 50, 
1920×1080 29.97P 35, 1920×1080 23.98P 50, 
1920×1080 23.98P 35

PAL Area
	 XAVC-I
	 4096 × 2160 50P, 4096 × 2160 25P, 3840 × 2160 

50P, 3840 × 2160 25P, 1920 × 1080 50P, 1920 × 
1080 25P

	 XAVC-L
	 3840×2160 50P, 3840×2160 25P, 1920×1080 

50P 50, 1920×1080 50P 35, 1920×1080 25P 50, 
1920×1080 25P 35

È possibile impostare la frequenza fotogrammi 
di registrazione premendo un pulsante 
programmabile a cui è stata assegnata la funzione 
S&Q Motion.

[Note]
ˎˎ La funzione Slow & Quick Motion non può essere 

impostata durante la registrazione, la riproduzione o 
mentre è visualizzata la schermata delle miniature.
ˎˎ La modalità Slow & Quick Motion non consente la 

registrazione di audio.
ˎˎ In modalità Quick & Slow Motion, la funzione di messa a 

fuoco automatica è disabilitata.
ˎˎ Per la ripresa con frequenze fotogrammi superiore a 60 fps 

si applicano le seguenti condizioni:
–– Gli indicatori di assistenza alla messa a fuoco, 

profondità di campo, posizione di messa a fuoco, 
posizione diaframma e posizione di zoom non sono 
visibili.

NTSC Area
Formato Risoluzione Frequenza 

fotogrammi
Valori di High  
Frame Rate

XAVC-I 2160 Da 1 a 
60 fps

Non supportato

(59.94P, 29.97P, 24.00P, 23.98P)

1080 Da 1 a 
60 fps

72/75/80/90/96/ 
100/110/120/125/ 
135/144/150/160/ 
168/175/180 fps

(59.94P, 29.97P, 23.98P)

XAVC-L 2160 Da 1 a 
60 fps

Non supportato

(59.94P, 29.97P, 23.98P)

1080 Da 1 a 
60 fps

72/75/80/90/96/ 
100/110/120 fps

(59.94P 50, 59.94P 35, 29.97P 
50, 29.97P 35, 23.98P 50, 
23.98P 35)
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PAL Area
Formato Risoluzione Frequenza 

fotogrammi
Valori di High  
Frame Rate

XAVC-I 2160 Da 1 a 
60 fps

Non supportato

(59P, 25P)

1080 Da 1 a 
60 fps

72/75/80/90/96/ 
100/110/120/125/ 
135/144/150 fps

(59P, 25P)

XAVC-L 2160 Da 1 a 
60 fps

Non supportato

(59P, 25P)

1080 Da 1 a 
60 fps

72/75/80/90/96/ 
100/110/120 fps

(50P 50, 50P 35, 25P 50, 25P 35)

Registrazione di video a intervalli 
(Interval Rec)

Il camcorder è dotato della funzione Interval Rec 
che consente di catturare video in time-lapse nella 
sua memoria interna. Questa funzione è efficace 
per riprendere soggetti che cambiano molto 
lentamente.
Quando si avvia la registrazione in questa modalità, 
il camcorder registra automaticamente un numero 
specificato di fotogrammi a intervalli specificati.
Questa funzione è abilitata quando il camcorder 
è impostato su uno dei seguenti formati video 
(pagina 75):
ˎˎ XAVC-I
ˎˎ XAVC-L*

ˎˎ MPEG HD 422*

*	 59.94i e 50i non sono supportati.

Intervallo di ripresa (Interval Time)

Numero di fotogrammi in ciascuna ripresa
(Number of Frames)

Quando è attiva la modalità Interval Rec, la 
luce video HVL-LBPC (opzionale) si accende 
automaticamente prima dell’avvio della 
registrazione per consentire la ripresa di 
immagini in stabili condizioni di illuminazione 
e di temperatura di colore (funzione di 
preilluminazione Pre-Lighting).

[Note]
ˎˎ È possibile utilizzare una sola funzione di registrazione 

speciale (ad esempio Interval Rec) alla volta.
ˎˎ Se durante l’utilizzo di Interval Rec viene attivata un’altra 

modalità di registrazione speciale, il camcorder esce dalla 
modalità Interval Rec.
ˎˎ Il camcorder esce automaticamente dalla modalità 

Interval Rec se vengono modificate le impostazioni di 
sistema, ad esempio il formato video.
ˎˎ Le impostazioni della modalità Interval Rec non possono 

essere modificate durante la registrazione, la riproduzione 
o mentre è visualizzata la schermata delle miniature.

Impostazione di Interval Rec

Impostare Interval Rec (pagina 70) >Setting nel 
menu Recording su On, quindi impostare Number 
of Frames e Interval Time.
Se si utilizza la luce video HVL-LBPC (opzionale), 
l’opzione Interval Rec >Pre-Lighting del menu 
Recording consente di specificare secondo 
le proprie esigenze con che anticipo dovrà 

accendersi la luce prima dell’avvio della 
registrazione. 

[Note]
ˎˎ Se si desidera accendere la luce video prima dell’avvio 

della registrazione, spostare il selettore della luce 
video su AUTO. La luce video si accenderà e spegnerà 
automaticamente secondo l’impostazione dell’opzione 
Video Light Set (pagina 58) nel menu Camera.
ˎˎ Spostando su ON il selettore della luce video, la luce 

rimane sempre accesa (non si accende e spegne 
automaticamente).
ˎˎ Se la luce video è configurata in modo da spegnersi per 5 

secondi o meno, la luce video non si spegne.

Allo spegnimento, il camcorder esce dalla 
modalità Interval Rec, ma i valori impostati in 
Number of Frames, Interval Time e Pre-Lighting 
sono mantenuti. Non è necessario impostarli 
nuovamente la volta successiva che si utilizza la 
funzione Interval Rec.

Ripresa in modalità Interval Rec

Premere il pulsante di registrazione per avviare la 
registrazione. Il mirino visualizza, alternativamente, 
le indicazioni “Int / Rec” e “Int /
Stby”.
Se si utilizza la funzione di preilluminazione, 
la luce video si illumina prima dell’avvio della 
registrazione.

Arresto della ripresa

Arrestare la registrazione.
Al termine della ripresa, i dati video memorizzati 
fino a quel momento nella memoria vengono 
salvati sul supporto di registrazione.

Uscire dalla modalità Interval Rec

Eseguire una delle operazioni indicate di seguito.
ˎˎ Spostare il selettore POWER su OFF.
ˎˎ In modalità standby di registrazione, impostare 
Interval Rec >Setting nel menu Recording su Off.

Il camcorder esce automaticamente dalla modalità 
Interval Rec anche quando viene riavviato.

Limitazioni durante la registrazione

ˎˎ Non viene registrato audio.
ˎˎ Non è possibile rivedere la registrazione (Rec 
Review).
ˎˎ Non è applicato un Genlock

Se il camcorder viene spento durante la 
registrazione

ˎˎ Se il selettore POWER del camcorder si trova 
nella posizione Off, il camcorder accede per 
alcuni secondi al supporto di registrazione 
per salvare le immagini contenute in memoria 
fino al quel momento, quindi si spegne 
automaticamente.
ˎˎ Se l’alimentazione si interrompe perché è stata 
rimossa la batteria, è stato scollegato il cavo 
di alimentazione CC oppure è stata interrotta 
l’alimentazione all’adattatore CA, tutti i dati 
video ed audio registrati fino a quel momento 
andranno persi (max. 10 secondi). Prestare 
attenzione durante la sostituzione la batteria.

Registrazione di immagini 
preregistrate nella cache (Picture 
Cache Rec)

Mantenendo una memoria cache interna di una 
durata specificata durante le riprese, la funzione 
Picture Cache Rec consente di catturare video 
“retroattivamente” all’avvio della registrazione e 
registrarlo sulle schede di memoria XQD. Il tempo 
di registrazione cache immagine viene impostato 
con la voce Picture Cache Rec >Cache Rec Time 
(pagina 71) del menu Recording.
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Formati di registrazione supportati

Formato di 
registrazione

Risoluzione Tempo cache [s]

RAW 4096×2160 Non supportato

2048×1080

XAVC*1 4096×2160 Da 0 a 2

3840×2160

1920×1080 Da 0 a 2/da 2 a 4/da 4 
a 6/da 6 a 8

MPEG-2 1920×1080 Da 0 a 2/da 2 a 4/da 4 
a 6/da 6 a 8/da 8 a 10/
da 13 a 15

ProRes422 1920×1080 Non supportato

*1:	 XAVC-I 59.94P e 50P non supportati.

[Note]
ˎˎ La funzione Picture Cache Rec non può essere attiva 

mentre sono attive le modalità Interval Rec o Slow & 
Quick Motion. Quando viene attivata la funzione Picture 
Cache Rec, queste altre modalità di registrazione vengono 
disattivate automaticamente.
ˎˎ Non è possibile selezionare la modalità Picture Cache Rec 

durante la registrazione o Rec Review.
ˎˎ Mentre Picture Cache Rec è attiva, il codice temporale 

viene sempre registrato in modalità Free Run 
indipendentemente dall’impostazione nel menu TC/UB 
(pagina 69).
ˎˎ L’impostazione Output Format potrebbe non essere 

configurabile nella modalità Picture Cache Rec. In tal caso, 
impostare provvisoriamente Picture Cache Rec su Off e 
modificare le impostazioni desiderate.

Configurazione prima della ripresa

Configurare Picture Cache Rec (pagina 70) nel 
menu Recording prima della ripresa.
È possibile anche assegnare la funzione Picture 
Cache Rec Setting a un pulsante programmabile 
(pagina 38) per impostare Picture Cache Rec 
>Setting su On o Off premendo tale pulsante.
Quando è configurata, l’indicatore  (verde) è 
visualizzato nel mirino (pagina 9).

Avvio della registrazione delle immagini della 
memoria cache

Quando viene premuto il pulsante di registrazione, 
la registrazione si avvia e il video viene registrato 
sulle schede di memoria XQD a partire dal video 
contenuto nella memoria cache.

Per annullare Picture Cache Rec

Impostare Picture Cache >Rec Setting nel menu 
Recording su Off, oppure premere il pulsante 
programmabile a cui è assegnata la funzione 
Picture Cache Rec.

[Note]
ˎˎ Se si cambia il formato di registrazione, il video già 

esistente nella memoria cache viene eliminato e la 
memoria cache inizia a registrare nuovo video. Di 
conseguenza, non è possibile registrare le immagini 
presenti nella cache prima del cambiamento del formato 
anche se la registrazione viene avviata immediatamente 
dopo il cambiamento del formato.
ˎˎ Se Picture Cache Rec viene impostata su On o Off 

immediatamente dopo l’inserimento di una scheda di 
memoria XQD è possibile che i dati della cache non 
vengano registrati sulla scheda.
ˎˎ Il video viene memorizzato nella memoria cache a partire 

dal momento in cui la funzione di Picture Cache Rec viene 
impostata su On. Prima dell’impostazione su On della 
funzione il video non viene memorizzato.
ˎˎ Durante l’accesso a una scheda di memoria XQD, 

ad esempio durante riproduzione, Rec Review o 
visualizzazione delle miniature, nella memoria cache non 
viene memorizzato video. Durante tale periodo non è 
possibile registrare immagini di cache.
ˎˎ È possibile modificare il tempo di registrazione della 

cache tramite il menu anche durante la registrazione, 
ma il nuovo valore entrerà in effetto solo al termine della 
registrazione corrente.

Revisione di una registrazione (Rec 
Review)

È possibile controllare il video dell’ultimo clip 
registrato sullo schermo.

Mentre la registrazione è arrestata, premere il 
pulsante programmabile (pagina 38) a cui è 
assegnata la funzione Rec Review.
Il clip viene riprodotto fino alla fine e il camcorder 
esce dalla funzione Rec Review e torna alla 
modalità di STBY (standby).
Premere e mantenere premuto il pulsante per 
avviare la riproduzione in direzione inversa. 
Rilasciando il pulsante, il clip viene riprodotto fino 
alla fine.

Per arrestare Rec Review

Premere il pulsante programmabile a cui è 
assegnata la funzione Rec Review.

[Nota]
La funzione Rec Review non è supportata se il formato video 
è stato modificato dopo la registrazione del clip.

Modalità autoritratto

È possibile ruotare l’immagine visualizzata nel 
mirino (pagina 7) verticalmente oppure 
orizzontalmente e verticalmente mediante il 
selettore MIRROR.
Questa funzione consente di ruotare il mirino di 
180° verso l’obiettivo.
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OFF

L’immagine non è invertita.

B/T

L’immagine è capovolta verticalmente.
La visualizzazione delle informazioni viene ruotata 
verticalmente ed orizzontalmente.

ROT

L’immagine è capovolta verticalmente ed 
orizzontalmente.
Anche la visualizzazione delle informazioni viene 
capovolta verticalmente ed orizzontalmente.

[Nota]
Le viste B/T e ROT sono visualizzate solo nel mirino. Il video in 
uscita e il video registrato rimangono inalterati.

Visualizzazione del Peaking

È possibile attivare o disattivare la visualizzazione 
del peaking premendo il pulsante PEAKING sul 
mirino (pagina 7).

Per attivare o disattivare il peaking ed impostarne 
il tipo e la frequenza, utilizzare la voce Peaking 
(pagina 67) del menu VF.

Visualizzazione del motivo zebra

È possibile attivare o disattivare la visualizzazione 
del motivo zebra premendo il pulsante ZEBRA sul 
mirino (pagina 7).
Per attivare o disattivare la visualizzazione del 
motivo zebra e impostarne il tipo e il livello 
di visualizzazione utilizzare la voce Zebra 
(pagina 67) del menu VF.

[Nota]
Il camcorder misura i valori dell’immagine nel mirino. In 
modalità Cine EI, regolare il livello di visualizzazione ed altri 
parametri in base alle impostazioni di Monitor LUT del mirino 
(pagina 65).

Video Signal Monitor

La voce Video Signal Monitor >Setting 
(pagina 69) del menu VF consente di specificare 
se visualizzare il segnale video sullo schermo 
del mirino come forma d’onda, vettorscopio o 
istogramma.
Il monitor del segnale video del camcorder misura 
il segnale video allo stadio di uscita del segnale. 
Pertanto, se il video viene emesso in uscita con 
il bordo ritagliato rispetto al video registrato, la 
componente di segnale eliminata dal ritaglio 
non verrà misurata. In tal caso, l’indicazione “EC” 
viene visualizzata nell’angolo superiore sinistro del 
monitor del segnale video.

Indicatore delle informazioni dello spazio colore

Quando Matrix >Preset Select (pagina 62) è 
impostato su BT.2020 nella modalità Custom 

mode, lo spazio colore dell’immagine di ingresso 
(in base alla risoluzione dell’uscita video, le 
impostazioni di Output Color Space e Source) 
viene visualizzato nella parte superiore destra del 
monitor del segnale video.

Visualizzazione delle informazioni della LUT di 
monitoraggio

Se l’uscita video è impostata su 2K o un valore 
inferiore in modalità Cine EI, è possibile scegliere 
se misurare il segnale video dal sistema SDI1 o 
dal sistema SDI2 tramite la voce Video Signal 
Monitor >Source (pagina 69) del menu 
VF. L’impostazione della LUT di monitoraggio 
(pagina 65) del sistema SDI specificato viene 
visualizzata nell’angolo superiore destro del 
monitor del segnale video.

[Note]
ˎˎ Quando la voce Display On/Off >Setting (pagina 68) del 

menu VF è impostata su Off, il monitor del segnale video 
non viene visualizzato.
ˎˎ Quando l’impostazione della LUT monitor del sistema 

SDI specificato è impostata su Off, nell’angolo superiore 
destro del monitor del segnale video viene visualizzata 
l’impostazione di Color Space (pagina 74).
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Acquisizione delle informazioni di 
posizione (GPS)

Quando l’opzione GPS del menu System è 
impostata su On, il camcorder visualizzerà l’icona 

 durante la ricerca dei satelliti GPS. Una volta 
acquisito il posizionamento, le informazioni di 
posizione sono registrate con il video ripreso.

[Note]
ˎˎ L’opzione GPS del menu System non può essere impostata 

su On se non è montata la maniglia. Il ricevitore GPS si 
trova infatti all’interno della maniglia stessa.
ˎˎ L’icona visualizzata nel mirino varia a seconda della qualità 

di ricezione del segnale proveniente dai satelliti GPS.
ˎˎ Durante l’utilizzo della funzione GPS, è possibile che 

afferrare la maniglia con la mano possa influenzare la 
precisione di posizionamento.

Stato di 
posizionamento

Visualizzazione Stato della ricezione GPS

Off Nessuna 
visualizzazione

GPS impostato su Off o si è 
verificato un errore.

Posizionamento 
non disponibile

Non è possibile acquisire 
informazioni di posizione 
perché non è possibile 
ricevere il segnale GPS. 
Spostarsi in un luogo che 
permetta una visione del 
cielo senza impedimenti.

Ricerca di 
satelliti in 
corso

Ricerca dei satelliti GPS 
L’acquisizione dei satelliti 
può richiedere alcuni 
minuti.

Posizionamento Il segnale GPS ricevuto è 
molto debole.

Il segnale GPS ricevuto è 
adeguato. È possibile 
acquisire informazioni 
geografiche.

Il segnale GPS ricevuto è 
buono. È possibile 
acquisire informazioni di 
posizione.

[Informazioni]
ˎˎ Per impostazione predefinita, la funzione GPS è impostata 

su On. Mentre la funzione di posizionamento è attiva, il 
camcorder registra le informazioni di posizione, data e ora 
del video ripreso.
ˎˎ Se tuttavia l’icona di posizionamento non appare entro 

alcuni minuti, è possibile che vi siano problemi con la 
ricezione del segnale. Avviare la ripresa senza informazioni 
di posizione o spostarsi in un luogo che permetta 
una visione del cielo senza impedimenti. Se l’icona di 
posizionamento non è visualizzata, le informazioni di 
posizione non saranno registrate con le riprese.
ˎˎ Il segnale GPS può non essere ricevibile durante le riprese 

in interni o in prossimità di edifici di una certa altezza. 
Spostarsi in un luogo che permetta una visione del cielo 
senza impedimenti.
ˎˎ A seconda dell’intensità del segnale ricevuto, la 

registrazione delle informazioni di posizione potrebbe 
interrompersi anche se l’icona di posizionamento rimane 
visualizzata.

Riprese in modalità Cine EI

Questa modalità imita il funzionamento di una 
macchina da presa cinematografica e presuppone 
lo “sviluppo” in post-produzione.

Limitazioni della modalità Cine EI

ˎˎ Funzioni che non possono essere regolate 
automaticamente

–– Bilanciamento del bianco
–– Guadagno
–– Shutter
–– Iris

ˎˎ Funzioni che non possono essere configurate
–– Sensibilità ISO/guadagno
–– Impostazioni del menu Paint
–– Scene File
–– Lens File

Funzioni disponibili solo in modalità Cine EI

ˎˎ Exposure Index
ˎˎ Monitor LUT

ˎˎ High/Low Key
ˎˎ Registrazione di video RAW

Registrazione di video RAW

È possibile registrare video RAW su un registratore 
AXS-R5 (opzione) convertendo il segnale in uscita 
dal connettore RAW OUT di un’unità di estensione 
XDCA-FS7 (opzione) connessa al camcorder 
tramite un’unità di interfaccia HXR-IFR5 (opzione) 
(pagina 28).

1	 Configurare il registratore RAW esterno 
(pagina 28).

2	 Impostare Base Setting >Shooting Mode nel 
menu System su Cine EI.

3	 Impostare Codec >Select nel menu System su 
RAW.
Selezionando RAW & XAVC-I è possibile 
registrare contemporaneamente video RAW 
sul registratore RAW esterno e video HD sulle 
schede di memoria XQD del camcorder.

4	 Impostare la risoluzione mediante Imager Scan 
Mode nel menu System.
Se impostato su Normal, la risoluzione RAW 
sarà 4096×2160.

5	 Impostare la frequenza fotogrammi in Rec 
Format >RAW Output Format nel menu 
System.

6	 Controllare che il registratore esterno sia 
acceso, quindi premere il pulsante di 
registrazione del camcorder.

	 [Nota]
Quando si avvia la registrazione su un registratore 
esterno, senza utilizzare il pulsante di registrazione del 
camcorder, i clip non vengono registrati correttamente.

Di seguito si elencano i formati di uscita RAW.

NTSC Area
Impostazione Codec 
>Select 

Formati di uscita RAW

RAW / RAW & XAVC-I / 
RAW &XAVC-L / RAW 
&MPEG HD422

4096×2160 59.94P

4096×2160 29.97P

4096×2160 23.98P

2048×1080 59.94P

2048×1080 29.97P

2048×1080 23.98P

PAL Area
Impostazione Codec 
>Select

Formati di uscita RAW

RAW / RAW & XAVC-I / 
RAW &XAVC-L / RAW 
&MPEG HD422

4096×2160 50P

4096×2160 25P

2048×1080 50P

2048×1080 25P

Indicazione dello stato di registrazione

Se Display On/Off (pagina 68) >HXR-IFR5 Rec 
Control del menu VF è impostato su On, lo stato 
della registrazione RAW è visualizzato nel mirino 
con un’icona.

[Nota]
Il connettore RAW OUT del camcorder controlla la 
registrazione solo inviando un segnale Rec Control al 
registratore esterno. Per questa ragione, è possibile che il 
camcorder indichi che è in corso una registrazione RAW 
anche se il registratore esterno in realtà non sta registrando. 
Controllare l’effettivo stato operativo servendosi sempre 
dell’indicatore del registratore esterno.

Registrazione Slow & Quick Motion

Se S&Q Motion >Setting del menu Recording è 
impostata su On, il video RAW viene registrato in 
modalità Slow & Quick Motion.
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L’uscita RAW in Slow & Quick Motion è supportata 
solo per la risoluzione 2K a 120/240 fps (NTSC) e 
100/200 fps (PAL).

Aggiunta di connettori di ingresso 
audio

È possibile collegare contemporaneamente al 
camcorder fino a quattro canali di dispositivi audio 
XLR utilizzando un adattatore XLR-K2M XLR (non in 
dotazione).
Montare l’adattatore XLR sulla slitta MI e, nel menu 
Audio, impostare Audio Input >CH3 Input Select 
su Shoe 1 e CH4 Input Select su Shoe 2.
Le funzioni del camcorder che si sovrappongono 
verranno disabilitate per i canali per i quali è 
selezionato come ingresso l’adattatore XLR. 
Eseguire le regolazioni necessarie servendosi dei 
pulsanti e delle manopole dell’adattatore XLR.

[Note]
ˎˎ Se Audio Input >CH3 Level e CH4 Level nel menu Audio 

sono impostati su Audio Input Level, il valore di Audio 
Input Level del camcorder verrà regolato in modo da 
corrispondere al valore impostato sull’adattatore XLR.  
Audio Input Level viene abilitato anche quando il selettore 
dell’adattatore XLR è impostato su AUTO.  
Se è specificato “Through”, l’audio verrà registrato al livello 
impostato con l’adattatore XLR (pagina 101).
ˎˎ È possibile impostare anche su CH1 e CH2 montando un 

adattatore XLR e impostando Audio Input >CH1 Input 
Select e CH2 Input Select nel menu Audio rispettivamente 
su Shoe 1 e Shoe 2. Tuttavia, se si assegna l’ingresso 
dall’adattatore XLR a entrambi i canali CH1 e CH2, non sarà 
possibile assegnare a tali canali l’ingresso dai connettori 
INPUT1/INPUT2 del camcorder.

Controllo della registrazione su un 
dispositivo di registrazione esterno

Utilizzando l’impostazione SDI/HDMI Rec Control 
>Setting (pagina 71) del menu Recording, 
è possibile sincronizzare la registrazione su 
un dispositivo di registrazione esterno con le 
operazioni di avvio e arresto della registrazione del 
camcorder.

Impostazione Descrizione

Off La sincronizzazione dell’avvio e 
dell’arresto della registrazione su un 
dispositivo esterno collegato 
mediante il segnale di uscita SDI/
HDMI è disattivata.

SDI/HDMI 
Remote I/F

La sincronizzazione dell’avvio e 
dell’arresto della registrazione su un 
dispositivo esterno collegato 
mediante il segnale di uscita SDI/
HDMI è abilitata.

[Nota]
Se non è inserito un supporto, viene 
solamente emesso il segnale di trigger 
REC.

Parallel Rec L’adattatore CBK-WA100 collegato al 
connettore SDI OUT registra un file 
proxy contemporaneamente alla 
registrazione da parte del 
camcorder.
È abilitata anche la sincronizzazione 
dell’avvio e dell’arresto della 
registrazione su un dispositivo 
esterno collegato mediante il 
segnale di uscita HDMI.

Icone visualizzate

L’indicatore di stato controllo uscita SDI/HDMI 
(pagina 10) dello schermo del mirino visualizza 
le icone descritte di seguito.

Impostazione Descrizione

SDI/HDMI Remote I/F

Parallel Rec

Lo stato di comando della registrazione (“Rec” o 
“Stop”) è visualizzato sulla destra dell’icona.

[Note]
ˎˎ Se il dispositivo esterno connesso non è compatibile con 

il segnale di trigger REC, il dispositivo non può essere 
comandato.
ˎˎ Durante la registrazione simultanea, il segnale di trigger 

REC viene emesso in uscita nei seguenti casi:
–– SDI/HDMI Remote I/F: Operazione sul lato supporto A.
–– Parallel Rec: Durante la registrazione su qualsiasi 

supporto.

Registrazione simultanea di video proxy

ˎˎ Quando è impostato Parallel Rec:
–– Il file proxy registrato dall’adattatore 

CBK‑WA100 ha lo stesso nome di clip del 
video registrato dal camcorder.

–– La registrazione del file proxy dell’adattatore 
CBK‑WA100 segue lo stato di registrazione 
dello slot A o dello slot B. La registrazione del 
file proxy dell’adattatore CBK‑WA100 si avvia 
all’avvio della registrazione su uno degli slot. 
La registrazione del file proxy dell’adattatore 
CBK‑WA100 si arresta quando si arresta la 
registrazione su entrambi gli slot.

–– L’indicatore STATUS dell’adattatore 
CBK‑WA100 deve essere illuminato in giallo-
verde per sincronizzare la registrazione del 
file proxy sul CBK-WA100 con la funzione di 
registrazione del camcorder. 
La registrazione del file proxy sul CBK‑WA100 
non viene sincronizzata con la funzione di 
registrazione del camcorder se si verifica una 
delle seguenti condizioni:

–– Quando S&Q Motion >Setting nel menu 
Recording è impostato su On

–– Quando Interval Rec >Setting nel menu 
Recording è impostato su On

–– Quando Picture Cache Rec >Setting nel menu 
Recording è impostato su On

–– Quando Simul Rec >Rec Button Set nel menu 
Recording è impostato su una delle seguenti 
opzioni durante la registrazione simultanea 
sulla scheda di memoria A e sulla scheda di 
memoria B: 
Rec Button [SlotA] Handle Rec Button [SlotB] 
Rec Button [SlotB] Handle Rec Button [SlotA]

ˎˎ Di seguito si indicano i segnali di uscita SDI 
del camcorder per i quali il CBK-WA100 può 
registrare file proxy.

–– 1920×1080 59.94i
–– 1920×1080 50i
–– 1920×1080 29.97PsF
–– 1920×1080 25PsF
–– 1920×1080 23.98PsF
–– 1280×720 59.94P
–– 1280×720 50P

ˎˎ Parallel Rec non può essere selezionato quando 
Codec >Select è impostato su RAW nel menu 
System.
ˎˎ L’indicatore di stato, il trasferimento dei file e 
alcune altre funzioni del camcorder non sono 
supportati quando il camcorder è collegato 
tramite cavo USB.
ˎˎ Per il supporto da parte del camcorder, il 
CBK‑WA100 deve avere la versione firmware v3.0 
o successiva.



000 3. Ripresa44

Collegamento di un tablet o di altri dispositivi tramite LAN wireless
Montando il modulo LAN wireless USB IFU-WLM3 
(fornito) oppure un adattatore wireless CBK-WA100 
(opzione), il camcorder è in grado di connettersi a 
smartphone, tablet e altri dispositivi mediante una 
connessione LAN wireless.

[Nota]
Non è supportato l’utilizzo di moduli wireless USB diversi dal 
modello IFU-WLM3.

I dispositivi connessi tramite una rete LAN wireless 
consentono di eseguire le funzioni elencate di 
seguito.
ˎˎ Comando a distanza  
Consente il comando a distanza del camcorder.
ˎˎ Monitoraggio video (solo con adattatore 
CBK‑WA100)  
Consente il monitoraggio del video del 
camcorder.  
È necessario utilizzare l’adattatore CBK-WA100 
(opzione) e l’applicazione Content Browser 
Mobile.

[Informazione]
Per informazioni dettagliate sull’applicazione Content 
Browser Mobile rivolgersi al proprio rappresentante 
commerciale o di assistenza tecnica Sony.

Dispositivi compatibili

È possibile utilizzare smartphone, tablet o 
computer per configurare e azionare il camcorder. 
La seguente tabella indica i dispositivi, i sistemi 
operativi e i browser supportati.

Dispositivo Sistema operativo Browser

Smartphone Android 6.0 Chrome

iOS 9 Safari

Tablet Android 6.0 Chrome

iOS 9 Safari

Dispositivo Sistema operativo Browser

Computer Microsoft Windows 7/
Microsoft Windows 
8.1/Microsoft Windows 
10

Chrome

Mac OS 10.10/10.11 Safari

Collegamento del modulo IFU-WLM3

Inserire il modulo LAN wireless USB IFU-WML3 
nell’apposito connettore (pagina 4).
Dopo averlo montato, impostare Wi-Fi >Wi-Fi 
(pagina 79) nel menu System su Enable per 
abilitare la LAN wireless.

[Nota]
Connettere e disconnettere il modulo IFU-WLM3 solo mentre 
il camcorder è spento.

Montaggio dell’adattatore 
CBK‑WA100

[Nota]
Connettere e disconnettere l’adattatore CBK-WA100 solo 
mentre il camcorder è spento.

1	 Montare l’adattatore CBK-WA100 sulla staffa di 
montaggio e stringere le due viti.

2	 Montare la staffa di montaggio dell’adattatore 
CBK-WA100 sul camcorder e stringere la vite.

3	 Collegare il cavo USB dell’adattatore 
CBK‑WA100 al connettore del modulo LAN 
wireless USB (1) e il cavo SDI al connettore SDI 
OUT (2).

11

22

4	 Accendere l’adattatore CBK-WA100 e quindi 
accendere il camcorder.

5	 Impostare Wi-Fi >Wi-Fi (pagina 79) nel menu 
System su Enable per abilitare la LAN wireless.

6	 Impostare SDI/HDMI Rec Control >Setting nel 
menu Recording su Parallel Rec (pagina 43).

[Nota]
Per poter utilizzare l’adattatore CBK-WA100 con il camcorder 
è necessario configurare opportunamente le impostazioni di 
uscita SDI OUT. Tuttavia il camcorder non può emettere un 
segnale compatibile con l’adattatore CBK-WA100 quando si 
utilizza XAVC-I 24.0P o ProRes 23.98P (pagina 65).

Informazioni sull’adattatore CBK-WA100

L’adattatore CBK-WA100 è dotato di funzioni 
per l’utilizzo di file proxy di registrazione a bassa 
risoluzione su una scheda SD e per il trasferimento 
dei file a un server tramite una rete LAN wireless. 
Per ulteriori informazioni, consultare le istruzioni 
per l’uso fornite con l’adattatore CBK-WA100.
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Connessione “One-Touch” dei 
dispositivi NFC (solo con modulo 
IFU-WLM3)

I dispositivi che supportano la funzione NFC 
possono essere collegati tramite tale funzione 
(connessione “One-Touch”).

1	 Montare un modulo IFU-WLM3 sul camcorder 
(pagina 44) ed impostare Wi-Fi >Wi-Fi 
(pagina 79) nel menu System su Enable per 
abilitare la funzione LAN wireless.

 appare sullo schermo.

2	 Aprire [Settings] sul dispositivo, selezionare 
[More] e contrassegnare con un segno di 
spunta la casella di controllo NFC.
Le opzioni di impostazione disponibili variano 
a seconda del dispositivo. Per informazioni 
dettagliate, fare riferimento al manuale di 
istruzioni del dispositivo.

3	 Toccare il camcorder con il dispositivo.
Il dispositivo si connette al camcorder, apre un 
browser Web e visualizza il telecomando Wi-Fi. 
Alla prima connessione del dispositivo è 
necessario eseguire la procedura di 
autenticazione.

[Note]
ˎˎ Disabilitare in anticipo le modalità sleep e di blocco 

schermo.
ˎˎ Toccare e mantenere fermo il dispositivo fino a quando 

non si avvia l’applicazione “Content Browser Mobile” (1 o 
2 secondi).
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Visualizzazione del telecomando Wi-Fi Remote
La schermata dell’applicazione di telecomando Wi-
Fi Remote viene automaticamente ridimensionata 
a seconda delle dimensioni dello schermo del 
dispositivo collegato.

1	 Collegare il camcorder e il dispositivo tramite 
una connessione LAN wireless (pagina 45).

2	 Avviare un browser sul dispositivo e immettere 
“http://indirizzo IP del camcorder (Wi-Fi >IP 
Address nel menu System)/rm.html” nella barra 
dell’URL.
Ad esempio, se l’indirizzo IP è 192.168.1.1, 
immettere “http://192.168.1.1/rm.html” nella 
barra dell’URL.

3	 Immettere nome utente e password (Basic 
Authentication >User Name e Password nel 
menu System).
Quando la connessione è stabilita, la 
schermata di Wi-Fi Remote apparirà sul 
dispositivo.
Azionare il camcorder dalla schermata di Wi-Fi 
Remote.
È possibile disabilitare il pulsante di 
registrazione spostando il selettore Lock verso 
destra.

[Note]
ˎˎ Se si utilizza uno smartphone, visualizzare la pagina 

sostituendo “rm.html” con “rms.html” nell’URL. Se si 
utilizza un tablet, visualizzare la pagina sostituendo “rm.
html” con “rmt.html” nell’URL. Se si immette “rm.html” la 
pagina dovrebbe cambiare automaticamente in base al 
dispositivo connesso. Ciononostante, è possibile che in 
certi dispositivi non venga visualizzata la pagina corretta.
ˎˎ Nelle circostanze elencate di seguito, è possibile che 

la schermata di Wi-Fi Remote non corrisponda alle 
impostazioni del camcorder. In tal caso, ricaricare la 
finestra del browser.

–– Se il camcorder viene riavviato mentre è connesso.
–– Se il camcorder viene azionato direttamente mentre è 

connesso.
–– Se il dispositivo si è riconnesso.
–– Se sono stati utilizzati i pulsanti avanti/indietro del 

browser.
ˎˎ La funzione di telecomando Wi-Fi Remote potrebbe 

non funzionare correttamente se l’intensità del segnale 
wireless è insufficiente.
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Schermata delle miniature
La schermata delle miniature viene visualizzata premendo il pulsante THUMBNAIL (pagina 6). Questa schermata mostra miniature (immagini di indice) dei clip contenuti nelle schede di memoria XQD.
La schermata delle miniature consente di selezionare un clip e avviarne la riproduzione. La riproduzione può essere visualizzata nel mirino e su un monitor esterno.
Premere di nuovo il pulsante THUMBNAIL per chiudere la schermata delle miniature e tornare all’immagine della videocamera.

[Note]
ˎˎ La schermata delle miniature mostra solo i clip registrati nel formato di registrazione correntemente selezionato. Se un clip registrato che avrebbe dovuto essere presente non è visualizzato, controllare il formato di registrazione. Prestare attenzione a questo 

fatto prima di procedere con la formattazione (inizializzazione) dei supporti di memoria.
ˎˎ Quando l’opzione Codec >Select del menu System è impostata su uno dei valori elencati di seguito, non sarà possibile avviare la registrazione durante la riproduzione o mentre è visualizzata la schermata delle miniature.  

RAW & XAVC-I, RAW & XAVC-L, RAW & MPEG HD422

Elementi dello schermo

Nella parte inferiore dello schermo vengono visualizzate le informazioni relative al clip su cui è posizionato il cursore.

1

2

3 4 5

6

Indicatore della scheda di memoria XQD correntemente selezionata
(se la scheda è protetta, viene visualizzata l’icona del lucchetto).

Cursore (giallo)

Numero del clip/Numero dei clip

1.	 Miniatura (immagine indice)
Visualizza l’immagine indice del clip. Quando 
si registra un clip, il primo fotogramma viene 
impostato automaticamente come immagine 
indice.
Sotto la miniatura vengono visualizzate 
informazioni sul clip e sul fotogramma. È possibile 
scegliere le informazioni visualizzate con la voce 
Customize View (pagina 72) >Thumbnail 
Caption del menu Thumbnail.

2.	 Nome del clip
Visualizza il nome del clip selezionato.

3.	 Formato di registrazione video
Visualizza il formato del file del clip selezionato.

4.	 Informazioni sulla registrazione speciale
Se il clip è stato registrato con una modalità di 
registrazione speciale, ne indica la modalità.
Se il clip è registrato in modalità Slow & Quick 
Motion, ne viene indicata la frequenza fotogrammi 
sulla destra.

5.	 Durata del clip

6.	 Data di creazione
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Riproduzione di clip
Riproduzione dei clip registrati

È possibile riprodurre i clip registrati mentre il 
camcorder si trova in modalità standby (Stby) di 
registrazione.

1	 Inserire la scheda di memoria XQD da 
riprodurre.

2	 Premere il pulsante THUMBNAIL.

3	 Ruotando la manopola SEL/SET (pagina 6), 
spostare il cursore sul clip da riprodurre.

4	 Premere la manopola SEL/SET.
La riproduzione si avvia dall’inizio del clip 
selezionato.

È possibile comandare la riproduzione con i 
seguenti pulsanti:
Manopola SEL/SET:  

Mette in pausa la riproduzione  
Premere una seconda volta per tornare alla 
riproduzione normale.

Pressione dei pulsanti sinistro/destro:  
Salta all’inizio del clip corrente o all’inizio del 
clip successivo.

Pressione continua dei pulsanti sinistro/destro:  
Ritorno e avanzamento veloce.  
Torna alla riproduzione normale quando si 
rilascia il pulsante.

Pulsante CANCEL/BACK:  
Arresta la riproduzione e torna alla modalità 
standby di registrazione.

[Note]
ˎˎ Nel passaggio da un clip a un altro la visualizzazione 

dell’immagine potrebbe momentaneamente frazionarsi 
o arrestarsi. Durante questo periodo non è possibile 
azionare il camcorder.
ˎˎ Quando si seleziona un clip nella schermata delle 

miniature e ha inizio la riproduzione, potrebbero verificarsi 
temporanei frazionamenti dell’immagine all’inizio del clip. 
Per visualizzare l’inizio del clip senza frazionamenti, avviare 
la modalità di riproduzione, mettere in pausa, quindi 

utilizzare il pulsante sinistro della manopola SEL/SET per 
tornare all’inizio del clip e riavviare la riproduzione.
ˎˎ È possibile comandare la riproduzione anche con il 

telecomando fornito in dotazione.
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Nella schermata delle miniature è possibile 
eseguire operazioni di gestione dei clip e 
controllarne le proprietà tramite il menu delle 
miniature.
Il menu delle miniature (pagina 71) viene 
visualizzato quando si preme il pulsante MENU e si 
seleziona una miniatura.

Utilizzo del menu delle miniature

Ruotare la manopola SEL/SET (pagina 6) per 
selezionare una funzione, quindi premere la 
manopola SEL/SET.
Premere il pulsante CANCEL/BACK (pagina 6) 
per ritornare alla schermata precedente.

[Nota]
A seconda dello stato operativo del camcorder quando viene 
visualizzato il menu, alcune voci potrebbero non essere 
selezionabili.

Voci del menu delle miniature

ˎˎ Display Clip Properties
ˎˎ Set Index Picture
ˎˎ Thumbnail View
ˎˎ Set Shot Mark
ˎˎ Set Clip Flag
ˎˎ Lock/Unlock Clip
ˎˎ Delete Clip
ˎˎ Filter Clips
ˎˎ Customize View

Per informazioni dettagliate sull’utilizzo del 
menu delle miniature, fare riferimento a “Menu 
Thumbnail” (pagina 71).

Displaying clip properties

Selezionare Display Clip Properties (pagina 71) 
nel menu Thumbnail per visualizzare la schermata 
delle proprietà dei clip.

Visualizzazione della schermata delle miniature 
con indicatori di identificazione.

Selezionare Thumbnail View (pagina 71) 
>Essence Mark Thumbnail nel menu Thumbnail, 
quindi selezionare il tipo di indicatore di 
identificazione (Essence Mark) desiderato per 
visualizzare le miniature dei fotogrammi che lo 
contengono.

Visualizzazione della schermata delle miniature 
filtrata

Selezionare Filter Clips (pagina 72) nel menu 
Thumbnail, quindi selezionare il tipo di flag dei 
clip desiderato per visualizzare solo i clip che lo 
contengono
Per visualizzare tutti i clip, impostare Thumbnail 
View >Essence Mark Thumbnail nel menu 
Thumbnail su All.

Eliminazione di clip

È possibile eliminare clip dalle schede di memoria 
XQD.
Selezionare Delete Clip >Select Clip o All Clips nel 
menu Thumbnail.
Select Clip:  

Elimina il clip selezionato. È possibile 
selezionare più clip contemporaneamente.

All Clips:  
Elimina tutti i clip visualizzati.

Scelta delle informazioni visualizzate nella 
schermata delle miniature

È possibile scegliere le informazioni sui clip o sui 
fotogrammi visualizzate sotto la miniatura.
Selezionare Customize View >Thumbnail Caption 
nel menu Thumbnail, quindi selezionare le 
informazioni da visualizzare.
Date Time:  

Visualizza la data e l’ora di creazione e 
dell’ultima modifica del clip.

Time Code:  
Visualizza il codice temporale.

Duration:  
Visualizza la durata del clip.

Sequential Number:  
Visualizza un numero sequenziale su ogni 
miniatura.

Operazioni con i clip
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Struttura del menu di configurazione
Premere il pulsante MENU per visualizzare nel 
mirino il menu di configurazione in cui specificare 
le opzioni necessarie per la ripresa, la registrazione 
e la riproduzione (il menu può essere visualizzato 
anche su un monitor esterno). Il menu di 
configurazione comprende i menu elencati di 
seguito:

Configurazione dei menu

Menu User
Contiene voci di menu configurate dall’utente 
tramite il menu Edit User.

Menu Edit User
Contiene comandi per la modifica del menu 
User.

Menu Camera
Contiene opzioni relative alla ripresa.

Menu Paint
Contiene opzioni relative alla qualità 
dell’immagine.

Menu Audio
Contiene opzioni relative all’audio.

Menu Video
Contiene opzioni relative all’uscita video.

Menu VF
Contiene opzioni relative alla visualizzazione 
sul mirino.

Menu TC/UB
Contiene opzioni relative al codice temporale 
e ai bit utente.

Menu Recording
Contiene opzioni relative alla registrazione.

Menu Thumbnail 
Contiene opzioni relative alla visualizzazione 
delle miniature.

Menu Media
Contiene opzioni relative ai supporti di 
memorizzazione.

Menu File
Contiene opzioni relative ai file.

Menu System
Contiene opzioni relative al sistema.

Struttura del menu di configurazione

User  
(impostazioni di 
fabbrica)

Country

Base Setting

Rec Format

Codec

S&Q Motion

Interval Rec

Picture Cache Rec

Simul Rec

Output Format

Monitor LUT

Clip

VF Setting

Assignable Button

Assignable Dial

Format Media

Edit User Menu

Edit User Add Item

Customize Reset

Camera ISO/Gain/EI

ND Filter

Auto Exposure

Focus

Shutter 

Color Bars

Noise Suppression

Flicker Reduce

SteadyShot 

Handle Zoom

Auto Black Balance

AF Micro Adjustment

Video Light Set

Paint White

Offset White

Black

Gamma

Black Gamma

Knee

White Clip

Detail

Skin Detail

Aperture

Matrix 

Multi Matrix 

Maintenance

Audio Audio Input

Audio Output

Video Output On/Off

Output Format

Output Setting

Monitor LUT

Output Display

VF VF Setting

Peaking

Zebra

Marker

Display On/Off

Video Signal Monitor

TC/UB Timecode

TC Display

User Bits

HDMI TC Out

Recording S&Q Motion

Interval Rec

Picture Cache Rec

Simul Rec

SDI/HDMI Rec Control
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Thumbnail Display Clip Properties

Set Index Picture

Thumbnail View

Set Shot Mark

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Filter Clips

Customize View

Media Update Media

Format Media

Clip

File All File

Scene File

User Menu Item

User Gamma

Monitor LUT

Monitor 3D LUT

Lens File

System Base Setting

Codec

Rec Format

Genlock 

Assignable Button

Assignable Dial

ND Dial

Rec Lamp

Fan Control 

HOLD Switch Setting

Lens

Language

Clock Set

Country

Hours Meter

System Basic Authentication

Wi-Fi 

GPS

IR Remote

Camera Battery Alarm

Camera DC IN Alarm

Ext.  Unit Battery Alarm

Ext.  Unit DC IN Alarm

All Reset

APR

Camera Config

Version



000 5. Menu visualizzati e impostazioni52

Utilizzo del menu di configurazione
Premere il pulsante MENU per visualizzare nel 
mirino il menu di configurazione in cui specificare 
le opzioni necessarie per la ripresa, la registrazione 
e la riproduzione (il menu può essere visualizzato 
anche su un monitor esterno).

Comandi del menu

Pulsante MENU (pagina 6)
Attiva o disattiva la modalità per utilizzare il 
menu di configurazione.

Pulsante sinistro / Pulsante destro (pagina 6)
Premere il pulsante sinistro o destro per 
spostare il cursore verso sinistra o destra e 
selezionare voci o impostazioni del menu.

Manopola SEL/SET (pagina 6)
ˎˎ Ruotare la manopola SEL/SET per spostare 
il cursore verso l’alto o il basso e selezionare 
voci o impostazioni del menu.
ˎˎ Premere la manopola SEL/SET per applicare 
la voce selezionata.

Pulsante CANCEL/BACK (pagina 6)
Annulla un’impostazione prima della sua 
applicazione e si sposta sul livello precedente 
della struttura dei menu.

[Nota]
Il menu di configurazione non può essere utilizzato quando il 
camcorder si trova in modalità di ingrandimento della messa 
a fuoco (pagina 32).

Impostazione delle voci dei menu

Ruotare la manopola SEL/SET per spostare il 
cursore sulla voce di menu da impostare, quindi 
premere la manopola per selezionare la voce.
ˎˎ Nell’area di selezione delle voci del menu 
vengono visualizzate un massimo di otto 
righe. Se non possono essere visualizzate 
contemporaneamente tutte le opzioni 

disponibili per una determinata voce, scorrere le 
opzioni spostando il cursore verso l’alto o verso 
il basso.
ˎˎ Se la gamma di opzioni disponibili per una voce 
è molto ampia (ad esempio da –99 a +99), l’area 
di selezione non viene visualizzata. Viene invece 
evidenziato il valore corrente per indicare che 
tale valore può essere modificato.
ˎˎ Per eseguire una funzione, selezionare [Execute].
ˎˎ Se si seleziona una voce che richiede 
conferma prima dell’esecuzione, il menu 
verrà momentaneamente nascosto e verrà 
visualizzato un messaggio di conferma. 
Controllare il messaggio e quindi scegliere se 
eseguire o annullare la funzione.

Immissione di una stringa di caratteri

Quando si seleziona una voce che richiede 
l’immissione di caratteri, viene visualizzata la 
schermata di inserimento caratteri.

1

2 3

1	 Ruotare la manopola SEL/SET per selezionare il 
set di caratteri desiderato, quindi premere la 
manopola.
ABC: caratteri alfabetici maiuscoli
abc: caratteri alfabetici minuscoli
123: caratteri numerici
!#$: caratteri speciali

2	 Selezionare il carattere desiderato nel set 
specificato, quindi premere la manopola.
Il cursore si sposta sul campo successivo.
Space: inserisce uno spazio in corrispondenza 

della posizione del cursore
/: sposta la posizione del cursore.
BS: elimina il carattere alla sinistra del cursore.

3	 Al termine, selezionare [Done] e premere la 
manopola.
La stringa di caratteri viene confermata e la 
schermata di inserimento dei caratteri si 
chiude.
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Elenco delle voci del menu di configurazione
Questa sezione descrive le funzioni e le impostazioni delle voci di ogni menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB).

Menu User

User

Voce Impostazione della voce secondaria Descrizione

Country
Impostazioni regionali

Vedere Country nel menu System.

Base Setting
Impostazioni di base

Vedere Base Setting nel menu System.

Rec Format
Impostazioni del formato 
di registrazione

Vedere Rec Format nel menu System.

Codec
Impostazioni codec

Vedere Codec nel menu System.

S&Q Motion
Impostazioni della 
modalità Slow & Quick 
Motion

Vedere S&Q Motion nel menu 
Recording.

Interval Rec
Impostazioni della 
modalità Interval Rec

Vedere Interval Rec nel menu 
Recording.

Picture Cache Rec
Impostazioni della 
modalità di registrazione 
cache immagine

Vedere Picture Cache Rec nel menu 
Recording.

Simul Rec
Impostazioni della 
registrazione simultanea

Vedere Simul Rec nel menu Recording.

Output Format
Impostazioni del formato 
di uscita

Vedere Output Format nel menu Video.

Monitor LUT
Impostazioni di LUT 
monitor.

Vedere Monitor LUT nel menu Video.

Clip
Impostazioni relative al 
nome dei clip

Vedere Clip nel menu Media.

User

Voce Impostazione della voce secondaria Descrizione

VF Setting
Impostazioni del mirino

Vedere VF Setting nel menu VF.

Assignable Button
Impostazioni dei pulsanti 
programmabili

Vedere Assignable Button nel menu 
System.

Assignable Dial
Impostazioni delle 
manopole programmabili

Vedere Assignable Dial nel menu 
System.

Format Media
Formatta (inizializza) 
schede di memoria

Vedere Format Media nel menu Media.

Edit User Menu
Modifica le voci del menu 
User

Consente di modificare le voci del 
menu User.
Quando si seleziona Edit User Menu, il 
menu Edit User passa al livello più alto e 
vengono visualizzate tutte le voci di 
menu.

Edit User Menu

Quando si seleziona Edit User Menu, il menu Edit User viene visualizzato al livello più alto.

Edit User

Voce Impostazione della voce secondaria Descrizione

Add Item
Aggiunge una voce al 
menu User

Aggiunge una voce al menu User.

Customize Reset
Ripristina le voci del menu 
User.

Ripristina l’impostazione predefinita 
delle voci del menu User.

Voce di menu selezionata 
durante la modifica

Delete Rimuove dal menu User la voce di 
menu registrata.

Move Cambia l’ordine delle voci registrate del 
menu User.

Edit Sub Item Elimina le voci secondarie registrate nel 
menu User.
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Menu Camera

Camera >ISO/Gain/EI
Consente di specificare le impostazioni relative al guadagno.

Voce Impostazione della voce secondaria Descrizione

Mode ISO/dB Seleziona la modalità di impostazione del 
guadagno.

ISO/Gain<H> Quando Mode è impostato su ISO e la gamma 
dinamica è 460%:

ISO 800 / ISO 1000 / ISO 1250 / ISO 1600 / 
ISO 2000 / ISO 2500 / ISO 3200 /  
ISO 4000 / ISO 5000 / ISO 6400 

Quando Mode è impostato su ISO e la gamma 
dinamica è 800%:

ISO 1600 / ISO 2000 / ISO 2500 / ISO 3200 / 
ISO 4000 / ISO 5000 / ISO 6400 /  
ISO 8000 / ISO 10000 / ISO 12500

Quando Mode è impostato su ISO e la gamma 
dinamica è 1300% (Gamma Category 
impostata su S-Log2 o S-Log3):

ISO 2000 / ISO 2500 / ISO 3200 / ISO 4000 / 
ISO 5000 / ISO 6400 / ISO 8000 /  
ISO 10000 / ISO 12500 / ISO 16000

Quando Mode è impostato su dB:
–3dB / 0dB / 3dB / 6dB / 9dB / 12dB / 
18dB

Imposta il valore predefinito del guadagno 
<H>.

[Informazione]
La gamma dinamica è determinata dalla gamma.

Gamma Gamma 
dinamica

STD / HG1 / HG2 / HG3 / 
HG4

460%

HG7 / HG8 / User 800%

S-Log2 / S-Log3 1300%

ISO/Gain<M> (Stesse impostazioni di ISO/Gain<H>)
Di seguito si indicano i valori predefiniti.
Quando Mode è impostato su ISO e la gamma 
dinamica è 460%:

ISO1600
Quando Mode è impostato su ISO e la gamma 
dinamica è 800%:

ISO3200
Quando Mode è impostato su ISO e la gamma 
dinamica è 1300% (Gamma Category 
impostata su S-Log2 o S-Log3):

ISO4000
Quando Mode è impostato su dB:

6dB

Imposta il valore preimpostato del guadagno 
<M>.

Camera >ISO/Gain/EI
Consente di specificare le impostazioni relative al guadagno.

Voce Impostazione della voce secondaria Descrizione

ISO/Gain<L> (Stesse impostazioni di ISO/Gain<H>)
Di seguito si indicano i valori predefiniti.
Quando Mode è impostato su ISO e la gamma 
dinamica è 460%:

ISO800
Quando Mode è impostato su ISO e la gamma 
dinamica è 800%:

ISO1600
Quando Mode è impostato su ISO e la gamma 
dinamica è 1300% (Gamma Category 
impostata su S-Log2 o S-Log3):

ISO2000
Quando Mode è impostato su dB:

0dB

Imposta il valore preimpostato del guadagno 
<L>.

Exposure 
Index<H>

500EI / 4.0E
640EI / 4.3E
800EI / 4.7E
1000EI / 5.0E
1250EI / 5.3E
1600EI / 5.7E
2000EI / 6.0E
2500EI / 6.3E
3200EI / 6.7E
4000EI / 7.0E
5000EI / 7.3E
6400EI / 7.7E
8000EI / 8.0E

Imposta il valore dell’indice di esposizione 
<H>.
Disponibile solo in modalità Cine EI.

Exposure 
Index<M>

(Stesse impostazioni di Exposure Index<H>)
Il valore predefinito è 1600EI / 5.7E

Imposta il valore dell’indice di esposizione 
<M>.

Exposure 
Index<L>

(Stesse impostazioni di Exposure Index<H>)
Il valore predefinito è 800EI / 4.7E

Imposta il valore dell’indice di esposizione 
<L>.

Shockless Gain On / Off Attiva o disattiva la funzione di guadagno 
fluido.

Camera >ND Filter
Imposta i valori preimpostati del filtro ND.

Voce Impostazione della voce secondaria Descrizione

Preset1 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Imposta il valore Preset 1 del filtro ND.

Preset2 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Imposta il valore Preset 2 del filtro ND.

Preset3 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Imposta il valore Preset 3 del filtro ND.
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Camera >Auto Exposure
Consente di specificare le impostazioni della correzione automatica dell’esposizione

Voce Impostazione della voce secondaria Descrizione

Level –2.0 / –1.75 / –1.5 / –1.25 / –1.0 / –0.75 / –0.5 / 
–0.25 / 0 / +0.25 / +0.5 / +0.75 / +1.0 / +1.25 / 
+1.5 / +1.75 / +2.0

Imposta i livelli di luminosità per il valore di 
esposizione rilevato automaticamente.

Mode Backlight / Standard / Spotlight Imposta la modalità di controllo.
Backlight:  

modalità controluce (i soggetti ripresi in 
controluce appaiono meno scuri)

Standard:  
Modalità standard

Spotlight:  
Modalità riflettore (limita il clipping dei 
bianchi quando il soggetto è illuminato 
da riflettori)

Speed Da –99 a +99 (±0) Imposta la velocità di regolazione.

AGC On / Off Attiva o disattiva la funzione AGC (controllo 
del guadagno automatico).

AGC Limit Quando ISO/Gain/EI Mode è impostato su dB:
3dB / 6dB / 9dB / 12dB / 15dB / 18dB

Quando ISO/Gain/EI Mode è impostato su ISO 
e la gamma dinamica è 460%:

ISO1000 / ISO1600 / ISO2000 / ISO3200 / 
ISO4000 / ISO6400

Quando ISO/Gain/EI Mode è impostato su ISO 
e la gamma dinamica è 800%:

ISO2000 / ISO3200 / ISO4000 / ISO6400 / 
ISO8000 / ISO12500

Quando ISO/Gain/EI Mode è impostato su ISO 
e la gamma dinamica è 1300%:

ISO2500 / ISO4000 / ISO5000 / ISO8000 / 
ISO10000 / ISO16000

Imposta il guadagno massimo della funzione 
AGC.

Auto ND Filter On / Off Attiva o disattiva la funzione del filtro ND 
Auto (pagina 35).

Auto Shutter On / Off Attiva o disattiva la funzione di otturatore 
automatico.

A.SHT Limit 1/100 / 1/150 / 1/200 / 1/250 / 1/2000 Imposta la velocità massima della funzione di 
otturatore automatico.

Clip High light On / Off Attiva o disattiva la funzione che ignora le 
zone più luminose per dare una reazione più 
piatta alle luminanze elevate.

Camera >Auto Exposure
Consente di specificare le impostazioni della correzione automatica dell’esposizione

Voce Impostazione della voce secondaria Descrizione

Detect 
Window

1 / 2 / 3 / 4 / 5 / 6 Imposta il campo di misurazione della luce 
per la regolazione automatica della luce 
secondo la luminosità del soggetto. (Non 
disponibile quando l’esposizione viene 
regolata manualmente)

Detect 
Window 
Indication

On / Off Attiva o disattiva la funzione Detect Window.

Camera >Focus
Consente di specificare le impostazioni relative alla messa a fuoco.

Voce Impostazione della voce secondaria Descrizione

Focus Area Wide / Center / Flexible Spot Specifica la zona di messa a fuoco per la 
messa a fuoco automatica (pagina 32).
Wide:  

Cerca il soggetto su un ampio angolo 
dell’immagine durante la messa a fuoco.

Center:  
Mette a fuoco il soggetto al centro 
dell’immagine.

Flexible Spot:  
Mette a fuoco una posizione specificata 
dell’immagine.

Focus Area 
(Push AF)

Center / Flexible Spot Specifica la zona di messa a fuoco per la 
funzione Push Auto Focus (pagina 32).
Center:  

Mette a fuoco il soggetto al centro 
dell’immagine.

Flexible Spot:  
Mette a fuoco una posizione specificata 
dell’immagine.

[Nota]
L’adattatore opzionale LA-EA2/4 non consente 
l’impostazione della posizione.

AF Assist On / Off Quando è impostato su On, consente di 
ignorare momentaneamente la funzione di 
messa a fuoco automatica ed eseguire la 
messa a fuoco manualmente.
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Camera >Shutter
Consente di specificare le impostazioni relative alle condizioni di funzionamento dell’otturatore

Voce Impostazione della voce secondaria Descrizione

Mode Speed / Angle / ECS / Off Seleziona la modalità operativa 
dell’otturatore elettronico.

Speed/Angle (modalità standard):  
Consente di eseguire riprese nitide di 
soggetti in rapido movimento. Seleziona 
la modalità di impostazione della 
velocità dell’otturatore in secondi 
(Speed) o in gradi (Angle).

ECS (Extended Clear Scan)  
Consente la ripresa senza visualizzare 
barre orizzontali in movimento sullo 
schermo del monitor.

Camera >Shutter
Consente di specificare le impostazioni relative alle condizioni di funzionamento dell’otturatore

Voce Impostazione della voce secondaria Descrizione

Shutter Speed Da 1/3 a 1/9000
I valori disponibili variano a seconda della 
frequenza fotogrammi del formato video 
selezionato.
59.94P/59.94i:  

1/4, 1/8, 1/15, 1/30, 1/60, 1/90, 1/100, 
1/125, 1/180, 1/250, 1/350, 1/500, 1/725, 
1/1000, 1/1500, 1/2000, 1/3000, 1/4000, 
1/6000, 1/9000

50P/50i:  
1/3, 1/6, 1/12, 1/25, 1/50, 1/60, 1/100, 
1/120, 1/150, 1/215, 1/300, 1/425, 1/600, 
1/1000, 1/1250, 1/1750, 1/2500, 1/3500, 
1/6000, 1/9000

29.97P:  
1/4, 1/8, 1/15, 1/30, 1/60, 1/90, 1/100, 
1/125, 1/180, 1/250, 1/350, 1/500, 1/725, 
1/1000, 1/1500, 1/2000, 1/3000, 1/4000, 
1/6000, 1/9000 

25P:  
1/3, 1/6, 1/12, 1/25, 1/50, 1/60, 1/100, 
1/120, 1/150, 1/215, 1/300, 1/425, 1/600, 
1/1000, 1/1250, 1/1750, 1/2500, 1/3500, 
1/6000, 1/9000

24P:  
1/3, 1/6, 1/12, 1/24, 1/40, 1/48, 1/50, 1/60, 
1/96, 1/100, 1/120, 1/144, 1/192, 1/200, 
1/288, 1/400, 1/576, 1/1200, 1/2400, 
1/4800, 1/9000

23.98P:  
1/3, 1/6, 1/12, 1/24, 1/40, 1/48, 1/50, 1/60, 
1/96, 1/100, 1/120, 1/144, 1/192, 1/200, 
1/288, 1/400, 1/576, 1/1200, 1/2400, 
1/4800, 1/9000

Imposta la velocità dell’otturatore quando 
Mode è impostato su Speed.
1/1 può essere impostato quando la 
frequenza fotogrammi di registrazione S&Q è 
impostata su 1fps.

Shutter Angle 5.6° / 11.2° / 22.5° / 45° / 90° / 120° / 144° /  
150° / 172.8° / 180° / 216° / 300°

Imposta l’angolo dell’otturatore quando 
Mode è impostato su Angle.
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Camera >Shutter
Consente di specificare le impostazioni relative alle condizioni di funzionamento dell’otturatore

Voce Impostazione della voce secondaria Descrizione

ECS Frequency Da 23.99 a 8000
I valori disponibili variano a seconda della 
frequenza fotogrammi del formato video 
selezionato.
Di seguito si indicano i valori predefiniti.
59.94P: 60.00
59.94i: 60.00
50P: 50.00
50i: 50.00
29.97P: 30.00
24P: 24.02
23.98P: 23.99
25P: 25.02

Imposta la frequenza ECS quando Mode è 
impostato su ECS.

Camera >Color Bars
Consente di specificare le impostazioni della barra colori

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la barra colori.

[Note]
ˎˎ Questa opzione non può essere impostata su 

On quando è configurata la registrazione di 
video RAW.
ˎˎ Quando Matrix >Preset Select nel menu Paint 

è impostato su BT.2020, le barre di colore 
emettono in uscita informazioni di colore 
BT.2020. Alcuni colori nelle barre colore 
potrebbero apparire differenti sul mirino e 
l’uscita video impostata sulla gamma di colore 
BT.709. Per informazioni dettagliate sulla 
gamma di colore di ciascuna uscita video, fare 
riferimento a Output Color Space (pagina 65).

Type ARIB / SMPTE / 75% / 100% Seleziona il tipo di barra colori.

Camera >Noise Suppression
Consente di specificare le impostazioni relative alla soppressione del rumore.

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la soppressione del rumore.

[Informazione]
Il valore predefinito è Off se Base Setting 
>Shooting Mode nel menu System è impostato 
su Cine EI.

Level Low / Mid / High Imposta il livello di soppressione del rumore.

Camera >Flicker Reduce
Consente di specificare le impostazioni relative alla correzione dello sfarfallio.

Voce Impostazione della voce secondaria Descrizione

Mode Auto / On / Off Imposta la modalità di correzione dello 
sfarfallio.

Frequency 50Hz / 60Hz Consente di specificare la frequenza della 
sorgente di alimentazione del dispositivo di 
illuminazione che causa lo sfarfallio.

Camera >SteadyShot
Consente di specificare le impostazioni relative alla stabilizzazione dell’immagine.

Voce Impostazione della voce secondaria Descrizione

Setting Active SteadyShot / SteadyShot / Off Attiva o disattiva la funzione di 
stabilizzazione dell’immagine.

[Nota]
Disponibile quando è montato un obiettivo 
compatibile.

Camera >Handle Zoom
Consente di specificare le impostazioni relative allo zoom della maniglia.

Voce Impostazione della voce secondaria Descrizione

Zoom Speed 
Type

Fix / Variable / Off Imposta la modalità della levetta dello zoom 
della maniglia.

[Nota]
Disabilitato se la maniglia non è montata.

Zoom Speed Da 1 a 8 (3) Imposta la velocità dello zoom della 
maniglia.
(Abilitata se Zoom Speed Type è impostato 
su Fix)

[Nota]
Disabilitato se la maniglia non è montata.
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Camera >Auto Black Balance
Consente di specificare le impostazioni del bilanciamento automatico del nero.

Voce Impostazione della voce secondaria Descrizione

Auto Black 
Balance

Execute / Cancel Esegue la funzione di bilanciamento 
automatico del nero.

[Note]
ˎˎ Eseguire la funzione di bilanciamento 

automatico del nero con il copriobiettivo 
montato.
ˎˎ Non può essere eseguita durante la 

registrazione o la visualizzazione della barra 
colori.
ˎˎ Non può essere eseguita nelle modalità Interval 

Rec e Slow & Quick Motion.

Camera >AF Micro Adjustment
Imposta le regolazioni micro della posizione di messa a fuoco. (Abilitata quando si utilizza un adattatore 
LA-EA2/4 (opzione))

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la funzione di regolazione 
micro della messa a fuoco.

Amount Da –20 a 0 a +20 Imposta il livello di regolazione micro della 
messa a fuoco automatica.
Utilizzare la seguente procedura per regolare 
gli obiettivi con innesto A-mount.
1	� Montare l’obiettivo desiderato 

servendosi di un adattatore LA-EA2/4 
(opzione).

2	� Impostare Setting su On e regolare il 
valore Amount.  
Valori positivi spostano la messa a fuoco 
dietro al soggetto mentre valori negativi 
spostano la messa a fuoco davanti al 
soggetto.  
Si raccomanda di controllare i risultati 
utilizzando, ad esempio, la funzione One 
Push AF durante la regolazione della 
messa a fuoco.

Clear All Execute / Cancel Inizializza il valori di regolazione salvati.

Camera >Video Light Set
Specifica il metodo di illuminazione della luce video. Disponibile solo se viene utilizzata la luce video 
HVL-LBPC (opzionale).

Voce Impostazione della voce secondaria Descrizione

Video Light Set Power Link / Rec Link / Rec Link + Stby Imposta il metodo di controllo 
dell’illuminazione per la luce video montata 
sulla slitta Multi-interface.
Power Link:  

Accende e spegne la luce video in 
sincronia con l’accensione o 
spegnimento del camcorder.

Rec Link:  
Accende e spegne la luce video in 
sincronia con l’avvio e l’arresto della 
registrazione.

Rec Link + Stby:  
Accende o mette in standby la luce 
video in sincronia con l’avvio e l’arresto 
della registrazione.

Menu Paint

Paint >White
Specifica le impostazioni del bilanciamento del bianco.

Voce Impostazione della voce secondaria Descrizione

Preset White Da 2100K a 10000K (3200K) Imposta il valore predefinito del 
bilanciamento del bianco.

Color Temp 
<A>

Da 1500K a 50000K (3200K) Visualizza la temperatura di colore di 
bilanciamento del bianco salvata nella 
memoria A.

Color Temp.  
Balance <A>

Da –99 a +99 (±0) Imposta il valore di guadagno del 
bilanciamento del bianco salvato nella 
memoria A (correlato al guadagno R e al 
guadagno B).

R Gain <A> Da –99 a +99 (±0) Imposta il valore di guadagno R del 
bilanciamento del bianco salvato nella 
memoria A.

B Gain <A> Da –99 a +99 (±0) Imposta il valore di guadagno B del 
bilanciamento del bianco salvato nella 
memoria A.
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Paint >White
Specifica le impostazioni del bilanciamento del bianco.

Voce Impostazione della voce secondaria Descrizione

Color Temp 
<B>

Da 1500K a 50000K (3200K) Visualizza la temperatura di colore del 
bilanciamento del bianco salvata nella 
memoria B.

Color Temp.  
Balance <B>

Da –99 a +99 (±0) Imposta il valore di guadagno del 
bilanciamento del bianco salvato nella 
memoria B (correlato al guadagno R e al 
guadagno B).

R Gain <B> Da –99 a +99 (±0) Imposta il valore del guadagno R del 
bilanciamento del bianco salvato nella 
memoria B.

B Gain <B> Da –99 a +99 (±0) Imposta il valore del guadagno B del 
bilanciamento del bianco salvato nella 
memoria B.

Filter White 
Memory

On / Off Attiva o disattiva la funzione che imposta 
l’area di memoria del bilanciamento del 
bianco per ciascun filtro ND.
On: Imposta una memoria del bilanciamento 

del bianco per ciascun filtro ND.

	 [Informazione]
In modalità Preset, sono disponibili quattro 
impostazioni (CLEAR / 1 / 2 / 3). In modalità 
variabile, sono disponibili due impostazioni 
(CLEAR / On).

Off: Imposta una memoria del bilanciamento 
del bianco comune a tutti i filtri ND.

Shockless 
White

Off/1/2/3 Imposta la velocità di risposta del 
bilanciamento del bianco quando si cambia 
la modalità di bilanciamento del bianco.
Off: Commutazione istantanea.
Da 1 a 3: Il passaggio avviene più lentamente 

(velocità minore con numero più alto).

White 
Switch<B>

Memory / ATW Seleziona la modalità di regolazione del 
bilanciamento del bianco che viene 
selezionata quando l’interruttore WHT BAL è 
impostato su B.

ATW Speed 1 / 2 / 3 / 4 / 5 Imposta la velocità di risposta in modalità 
ATW.
1: Più alta velocità di risposta

Paint >Offset White
Specifica le impostazioni di correzione (offset) del bilanciamento del bianco.

Voce Impostazione della voce secondaria Descrizione

Offset White 
<A>

On / Off Seleziona se aggiungere (On) o non 
aggiungere (Off ) un valore di correzione al 
valore di bilanciamento del bianco della 
memoria A.

Warm Cool 
<A>

Da –99 a +99 (±0) Imposta come temperatura di colore la 
correzione aggiunta al bilanciamento del 
bianco della memoria A quando Offset 
White<A> è impostato su On.

Warm Cool 
Balance <A>

Da –99 a +99 (±0) Imposta una temperatura di colore più 
precisa, da utilizzare quando non è possibile 
ottenere un’immagine soddisfacente con 
l’impostazione Warm Cool <A>.

Offset White 
<B>

On / Off Seleziona se aggiungere (On) o non 
aggiungere (Off ) un valore di correzione al 
valore di bilanciamento del bianco della 
memoria B.

Warm Cool 
<B>

Da –99 a +99 (±0) Imposta come temperatura di colore la 
correzione aggiunta al bilanciamento del 
bianco della memoria B quando Offset White 
<B> è impostato su On.

Warm Cool 
Balance <B>

Da –99 a +99 (±0) Imposta una temperatura di colore più 
precisa, da utilizzare quando non è possibile 
ottenere un’immagine soddisfacente con 
l’impostazione Warm Cool <B>.

Offset White 
<ATW>

On / Off Specifica se aggiungere (On) o non 
aggiungere (Off ) un valore di correzione al 
bilanciamento del bianco ATW.

Warm 
Cool<ATW>

Da –99 a +99 (±0) Imposta come temperatura di colore la 
correzione aggiunta al bilanciamento del 
bianco ATW quando Offset White<ATW> è 
impostato su On.

Warm Cool 
Balance 
<ATW>

Da –99 a +99 (±0) Imposta una temperatura di colore più 
precisa, da utilizzare quando non è possibile 
ottenere un’immagine soddisfacente con 
l’impostazione Warm Cool <ATW>.

Paint >Black
Consente di specificare le impostazioni relative al nero.

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la correzione del nero
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Paint >Black
Consente di specificare le impostazioni relative al nero.

Voce Impostazione della voce secondaria Descrizione

Master Black Da –99 a +99 (±0) Imposta il livello del nero master.

[Nota]
Per la regolazione fine, ruotare la manopola 
SEL/SET lentamente. In questo caso, il valore 
visualizzato potrebbe non cambiare.

R Black Da –99 a +99 (±0) Imposta il livello R del nero.

B Black Da –99 a +99 (±0) Imposta il livello B del nero.

Paint >Gamma
Consente di specificare le impostazioni di correzione della gamma.

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la funzione di correzione 
della gamma.

Step Gamma Da 0.35 a 0.45 a 0.90 Imposta il valore di correzione della gamma 
in intervalli di 0,05.

Master 
Gamma

Da –99 a +99 (±0) Imposta il livello di gamma master.

R Gamma Da –99 a +99 (±0) Imposta il livello di gamma R.

G Gamma Da –99 a +99 (±0) Imposta il livello di gamma G.

B Gamma Da –99 a +99 (±0) Imposta il livello di gamma B.

Gamma 
Category

STD / HG / User / S-Log2 / S-Log3 Seleziona l’utilizzo della gamma standard 
(STD), HyperGamma (HG), gamma utente 
(User), S-Log2 o S-Log3.

Paint >Gamma
Consente di specificare le impostazioni di correzione della gamma.

Voce Impostazione della voce secondaria Descrizione

Gamma Select Quando Gamma Category è impostato su STD:
STD1 DVW / STD2 × 4.5 / STD3 × 3.5 / 
STD4 240M / STD5 R709 / STD6 × 5.0

Quando Gamma Category è impostato su HG:
HG1 3250G36 / HG2 4600G30 / HG3 
3259G40 / HG4 4609G33 / HG7 8009G40 / 
HG8 8009G33

Quando Gamma Category è impostato su 
User:

User 1 / User 2 / User 3 / User 4 / User 5
Quando Gamma Category è impostato su 
SLog2:

S-Log2
Quando Gamma Category è impostato su 
SLog3:

S-Log3

Seleziona la tabella di gamma da utilizzare 
nella correzione gamma.
Vedere la tabella sottostante per informazioni 
dettagliate su HyperGamma e 
S-Log2/S-Log3.

Nome Gamma 
dinamica

White 
Limit 
(limitaz. 
verso il 
bianco)

Uscita video 
cartoncino 
18% grigio 
(ingresso 
video 20%)

HG1 3250G36 325% 100% 36%

HG2 4600G30 460% 100% 30%

HG3 3259G40 325% 109% 40%

HG4 4609G33 460% 109% 33%

HG7 8009G40 800% 109% 40%

HG8 8009G33 800% 109% 33%

S-Log2 1300% – 32%

S-Log3 1300% – 41%

Paint >Black Gamma
Consente di specificare le impostazioni di correzione della gamma del nero.

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la correzione della gamma 
del nero.
(Abilitata quando Gamma >Gamma 
Category è impostata su STD)

[Nota]
Le funzioni Black Gamma e Knee >Knee 
Saturation non possono essere utilizzate 
contemporaneamente.

Range Low / Mid / High Seleziona il campo effettivo della correzione 
di gamma del nero.

Master Black 
Gamma

Da –99 a +99 (±0) Specifica il livello di gamma del nero master.
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Paint >Knee
Consente di specificare le impostazioni relative alla correzione del knee.

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la funzione di correzione 
del knee
(Abilitata quando Gamma >Gamma 
Category è impostata su STD)

Auto Knee On / Off Attiva o disattiva la funzione di correzione 
del knee automatica.

Point Da 75% a 109% (90%) Imposta il punto knee

Slope Da –99 a +99 (±0) Imposta la pendenza del knee

Knee 
Saturation

On / Off Abilita o disabilita la correzione della 
saturazione knee (corregge il colore sopra il 
punto di knee).

[Nota]
Le funzioni Black Gamma e Knee >Knee 
Saturation non possono essere utilizzate 
contemporaneamente.

Knee 
Saturation 
Level

Da –99 a +99 (±0) Imposta il livello di correzione del colore 
sopra il punto knee (saturazione knee)

Paint >White Clip
Specifica le impostazioni di regolazione del clipping del bianco.

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la funzione di regolazione 
del clip del bianco.

[Note]
ˎˎ L’impostazione viene ripristinata su On 

quando si spegne il camcorder. Per impostarla 
permanentemente su Off, impostare Level su 
109%.
ˎˎ Non può essere impostata quando Gamma 

>Gamma Category è impostata su S-Log2 or 
S-Log3.

Level Da 90.0% a 109.0%
L’impostazione predefinita varia a seconda del 
paese di acquisto.

NTSC Area: 108.0%
PAL Area: 105.0%

Specifica il livello di clipping del bianco.

Paint >Detail
Consente di specificare le impostazioni di regolazione dei dettagli

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la funzione di regolazione 
dei dettagli.

Level Da –99 a +99 (±0) Imposta il livello del dettaglio.

H/V Ratio Da –99 a +99 (±0) Specifica il rapporto di combinazione tra il 
livello di dettaglio H e il livello di dettaglio V.

Crispening Da –99 a +99 (±0) Imposta il livello di miglioramento della 
nitidezza.

Level Depend On / Off Attiva o disattiva la funzione di regolazione 
della dipendenza del livello.

Level Depend 
Level

Da –99 a +99 (±0) Imposta il livello della dipendenza del livello.

Frequency Da –99 a +99 (±0) Imposta la frequenza centrale del dettaglio 
(spessore di dettaglio).
Il dettaglio è tanto più sottile quanto più alta 
è la frequenza centrale e tanto più spesso 
quanto più bassa la frequenza centrale.

Knee Aperture On / Off Attiva o disattiva la funzione di correzione 
dell’apertura del knee.

Knee Aperture 
Level

Da –99 a +99 (±0) Imposta il livello di apertura knee.

Limit Da –99 a +99 (±0) Imposta il valore di limitazione del dettaglio 
sia verso il bianco che verso il nero

White Limit Da –99 a +99 (±0) Imposta il valore di limitazione del dettaglio 
verso il bianco.

Black Limit Da –99 a +99 (±0) Imposta il valore di limitazione del dettaglio 
verso il nero.

V Black Limit Da –99 a +99 (±0) Imposta il valore di limitazione del dettaglio 
V verso il nero.

V Detail 
Creation

NAM / Y / G / G+R Imposta la sorgente del segnale per la 
creazione del dettaglio V su NAM (G o R, 
qualunque sia maggiore), Y, G o G+R.

Paint >Skin Detail
Consente di specificare le impostazioni relative alla correzione dettaglio pelle.

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la funzione di correzione 
del dettaglio pelle.
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Paint >Skin Detail
Consente di specificare le impostazioni relative alla correzione dettaglio pelle.

Voce Impostazione della voce secondaria Descrizione

Area Detection Execute / Cancel Identifica il colore utilizzato per la correzione 
del dettaglio pelle.
Execute: Esegue l’identificazione.

Area Indication On / Off Attiva o disattiva la funzione che visualizza il 
motivo zebra nelle aree del colore utilizzato 
per la correzione del dettaglio pelle.

Level Da –99 a +99 (±0) Imposta il livello del dettaglio pelle.

Saturation Da –99 a +99 (±0) Imposta la saturazione del colore su cui 
applicare la correzione del dettaglio pelle.

Hue Da 0 a 359 Imposta la tonalità (hue) del colore su cui 
applicare la correzione del dettaglio pelle.

Width Da 0 a 90 (40) Specifica il campo della tonalità (hue) del 
colore su cui applicare la correzione del 
dettaglio pelle.

Paint >Aperture
Consente di specificare le impostazioni relative alla correzione dell’apertura.

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Abilita o disabilita la funzione di correzione 
dell’apertura, un processo che permette di 
migliorare la risoluzione aggiungendo sul 
segnale video un segnale di apertura ad alta 
frequenza che corregge il degrado dovuto 
alle caratteristiche delle alte frequenze.

Level Da –99 a +99 (±0) Imposta il livello della correzione di apertura.

Paint >Matrix
Consente di specificare le impostazioni relative alla correzione della matrice.

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la funzione di correzione 
della matrice.

Adaptive 
Matrix

On / Off Attiva o disattiva la funzione di matrice 
adattiva.

Preset Matrix On / Off Attiva o disattiva la funzione di matrice 
preimpostata.

Paint >Matrix
Consente di specificare le impostazioni relative alla correzione della matrice.

Voce Impostazione della voce secondaria Descrizione

Preset Select Standard
High Saturation
FL Light
Cinema
F55 709 Like
BT.2020

Seleziona una matrice preimpostata.

[Note]
ˎˎ BT.2020 può essere selezionato solo quando il 

formato di registrazione è 4K o QFHD.
ˎˎ Per informazioni dettagliate sulla gamma 

di colore di ciascuna uscita video quando 
è selezionato BT.2020, fare riferimento a 
“Impostazioni del menu Output e spazio colore 
dell’uscita video quando Preset Select è BT.2020” 
(pagina 92).
ˎˎ Per i due tipi di segnale indicati di seguito, 

quando è selezionato BT.2020 viene attivata la 
correzione della matrice BT.2020.

–– Segnali di uscita BT.2020 descritti in 
“Impostazioni del menu Output e spazio 
colore dell’uscita video quando Preset Select 
è BT.2020” (pagina 92).

–– Video registrato in 4K o QFHD
La correzione matrice ITU-R BT.709 equivalente 
viene invocata per i segnali di uscita BT.709 in 
“Impostazioni del menu Output e spazio colore 
dell’uscita video quando Preset Select è BT.2020” 
(pagina 92).

User Matrix On / Off Attiva o disattiva la funzione di matrice 
dell’utente.

Level Da –99 a +99 (±0) Regola la saturazione del colore dell’intera 
immagine.

Phase Da –99 a +99 (±0) Regola il tono di colore (la fase) dell’intera 
immagine.

User Matrix 
R-G

Da –99 a +99 (±0) Imposta una matrice R-G definita dall’utente.

User Matrix R-B Da –99 a +99 (±0) Imposta una matrice R-B definita dall’utente.

User Matrix 
G-R

Da –99 a +99 (±0) Imposta una matrice G-R definita dall’utente.

User Matrix 
G-B

Da –99 a +99 (±0) Imposta una matrice G-B definita dall’utente.

User Matrix B-R Da –99 a +99 (±0) Imposta una matrice B-R definita dall’utente.

User Matrix 
B-G

Da –99 a +99 (±0) Imposta una matrice B-G definita dall’utente.
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Paint >Multi Matrix
Consente di specificare le impostazioni relative alla correzione multimatrice.

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la correzione multimatrice

Area Indication On / Off Attiva o disattiva la funzione di indicazione 
dell’area.

Color 
Detection

Execute / Cancel Identifica il colore utilizzato per la correzione 
multimatrice.

Axis B / B+ / MG– / MG / MG+ / R / R+ / YL– / YL / 
YL+ / G– / G / G+ / CY / CY+ / B–

Seleziona l’asse.

Hue Da –99 a +99 (±0) Imposta la tonalità (hue) del colore per la 
correzione multimatrice.

Saturation Da –99 a +99 (±0) Imposta la saturazione del colore utilizzato 
per la correzione multimatrice.

Paint >Maintenance
Consente di specificare le impostazioni relative alla manutenzione.

Voce Impostazione della voce secondaria Descrizione

Test Saw On / Off Attiva o disattiva il segnale di prova.

Menu Audio

Fare riferimento a “Diagrammi a blocchi” (pagina 101).
Audio >Audio Input

Consente di specificare le impostazioni relative all’ingresso audio.

Voce Impostazione della voce secondaria Descrizione

CH1 Input 
Select

INPUT1 / Internal MIC / Shoe 1 Seleziona la sorgente di ingresso per la 
registrazione sul canale 1.

CH2 Input 
Select

INPUT1 / INPUT2 / Internal MIC / Shoe 2 Seleziona la sorgente di ingresso per la 
registrazione sul canale 2.

CH3 Input 
Select

Off / Internal MIC / Shoe 1 Seleziona la sorgente di ingresso per la 
registrazione sul canale 3.

CH4 Input 
Select

Off / Internal MIC / Shoe 2 Seleziona la sorgente di ingresso per la 
registrazione sul canale 4.

INPUT1 MIC 
Reference

–60dB / –50dB / –40dB Imposta il livello di riferimento di 
registrazione dell’ingresso microfono XLR su 
INPUT1.

Audio >Audio Input
Consente di specificare le impostazioni relative all’ingresso audio.

Voce Impostazione della voce secondaria Descrizione

INPUT2 MIC 
Reference

–60dB / –50dB / –40dB Imposta il livello di riferimento di 
registrazione dell’ingresso microfono XLR su 
INPUT2.

CH1 Wind 
Filter

On / Off Abilita o disabilita il filtro di riduzione del 
rumore del vento per la registrazione del 
canale 1.

CH2 Wind 
Filter

On / Off Abilita o disabilita il filtro di riduzione del 
rumore del vento per la registrazione del 
canale 2.

CH3 Wind 
Filter

On / Off Abilita o disabilita il filtro di riduzione del 
rumore del vento per la registrazione del 
canale 3.

CH4 Wind 
Filter

On / Off Abilita o disabilita il filtro di riduzione del 
rumore del vento per la registrazione del 
canale 4.

CH3 Level 
Control

Auto / Manual Seleziona la regolazione del livello di 
ingresso audio automatica o manuale per la 
registrazione sul canale 3.

[Nota]
Se CH3 Input Select e CH4 Input Select sono 
entrambi impostati su Internal MIC, CH4 viene 
impostato su automatico o manuale in accordo 
con questa impostazione.

CH4 Level 
Control

Auto / Manual Seleziona la regolazione del livello di 
ingresso audio automatica o manuale per la 
registrazione sul canale 4.

[Nota]
Se CH3 Input Select e CH4 Input Select sono 
entrambi impostati su Internal MIC, CH4 viene 
impostato su automatico o manuale in accordo 
l’impostazione di CH3 Level Control.

CH3 Input 
Level

Da 0 a 99 (49) Imposta il livello di ingresso audio per la 
registrazione del canale 3.

[Nota]
Se CH3 Input Select e CH4 Input Select sono 
entrambi impostati su Internal MIC, l’opzione CH4 
Input Level viene impostata in accordo con questa 
impostazione.
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Audio >Audio Input
Consente di specificare le impostazioni relative all’ingresso audio.

Voce Impostazione della voce secondaria Descrizione

CH4 Input 
Level

Da 0 a 99 (49) Imposta il livello di ingresso audio per la 
registrazione del canale 4.

[Nota]
Se CH3 Input Select e CH4 Input Select sono 
entrambi impostati su Internal MIC, l’opzione 
CH4 Input Level viene impostata in accordo con 
l’impostazione di CH3 Input Level.

Audio Input 
Level

Da 0 a 99 Imposta il livello di ingresso audio.
Utilizzabile come volume master secondo le 
impostazioni delle opzioni CH Level da 1 a 4.

Limiter Mode Off / –6dB / –9dB / –12dB / –15dB / –17dB Seleziona la caratteristica di limitazione per i 
segnali di ingresso di livello elevato quando il 
livello di ingresso audio viene regolato 
manualmente.

CH1&2 AGC 
Mode

Mono / Stereo Imposta la modalità di regolazione livello 
automatica per la registrazione sui canali 1 e 
2.

CH3&4 AGC 
Mode

Mono / Stereo Imposta la modalità di regolazione livello 
automatica per la registrazione sui canali 3 e 
4.

AGC Spec –6dB / –9dB / –12dB / –15dB / –17dB Seleziona la caratteristica AGC.

1kHz Tone on 
Color Bars

On / Off Attiva o disattiva l’emissione del segnale di 
tono di riferimento a 1 kHz durante la 
visualizzazione delle barre colore.

[Nota]
Se impostato su On, viene impostato il segnale di 
tono di riferimento a 1 kHz per la registrazione sui 
canali 3 e 4, anche se CH3 Input Select e CH4 Input 
Select sono impostati su Off.

CH1 Level Ingresso senza adattatore XLR
Audio Input Level / Side / Level+Side

Ingresso con adattatore XLR (pagina 43)
Audio Input Level / Through

Imposta la combinazione delle regolazioni 
del livello di ingresso audio abilitate per la 
registrazione del canale 1.

[Nota]
“Side” indica la manopola CH1 INPUT LEVEL sul 
lato del camcorder. Se è selezionato Level+Side, il 
livello di registrazione audio è determinato dalla 
combinazione di Audio Input Level e la posizione 
della manopola (pagina 101).

Audio >Audio Input
Consente di specificare le impostazioni relative all’ingresso audio.

Voce Impostazione della voce secondaria Descrizione

CH2 Level Ingresso senza adattatore XLR
Audio Input Level / Side / Level+Side

Ingresso con adattatore XLR (pagina 43)
Audio Input Level / Through

Imposta la combinazione delle regolazioni 
del livello di ingresso audio abilitate per la 
registrazione del canale 2.

[Nota]
“Side” indica la manopola CH2 INPUT LEVEL sul 
lato del camcorder. Se è selezionato Level+Side, il 
livello di registrazione audio è determinato dalla 
combinazione di Audio Input Level e la posizione 
della manopola (pagina 101).

CH3 Level Ingresso senza adattatore XLR
Audio Input Level / CH3 Input Level / 
Level+CH3 Input Level

Ingresso con adattatore XLR (pagina 43)
Audio Input Level / Through

Imposta la combinazione delle regolazioni 
del livello di ingresso audio abilitate per la 
registrazione del canale 3.

[Nota]
Se è selezionato Level+CH3 Input Level, il livello 
di registrazione audio è determinato dalla 
combinazione di Audio Input Level e CH3 Input 
Level (pagina 101).

CH4 Level Ingresso senza adattatore XLR
Audio Input Level / CH4 Input Level / 
Level+CH4 Input Level

Ingresso con adattatore XLR (pagina 43)
Audio Input Level / Through

Imposta la combinazione delle regolazioni 
del livello di ingresso audio abilitate per la 
registrazione del canale 4.

[Nota]
Se è selezionato Level+CH4 Input Level, il livello 
di registrazione audio è determinato dalla 
combinazione di Audio Input Level e CH4 Input 
Level (pagina 101).

Audio >Audio Output
Consente di specificare le impostazioni relative all’uscita audio.

Voce Impostazione della voce secondaria Descrizione

Monitor CH CH1/CH2 / CH3/CH4 / MIX ALL / CH1 / CH2 / 
CH3 / CH4

Seleziona l’uscita del canale audio sul jack 
cuffie e l’altoparlante incorporato.

[Nota]
Se l’audio è impostato per l’uscita simultanea su 
più di un canale, il livello di uscita di ciascun canale 
viene ridotto per evitare il clipping.

Monitor 
Volume

Da 0 a 15 (7) Regola il livello di uscita dell’audio di 
monitoraggio sul jack cuffie e l’altoparlante 
incorporato.

Headphone 
Out

Mono / Stereo Specifica se l’uscita del jack cuffie deve 
essere mono o stereo.

Alarm Volume Da 0 a 7 (4) Regola il volume dell’allarme.
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Audio >Audio Output
Consente di specificare le impostazioni relative all’uscita audio.

Voce Impostazione della voce secondaria Descrizione

Output Limiter On / Off Attiva o disattiva il limitatore di uscita audio.

HDMI Output 
CH

CH1/CH2 / CH3/CH4 Imposta la combinazione dei canali audio 
sull’uscita HDMI.

Menu Video

Video >Output On/Off
Consente di specificare le impostazioni relative all’uscita video.

Voce Impostazione della voce secondaria Descrizione

SDI On / Off Attiva o disattiva l’uscita SDI.

HDMI On / Off Attiva o disattiva l’uscita HDMI.

Video >Output Format
Consente di specificare le impostazioni relative al formato di uscita.

Voce Impostazione della voce secondaria Descrizione

SDI Per informazioni dettagliate su queste 
impostazioni, vedere “Formati di uscita e 
limitazioni” (pagina 87).

Imposta la risoluzione delle uscite SDI e HDMI.

[Nota]
L’impostazione Output Format potrebbe non essere 
configurabile nella modalità Picture Cache Rec. In tal 
caso, impostare provvisoriamente Picture Cache Rec 
su Off e modificare le impostazioni desiderate.

HDMI

REF

Video >Output Setting
Consente di specificare le impostazioni relative alle modalità di conversione in uscita.

Voce Impostazione della voce secondaria Descrizione

HDMI Target 
Device

Recorder / Monitor Imposta il tipo di dispositivo di ingresso 
HDMI connesso all’uscita HDMI.
Recorder:  

In modalità Cine EI, emette in uscita su 
HDMI lo stesso video di SDI1.

Monitor:  
In modalità Cine EI, emette in uscita su 
HDMI lo stesso video di SDI2.

Video >Output Setting
Consente di specificare le impostazioni relative alle modalità di conversione in uscita.

Voce Impostazione della voce secondaria Descrizione

Output Color 
Space

Se Matrix >Preset Select nel menu Paint è 
impostato su BT.2020 e Output Format nel 
menu Video è impostato su 2K o valore 
inferiore:

SDI2 BT.709 / SDI2 BT.2020 / All BT.709
Non è configurabile con impostazioni diverse 
da quelle sopra indicate. Visualizza lo spazio 
colore di uscita.

Imposta lo spazio colore di uscita.

[Informazione]
Per informazioni dettagliate sulla gamma di colore 
di ciascuna uscita video quando è selezionato 
BT.2020, fare riferimento a “Impostazioni del menu 
Output e spazio colore dell’uscita video quando 
Preset Select è BT.2020” (pagina 92).

[Nota]
Quando S&Q Motion è impostato su On, questa 
opzione viene temporaneamente impostata su All 
BT.709.

4K/2K to HD 
Conv.

Edge Crop / Letter Box Imposta la modalità di conversione per 
l’uscita video HD di video 17:9.

Video >Monitor LUT
Consente di specificare le impostazioni relative alla LUT monitor. Disponibile solo per riprese in Cine EI 
mode.

Voce Impostazione della voce secondaria Descrizione

Category LUT / Look Profile / User 3D LUT Imposta il tipo di Look applicato come 
Monitor LUT.
LUT:  

Emette in uscita video a cui è applicato il 
LUT preimpostato oppure il LUT utente.

Look Profile:  
Selezionando un numero di Look, 
consente di emettere in uscita video 
simile alla pellicola cinematografica 
oppure video adatto come punto di 
partenza del grading del colore.

User 3D LUT:  
Emette in uscita video con applicato il 
3D LUT utente.

[Note]
ˎˎ Può non essere possibile impostare una LUT 

monitor indipendente per ciascun sistema 
(pagina 91).
ˎˎ User 3D LUT non può essere selezionato se 

Base Setting >Color Space nel menu System è 
impostato su S-Gamut/S-Log2 .
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Video >Monitor LUT
Consente di specificare le impostazioni relative alla LUT monitor. Disponibile solo per riprese in Cine EI 
mode.

Voce Impostazione della voce secondaria Descrizione

LUT Select P1: 709 (800%)
P2: HG8009G40
P3: HG8009G33
P4: S-Log2
P5: S-Log3
U1
U2
U3
U4
U5
U6

Seleziona il tipo di LUT, quando Monitor LUT 
>Category è impostato su LUT.
709(800%):  

Segnale con curva di base ITU-R709 con 
gamma dinamica estesa fino a 800%.

HG8009G40:  
Segnale con HyperGamma con gamma 
dinamica 800%, limite del bianco 109% e 
uscita video scheda grigio 18% al 40%.

HG8009G33:  
Segnale con HyperGamma con gamma 
dinamica 800%, limite del bianco 109% e 
uscita video scheda grigio 18% al 33%.

S-Log2:  
Segnale di log con gamma dinamica del 
1300% che tiene conto della visibilità su 
un monitor video, con sviluppo delle 
riprese in sede di post produzione.  
(Abilitato quando Base Setting >Color 
Space nel menu System è impostato su 
S-Gamut/SLog2).

S-Log3:  
Segnale di log con gamma dinamica del 
1300% che imita le caratteristiche della 
pellicola, simile alla curva Cineon Log.  
(Abilitato quando Base Setting >Color 
Space nel menu System è impostato su 
S-Gamut3.Cine/SLog3 o S-Gamut3/
SLog3).

Da U1 a U6:  
Segnali LUT utente importati da una 
scheda SD.

[Nota]
Selezionare F55/F5 come formato di uscita quando 
si crea una LUT usando RAW Viewer.
Creare e memorizzare i file LUT nella seguente 
cartella di una scheda SD: 
\PRIVATE\SONY\PRO\CAMERA\PMWF55_F5

Video >Monitor LUT
Consente di specificare le impostazioni relative alla LUT monitor. Disponibile solo per riprese in Cine EI 
mode.

Voce Impostazione della voce secondaria Descrizione

Look Profile 
Select

1: LC-709
2: LC-709typeA
3: SLog2-709
4: Cine+709

Seleziona il tipo di profilo Look quando 
Monitor LUT >Category è impostato su Look 
Profile.

User 3D LUT 
Select

User 3D-1
User 3D-2
User 3D-3
User 3D-4

Seleziona il tipo di 3D LUT utente.

SDI1 & Internal 
Rec

MLUT On / MLUT Off Seleziona se applicare la LUT monitor 
all’uscita video SDI OUT1 e ai video registrati 
su schede di memoria XQD.

SDI2 MLUT On / MLUT Off Seleziona se applicare la LUT monitor 
all’uscita video SDI OUT2.

HDMI MLUT On / MLUT Off Indica se la LUT monitor è applicata all’uscita 
video HDMI.

[Informazione]
Questa impostazione segue quella di HDMI Target 
Device (pagina 91).

Mirino MLUT On / MLUT Off Seleziona se applicare la LUT monitor 
all’uscita video sul mirino.

Video >Output Display
Consente di specificare le impostazioni relative al segnale di uscita.

Voce Impostazione della voce secondaria Descrizione

SDI2 On / Off Seleziona se sovraimporre menu e stato sui 
segnali di uscita SDI e HDMI.HDMI On / Off

Menu VF

VF >VF Setting
Consente di specificare le impostazioni relative al mirino.

Voce Impostazione della voce secondaria Descrizione

Brightness Da –99 a +99 (±0) Regola la luminosità dell’immagine del 
mirino.
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VF >VF Setting
Consente di specificare le impostazioni relative al mirino.

Voce Impostazione della voce secondaria Descrizione

Color Mode Color / B&W Seleziona la modalità di visualizzazione del 
mirino in modalità di registrazione o E-E.

VF >Peaking
Consente di specificare le impostazioni relative al peaking.

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la funzione Peaking.

Peaking Type Normal / Color Seleziona il tipo di peaking.
Normal: peaking normale
Color: peaking in colore

Frequency Normal / High Seleziona la frequenza di peaking.

Normal 
Peaking Level

Da 0 a 99 (50) Imposta il livello di peaking normale.

Color B&W / Red / Yellow / Blue Seleziona il colore del segnale di peaking 
colore.

Color Peaking 
Level

Da 0 a 99 (50) Imposta il livello del peaking colore.

VF >Zebra
Consente di specificare le impostazioni del motivo zebra.

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la funzione Zebra.

Zebra Select 1 / 2 / Both Seleziona il tipo di motivo zebra (Zebra1, 
Zebra2, Both).

Zebra1 Level Da 0% a 107% (70%) Imposta il livello di visualizzazione del motivo 
Zebra1.

Zebra1 
Aperture Level

Da 1% a 20% (10%) Imposta il livello di apertura del motivo 
Zebra1.

Zebra2 Level Da 0% a 109% (100%) Imposta il livello di visualizzazione del motivo 
Zebra2.

VF >Marker
Consente di specificare le impostazioni relative alla visualizzazione degli indicatori.

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la visualizzazione di tutti gli 
indicatori.

Color White / Yellow / Cyan / Green / Magenta / Red 
/ Blue

Seleziona il colore del segnale dell’indicatore.

VF >Marker
Consente di specificare le impostazioni relative alla visualizzazione degli indicatori.

Voce Impostazione della voce secondaria Descrizione

Center Maker 1 / 2 / 3 / 4 / Off Attiva o disattiva la visualizzazione 
dell’indicatore centrale.

Safety Zone On / Off Attiva o disattiva la visualizzazione 
dell’indicatore della zona di sicurezza.

Safety Area 80% / 90% / 92.5% / 95% Seleziona le dimensioni dell’indicatore della 
zona di sicurezza (come percentuale delle 
dimensioni totali dello schermo).

Aspect Marker Line / Mask / Off Seleziona il tipo di indicatore di aspetto.

Aspect Mask Da 0 a 15 (12) Imposta il livello del segnale video all’esterno 
dell’indicatore.

Aspect Safety 
Zone

On / Off Attiva o disattiva la visualizzazione della zona 
di sicurezza di aspetto.

Aspect Safety 
Area

80% / 90% / 92.5% / 95% Seleziona le dimensioni dell’indicatore della 
zona di sicurezza di aspetto come 
percentuale delle dimensioni totali dello 
schermo.

Aspect Select 4:3 / 1.66:1 / 1.85:1 / 2.35:1 / 2.4:1 Imposta la modalità di visualizzazione 
dell’indicatore di aspetto.

User Box On / Off Attiva o disattiva la visualizzazione del 
cursore a riquadro.

User Box 
Width

Da 3 a 479 (240) Specifica la larghezza del cursore a riquadro 
(distanza dal centro ai bordi destro e sinistro).

User Box 
Height

Da 3 a 269 (135) Specifica l’altezza del cursore a riquadro 
(distanza dal centro al bordo superiore e 
inferiore).

User Box H 
Position

Da –476 a +476 (0) Imposta la posizione orizzontale del centro 
del cursore a riquadro.

User Box V 
Position

Da –266 a +266 (0) Specifica la posizione verticale del centro del 
cursore a riquadro.

100% Marker On / Off Attiva o disattiva la visualizzazione 
dell’indicatore 100%.

Guide Frame On / Off Attiva o disattiva la visualizzazione del 
riquadro di guida.
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VF >Display On/Off
Consente di specificare le impostazioni di visualizzazione delle indicazioni.

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Seleziona gli elementi da visualizzare nel 
mirino.Shutter Setting On / Off

ND Filter Value On / Off

Gain Setting On / Off

Rec/Play 
Status

On / Off

HXR-IFR5 Rec 
Control

On / Off

Color Temp. On / Off

Frame Rate / 
Interval

On / Off

Battery 
Remain

On / Off

Timecode On / Off

Audio Manual On / Off

Audio Level 
Meter

On / Off

Media Status On / Off

VF >Display On/Off
Consente di specificare le impostazioni di visualizzazione delle indicazioni.

Voce Impostazione della voce secondaria Descrizione

Focus Position Meter / Feet / Off Seleziona gli elementi da visualizzare nel 
mirino.Iris Position On / Off

Zoom Position Number / Bar / Off

SteadyShot On / Off

Focus Mode On / Off

Focus Area 
Indicator

On / Off

Focus Area 
Ind. (Push AF)

On / Off

Focus 
Indicator

On / Off

Auto Shutter On / Off

AGC On / Off

Auto ND Filter On / Off

Auto Iris On / Off

AE Mode On / Off

Auto Exposure 
Level

On / Off

White Balance 
Mode

On / Off

SDI/HDMI Rec 
Control

On / Off

Rec Format On / Off

Gamma On / Off

Timecode 
Lock

On / Off

Wi-Fi 
Condition

On / Off

Clip Name On / Off

Focus Assist 
Indicator

On / Off

Focus Area 
Marker

On / Off

Video Level 
Warning

On / Off

Clip Number On / Off



000 5. Menu visualizzati e impostazioni: Elenco delle voci del menu di configurazione69

VF >Display On/Off
Consente di specificare le impostazioni di visualizzazione delle indicazioni.

Voce Impostazione della voce secondaria Descrizione

GPS On / Off Seleziona gli elementi da visualizzare nel 
mirino.

Level Gauge On / Off

Lens Info Meter / Feet / Off

Notice 
Message

On / Off

VF >Video Signal Monitor
Consente di configurare le impostazioni del monitor del segnale video (pagina 41)

Voce Impostazione della voce secondaria Descrizione

Setting Off / Waveform / Vector / Histogram Imposta il tipo di monitor del segnale video.

[Informazione]
Non visualizzato se Display On/Off >Setting è 
impostato su Off.

Source In modalità Custom mode, se Preset Select è 
impostato su BT.2020, la risoluzione di uscita 
video è 2K o inferiore e Color Output Space è 
impostato su SDI2 BT.709:
oppure
In modalità Cine EI con risoluzione di uscita 
video di 2K o inferiore:

SDI1 & Internal Rec / SDI2

Imposta l’obiettivo di misura del monitor del 
segnale video.
Visualizza l’obiettivo di misura se non 
configurabile.

TC/UB Menu

TC/UB >Timecode
Consente di specificare le impostazioni relative al codice temporale.

Voce Impostazione della voce secondaria Descrizione

Mode Preset / Regen / Clock Imposta la modalità di avanzamento del 
codice temporale.
Preset:  

Si avvia da un valore preimpostato.
Regen:  

Prosegue dal codice temporale della fine 
del clip precedente.

Clock:  
Utilizza l’orologio interno come codice 
temporale.

Run Rec Run / Free Run Rec Run: Avanza solo durante la 
registrazione.

Free Run: Avanzamento costante, 
indipendentemente dall’accensione del 
camcorder.

Setting Imposta il codice temporale su un valore 
arbitrario.
SET: Imposta il valore.

Reset Execute / Cancel Azzera il codice temporale (00:00:00:00)
Execute: Azzera il codice temporale.

TC Format DF / NDF Imposta il formato del codice temporale.
DF: Drop Frame
NDF: Non-Drop Frame

TC/UB >TC Display
Consente di specificare le impostazioni di visualizzazione dei dati temporali.

Voce Impostazione della voce secondaria Descrizione

Display Select Timecode / Users Bit / Duration Consente di scegliere quali dati temporali 
devono essere visualizzati.

TC/UB >Users Bit
Consente di specificare le impostazioni relative ai bit utente.

Voce Impostazione della voce secondaria Descrizione

Mode Fix / Time Imposta la modalità del bit utente.
Fix: Utilizza per i bit utente un valore fisso 

arbitrario.
Time: Utilizza l’ora corrente nei bit utente.
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TC/UB >Users Bit
Consente di specificare le impostazioni relative ai bit utente.

Voce Impostazione della voce secondaria Descrizione

Setting Imposta i bit utente su un valore arbitrario.

TC/UB >HDMI TC Out
Consente di specificare le impostazioni relative all’uscita del codice temporale quando si utilizza HDMI.

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Consente di selezionare se emettere il codice 
temporale ad altri dispositivi per altri scopi, 
tramite HDMI.

Menu Recording

Recording >S&Q Motion
Consente di specificare le impostazioni relative alla modalità Slow & Quick Motion (pagina 38).

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la modalità Slow & Quick 
Motion.
Quando è impostato su On, le seguenti 
funzioni sono disabilitate:

ˎˎ Auto Iris
ˎˎ Auto Focus 

High Frame 
Rate Mode

Off / Full Scan / Center Scan Consente di utilizzare una velocità di 
imaging superiore a 60P.
Off:  

Non consente di utilizzare una velocità di 
imaging superiore a 60P.

Full Scan:  
Abilita l’imaging ad alta velocità con 
dimensione di fotogramma Super 
35mm.

Center Scan:  
Imaging ad alta velocità di metà 
dell’angolo di visuale del formato Super 
35 mm al centro dell’immagine.

[Nota]
Non è possibile adeguare questa impostazione 
a Imager Scan Mode se Imager Scan Mode è 
impostata su 2K Full o 2K Center.

Recording >S&Q Motion
Consente di specificare le impostazioni relative alla modalità Slow & Quick Motion (pagina 38).

Voce Impostazione della voce secondaria Descrizione

Frame Rate Fino a 240fps Imposta la frequenza fotogrammi per le 
riprese in modalità Slow & Quick Motion.

[Nota]
Il valore iniziale varia a seconda delle impostazioni 
di Codec, Country, Video Format e RAW Output 
Format.

Recording >Interval Rec
Consente di specificare le impostazioni relative alla funzione Interval Rec (pagina 39).

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la modalità di registrazione 
a intervalli (Attivando questa modalità, si 
disattivano tutte le altre modalità speciali).

Interval Time 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 20 / 30 / 
40 / 50 (sec) 
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 20 / 30 / 
40 / 50 / (min) 
1 / 2 / 3 / 4 / 6 / 12 / 24 (ore)

Imposta l’intervallo fra registrazioni nella 
modalità di registrazione Interval Rec 
(Interval Rec impostata su On).

Number of 
Frames

1frame / 2frames / 3frames / 6frames / 9frames 
/ 12frames
I valori disponibili variano a seconda della 
frequenza fotogrammi del formato video 
selezionato.
50P/59.94P:

2frames / 6frames / 12frames
23.98P/25P/29.97P/50i/59.94i:

1frame / 3frames / 6frames / 9frames

Imposta il numero di fotogrammi per 
ciascuna ripresa nella modalità di 
registrazione Interval Rec (Interval Rec 
impostata su On).

Pre-Lighting Off / 2sec / 5sec / 10sec Specifica con che anticipo in secondi si deve 
accendere la luce video prima dell’avvio della 
registrazione in modalità Interval Rec.

[Informazione]
Disponibile solo se viene utilizzata la luce video 
HVL-LBPC (opzionale).

Recording >Picture Cache Rec
Consente di specificare le impostazioni relative alla modalità Picture Cache Rec (pagina 39).

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la funzione di registrazione 
cache immagine.
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Recording >Picture Cache Rec
Consente di specificare le impostazioni relative alla modalità Picture Cache Rec (pagina 39).

Voce Impostazione della voce secondaria Descrizione

Cache Rec 
Time

0-2sec / 2-4sec / 4-6sec / 6-8sec / 8-10sec / 
10-12sec / 12-14sec / 13-15sec

Imposta il tempo di registrazione cache 
immagine quando Picture Cache Rec è 
impostato su On.

Recording >Simul Rec
Consente di specificare le impostazioni relative alla modalità Simul Rec (pagina 31).

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la funzione di registrazione 
simultanea e specifica il supporto di 
destinazione della registrazione.

Rec Button Set “Rec Button [SlotA SlotB] Handle Rec Button 
[SlotA SlotB]” / “Rec Button [SlotA] Handle Rec 
Button [SlotB]” / “Rec Button [SlotB] Handle Rec 
Button [SlotA]”

Seleziona i pulsanti utilizzati per controllare la 
registrazione sui vari supporti di 
registrazione.

Recording >SDI/HDMI Rec Control
Consente di specificare le impostazioni relative alla registrazione SDI/HDMI.

Voce Impostazione della voce secondaria Descrizione

Setting Off / SDI/HDMI Remote I/F / Parallel Rec Imposta il metodo di avvio e arresto della 
registrazione su un dispositivo esterno 
tramite i segnali di uscita SDI/HDMI 
(pagina 43).
Quando sono assegnati pulsanti diversi con 
Rec Button Set, il segnale di controllo 
registrazione segue lo stato di registrazione 
dello slot A.

[Informazione]
Se impostato su SDI/HDMI Remote I/F, arresta o 
avvia la registrazione su un dispositivo esterno 
collegato anche se non è inserita nessuna scheda 
XQD.

Menu Thumbnail

Thumbnail

Voce Impostazione della voce secondaria Descrizione

Display Clip 
Properties

Visualizza la schermata delle proprietà dei 
clip.

Set Index 
Picture

Specifica l’immagine indice del clip.

Thumbnail >Thumbnail View
Consente di specificare le impostazioni del formato di visualizzazione delle miniature.

Voce Impostazione della voce secondaria Descrizione

Essence Mark 
Thumbnail

All / Rec Start / Shot Mark1 / Shot Mark2 / Shot 
Mark3 / Shot Mark4 / Shot Mark5 / Shot Mark6 
/ Shot Mark7 / Shot Mark8 / Shot Mark9 / Shot 
Mark0

Visualizza le miniature di tutti i fotogrammi 
contenenti essence mark (indicatori di 
identificazione).

Clip Thumbnail Visualizza miniature dei clip registrati.

Thumbnail >Set Shot Mark
Consente di specificare le impostazioni relative agli Shot Mark.

Voce Impostazione della voce secondaria Descrizione

Add Shot 
Mark1

Aggiunge lo Shot Mark1

Delete Shot 
Mark1

Elimina lo Shot Mark1

Add Shot 
Mark2

Aggiunge lo Shot Mark2

Delete Shot 
Mark2

Elimina lo Shot Mark2

Thumbnail >Set Clip Flag
Consente di specificare le impostazioni relative ai flag dei clip.

Voce Impostazione della voce secondaria Descrizione

Add OK Aggiunge un flag OK.

Add NG Aggiunge un flag NG.

Add KEEP Aggiunge un flag Keep.

Delete Clip 
Flag

Elimina tutti i flag.
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Thumbnail >Lock/Unlock Clip
Consente di specificare le impostazioni relative alla protezione dei clip.

Voce Impostazione della voce secondaria Descrizione

Select Clip Seleziona e blocca/sblocca un clip.

Lock All Clips Blocca tutti i clip.

Unlock All 
Clips

Sblocca tutti i clip.

Thumbnail >Delete Clip
Elimina clip.

Voce Impostazione della voce secondaria Descrizione

Select Clip Elimina il clip selezionato.

All Clips Elimina tutti i clip visualizzati.

Thumbnail >Filter Clips
Consente di specificare le impostazioni relative ai clip da visualizzare.

Voce Impostazione della voce secondaria Descrizione

OK Visualizza solo i clip che contengono un flag 
OK.

NG Visualizza solo i clip che contengono un flag 
NG.

KEEP Visualizza solo i clip che contengono un flag 
Keep.

None Visualizza solo i clip che non contengono 
nessun flag.

Thumbnail >Customize View
Consente di scegliere la visualizzazione delle miniature.

Voce Impostazione della voce secondaria Descrizione

Thumbnail 
Caption

Date Time / Time Code / Duration / Sequential 
Number

Seleziona le informazioni visualizzate sotto le 
miniature.

Menu Media

Media >Update Media
Aggiorna il file di gestione delle schede di memoria.

Voce Impostazione della voce secondaria Descrizione

Media (A) Execute / Cancel Aggiorna il file di gestione della scheda di 
memoria XQD nello slot A.
Execute: Aggiorna la scheda

Media (B) Execute / Cancel Aggiorna il file di gestione della scheda di 
memoria XQD nello slot B.
Execute: Aggiorna la scheda

Media >Format Media
Inizializza le schede di memoria.

Voce Impostazione della voce secondaria Descrizione

Media (A) Execute / Cancel Inizializza la scheda di memoria XQD nello 
slot A.
Execute: Inizializza la scheda

Media (B) Execute / Cancel Inizializza la scheda di memoria XQD nello 
slot B.
Execute: Inizializza la scheda

SD Card Execute / Cancel Inizializza la scheda SD UTILITY.
Execute: Inizializza la scheda

Media >Clip
Consente di specificare le impostazioni relative ai nomi dei clip.

Voce Impostazione della voce secondaria Descrizione

Auto Naming Cam ID + Reel# / Title Imposta il metodo per l’assegnazione di 
nomi ai clip.
Cam ID + Reel#:  

Identificativo videocamera + numero 
bobina + numero ripresa + data + 
stringa casuale

Title:  
Stringa impostata tramite Title Prefix + 
numero del clip

[Nota]
Quando Simul Rec è impostato su On, Cam ID + 
Reel# non può essere configurato.

Camera ID Da A a Z Imposta l’identificativo della videocamera 
quando Auto Naming è impostato su Cam ID 
+ Reel#.
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Media >Clip
Consente di specificare le impostazioni relative ai nomi dei clip.

Voce Impostazione della voce secondaria Descrizione

Reel Number Da 001 a 999 Imposta la porzione numerica del numero 
della bobina quando Auto Naming è 
impostato su Cam ID + Reel#.

Camera 
Position

C / L / R Imposta il prefisso del numero della ripresa 
quando Auto Naming è impostato su Cam ID 
+ Reel#.

Title Prefix Il valore iniziale è un identificativo basato sul 
modello.
L’identificativo basato sul modello comprende 
le ultime tre cifre del numero di serie.

Imposta la porzione del titolo del nome del 
clip quando Auto Naming è impostato su 
Title.

[Informazione]
Il valore viene inserito utilizzando la schermata di 
inserimento caratteri (pagina 52).

Number Set Da 0001 a 9999 Imposta la porzione numerica del nome del 
clip quando Auto Naming è impostato su 
Title.

Menu File

File >All File
Consente di specificare le impostazioni relative ai file ALL.

Voce Impostazione della voce secondaria Descrizione

Load SD Card Execute / Cancel Carica un file ALL.
Execute: Carica il file

Save SD Card Execute / Cancel Salva un file ALL.
Execute: Salva il file

File ID Assegna un nome al file.

File >Scene File
Consente di specificare le impostazioni relative ai file di scena.

Voce Impostazione della voce secondaria Descrizione

Recall Internal 
Memory

Execute / Cancel Carica un file di scena dalla memoria interna.
Execute: Carica il file

Store Internal 
Memory

Execute / Cancel Salva un file di scena nella memoria interna.
Execute: Salva il file

File >Scene File
Consente di specificare le impostazioni relative ai file di scena.

Voce Impostazione della voce secondaria Descrizione

Load SD Card Execute / Cancel Carica un file di scena dalla scheda SD.
Execute: Carica il file

Save SD Card Execute / Cancel Salva un file di scena su una scheda SD.
Execute: Salva il file

File ID Assegna un nome al file.

Scene White 
Data

On / Off Seleziona se applicare o meno i dati di 
bilanciamento del bianco quando si caricano 
file di scena.

File >User Menu Item
Consente di specificare le impostazioni relative alle voci del menu User.

Voce Impostazione della voce secondaria Descrizione

Load SD Card Execute / Cancel Carica le impostazioni del menu utente da 
una scheda SD alla memoria interna.
Execute: Carica le impostazioni

Save SD Card Execute / Cancel Salva le impostazioni del menu utente su 
una scheda SD.
Execute: Salva le impostazioni

File ID Visualizza il File ID specificato per il file 
caricato mediante Load SD Card. Inoltre, 
imposta o modifica il File ID quando si salva 
un file mediante questo menu.

File >User Gamma
Consente di specificare le impostazioni relative ai file gamma utente.

Voce Impostazione della voce secondaria Descrizione

Current 
Settings

Visualizza un elenco delle impostazioni del 
file gamma utente correnti (nome dei file).

Load SD Card Execute / Cancel Carica le impostazioni di gamma utente da 
una scheda SD alla memoria interna.
Execute: Carica la gamma
Per utilizzare sul camcorder i file di camma 
creati con CvpFileEditor™ V4.2, salvare i file 
nella seguente cartella della scheda SD:
PRIVATE\SONY\PRO\CAMERA\HD_CAM

Reset 1 / 2 / 3 / 4 / 5 / All
Valore iniziale: 709(800%)

Ripristina i valori predefiniti dei file di gamma 
utente contenuti nella memoria interna.
Da 1 a 5: Ripristina la gamma utente 
specificata.
All: Ripristina tutte le gamme 
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File >Monitor LUT
Consente di specificare le impostazioni relative ai file di LUT monitor.

Voce Impostazione della voce secondaria Descrizione

Current 
Settings

Visualizza un elenco delle impostazioni del 
file LUT monitor correnti (nome dei file).

Load SD Card Execute / Cancel Carica le impostazioni di LUT monitor da una 
scheda SD alla memoria interna.
Execute: Carica le impostazioni di LUT
Salvare i file LUT utente generati con RAW 
Viewer nella seguente cartella della scheda 
SD:
PRIVATE\SONY\PRO\CAMERA\PMWF55_F5

Reset 1 / 2 / 3 / 4 / 5 / 6 / All Ripristina i valori predefiniti della LUT 
monitor contenuti nella memoria interna.
Da 1 a 6: Ripristina la LUT monitor specificata
All: Ripristina tutte le LUT monitor.

File >Monitor 3D LUT
Consente di specificare le impostazioni relative ai file LUT 3D monitor.

Voce Impostazione della voce secondaria Descrizione

Current 
Settings

Visualizza un elenco delle impostazioni del 
file LUT 3D monitor correnti (nome dei file).

Load SD Card Execute / Cancel Carica le impostazioni di LUT 3D monitor da 
una scheda SD alla memoria interna.
Execute: Carica le impostazioni di LUT 3D
È possibile importare file CUBE (*.cube) con 
risoluzione di reticolo 17 o 33 creati con 
Catalyst Browse, RAW Viewer, o BMD Da Vinci 
Resolve*.
* Verificato con Resolve V9.0, V10.0 e V11.0.
Se si crea un file CUBE con Catalyst Browse e 
RAW Viewer, impostare Source in Catalyst 
Browse e Input in RAW Viewer su S-Gamut3.
Cine/S-Log3.
Impostare Format su Resolve quando si 
esporta il file CUBE.
Salvare i dati 3D LUT creati (file User 3D LUT) 
nella seguente cartella della scheda SD.
PRIVATE\SONY\PRO\CAMERA\PMWF55_F5

[Nota]
La funzione Monitor 3D LUT non può essere 
selezionata se si imposta Base Setting >Color 
Space su S-Gamut/S-Log2 nel menu System del 
camcorder.

File >Monitor 3D LUT
Consente di specificare le impostazioni relative ai file LUT 3D monitor.

Voce Impostazione della voce secondaria Descrizione

Reset 1 / 2 / 3 / 4 / All Ripristina i valori predefiniti di LUT 3D 
monitor contenuti nella memoria interna.
Da 1 a 4: Ripristina la LUT 3D monitor 
specificata
All: Ripristina tutte le LUT 3D monitor

File >Lens File
Consente di specificare le impostazioni relative ai file obiettivo.

Voce Impostazione della voce secondaria Descrizione

White Offset R Da –99 a +99 (±0) Imposta il valore di correzione del 
bilanciamento del bianco del canale R 
dell’obiettivo nel file obiettivo.

White Offset B Da –99 a +99 (±0) Imposta il valore di correzione del 
bilanciamento del bianco del canale B 
dell’obiettivo nel file obiettivo.

[Nota]
Salvare i file nelle cartelle della scheda SD indicate di seguito.
File ALL, file Scene, User Menu Item:

\PRIVATE\Sony\PRO\CAMERA\PXW-FS7M2
File di gamma utente:

\PRIVATE\Sony\PRO\CAMERA\HD_CAM
File di LUT monitor, file di LUT monitor 3D:

\PRIVATE\Sony\PRO\CAMERA\PMWF55_F5

Menu System

System >Base Setting
Consente di specificare le impostazioni di base.

Voce Impostazione della voce secondaria Descrizione

Shooting 
Mode

Custom / Cine EI Imposta la modalità di ripresa.

[Nota]
Al passaggio dalla modalità Cine EI alla modalità 
Custom, le impostazioni della modalità Cine 
EI vengono ereditate per l’impostazione della 
gamma.

Color Space S-Gamut/SLog2 / 
S-Gamut3.Cine/SLog3 / S-Gamut3/SLog3 / 
Matrix

Imposta lo spazio colore.
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System >Base Setting
Consente di specificare le impostazioni di base.

Voce Impostazione della voce secondaria Descrizione

Imager Scan 
Mode

Normal / 2K Full / 2K Center Imposta la modalità di scansione del sensore 
immagini per la cattura delle informazioni 
(pagina 22).

Rec/Out EI 
Applied

On / Off Attiva o disattiva Rec/Out EI Applied.
Se impostato su On, viene applicato il valore 
di Exposure Index del menu Camera come 
sensibilità ISO nei sistemi per i quali Monitor 
LUT è impostato su MLUT Off nel menu 
Video.
Questa funzione, tuttavia, è disabilitata per il 
video RAW.

[Note]
ˎˎ Questa impostazione è abilitata in modalità 

Cine EI.
ˎˎ Quando impostato su On, il display di ripresa del 

camcorder mostra EI  come unità dell’indicatore 
di guadagno.

System >Codec
Consente di specificare le impostazioni relative ai codec.

Voce Impostazione della voce secondaria Descrizione

Select RAW / RAW & XAVC-I / RAW & XAVC-L / RAW & 
MPEG HD 422 / XAVC-I / XAVC-L / MPEG HD 
422 / ProRes 422 HQ / ProRes 422

Imposta la modalità di registrazione/
riproduzione.

[Note]
ˎˎ Le opzioni RAW / RAW & XAVC-I / RAW & XAVC-L 

/ RAW & MPEG HD 422 sono disponibili quando 
è collegata un’unità di estensione XDCA-FS7 e 
Base Setting >Shooting Mode è impostato su 
Cine EI. 
ˎˎ Le opzioni ProRes 422 HQ / ProRes 422 sono 

disponibili solo quando è collegata un’unità di 
estensione XDCA-FS7.
ˎˎ Dopo aver cambiato codec, controllare sempre 

l’impostazione Video Format.

System >Rec Format
Consente di specificare le impostazioni relative al formato di registrazione.

Voce Impostazione della voce secondaria Descrizione

Video Format

ˎˎ Per sistemi NTSC:
Quando Codec >Select è impostato su XAVC-I: 

4096×2160 59.94P
4096×2160 29.97P
4096×2160 24.00P
4096×2160 23.98P
3840×2160 59.94P
3840×2160 29.97P
3840×2160 23.98P
1920×1080 59.94P
1920×1080 59.94i
1920×1080 29.97P
1920×1080 23.98P

Quando Codec >Select è impostato su XAVC-L:
3840×2160 59.94P
3840×2160 29.97P
3840×2160 23.98P
1920×1080 59.94P 50
1920×1080 59.94P 35
1920×1080 59.94i 50
1920×1080 59.94i 35
1920×1080 59.94i 25
1920×1080 29.97P 50
1920×1080 29.97P 35
1920×1080 23.98P 50
1920×1080 23.98P 35

Quando Codec >Select è impostato su MPEG 
HD422:

1920×1080 59.94i 50
1920×1080 29.97P 50
1920×1080 23.98P 50
1280×720 59.94P 50
1280×720 29.97P 50
1280×720 23.98P 50

Quando Codec >Select è impostato su ProRes 
422 HQ o ProRes 422:

1920×1080 59.94i
1920×1080 29.97P
1920×1080 23.98P

Imposta il formato di registrazione.

ˎˎ Per sistemi PAL:
Quando Codec >Select è impostato su XAVC-I:

4096×2160 50P
4096×2160 25P
3840×2160 50P
3840×2160 25P
1920×1080 50P
1920×1080 50i
1920×1080 25P

Quando Codec >Select è impostato su XAVC-L:
3840×2160 50P
3840×2160 25P
1920×1080 50P 50
1920×1080 50P 35
1920×1080 50i 50
1920×1080 50i 35
1920×1080 50i 25
1920×1080 50P 25
1920×1080 25P 35

Quando Codec >Select è impostato su MPEG 
HD422:

1920×1080 50i 50
1920×1080 25P 50
1280×720 50P 50
1280×720 50P 25

Quando Codec >Select è impostato su 
ProRes 422 HQ o ProRes 422:

1920×1080 50i
1920×1080 25P

[Note]
ˎˎ “---” non è disponibile (grigio) quando Codec 

>Select è impostato su RAW.
ˎˎ I valori fissi non sono disponibili (grigi) quando 

Codec >Select è impostato su RAW & XAVC-I, RAW 
& XAVC-L o RAW & MPEG HD 422.
ˎˎ Il formato di registrazione non può essere 

impostato su 4096×2160 o 3840×2160 quando 
Imager Scan Mode è impostata su 2K Full o 2K 
Center.
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System >Rec Format
Consente di specificare le impostazioni relative al formato di registrazione.

Voce Impostazione della voce secondaria Descrizione

RAW Output 
Format

 

ˎˎ Per sistemi NTSC:
Quando Codec >Select è impostato su 
un’opzione che include RAW e Imager Scan 
Mode è impostata su Normal:

4096×2160 59.94P
4096×2160 29.97P
4096×2160 23.98P

Quando Codec >Select è impostato su 
un’opzione che include RAW e Imager Scan 
Mode è impostata su 2K Full o 2K Center: 

2048×1080 59.94P
2048×1080 29.97P
2048×1080 23.98P

Imposta il formato di registrazione per un 
registratore RAW esterno.

ˎˎ 	Per sistemi PAL:
Quando Codec >Select è impostato su 
un’opzione che include RAW e Imager Scan 
Mode è impostata su Normal:

4096×2160 50P
4096×2160 25P

Quando Codec >Select è impostato su 
un’opzione che include RAW e Imager Scan 
Mode è impostata su 2K Full o 2K Center:

2048×1080 50P
2048×1080 25P

System >Genlock
Consente di specificare le impostazioni relative al genlock.

Voce Impostazione della voce secondaria Descrizione

Reference Internal / External (HD) / External (SD) Visualizza lo stato di Genlock. Se Genlock è 
applicato, visualizza il tipo di segnale.
Internal: Genlock esterno non applicato.
External (HD): Genlock su segnale HD.
External (SD): Genlock su segnale SD.

System >Assignable Button
Assegna le funzioni desiderate ai pulsanti programmabili.

Voce Impostazione della voce secondaria Descrizione

Da <1> a 
<10>

Off / Marker / Zebra / Peaking / Video Signal 
Monitor / DURATION/TC/U-BIT / Focus 
Magnifier x4/x8 / Focus Magnifier x4 / Focus 
Magnifier x8 / Push AF/Focus Hold / Focus 
Area / Focus Area (Push AF) / VF Mode / ND 
Filter Position / IRIS / AGC / Auto ND Filter / 
SHUTTER / Auto Exposure Level / Push Auto 
Iris / Push AGC / Push Auto ND / Spotlight / 
Backlight / ATW / ATW Hold / SteadyShot / 
Color Bars / User Menu / Rec Lamp / S&Q 
Motion / Picture Cache Rec / Rec Review / 
Thumbnail / Shot Mark1 / Shot Mark2 / Clip 
Flag OK / Clip Flag NG / Clip Flag Keep / High/
Low Key

Assegna funzioni ai pulsanti programmabili.
Marker:  

Attiva o disattiva la funzione Marker.
Zebra:  

Attiva o disattiva la funzione Zebra.
Peaking:  

Attiva o disattiva la funzione Peaking.
Video Signal Monitor:  

Attiva una modalità di monitor del segnale video 
(ad esempio il monitor della forma d’onda).

DURATION/TC/U-BIT:  
Alterna fra Time Code, Users Bit e Duration.

Focus Magnifier x4/x8:
Focus Magnifier x4:
Focus Magnifier x8:  

Attiva o disattiva la funzione di 
ingrandimento per la messa a fuoco.

Push AF/Focus Hold:  
Esegue la funzione di Push Auto Focus o 
di Focus Hold.

Focus Area:
Focus Area (Push AF):  

Apre la schermata di configurazione di 
Focus Area.

VF Mode:  
Consente di scegliere se visualizzare l’immagine 
del mirino a colori o in bianco e nero.

ND Filter Position  
Consente di scegliere i filtro ND.

IRIS:  
Alterna fra le modalità di diaframma 
automatico e manuale.

AGC:  
Attiva o disattiva la funzione AGC.

Auto ND Filter  
Attiva o disattiva la funzione di filtro ND 
automatico.

SHUTTER:  
Alterna fra le modalità di otturatore 
automatico e manuale.

Auto Exposure Level:  
Apre la schermata del livello di 
esposizione automatica.
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System >Assignable Button
Assegna le funzioni desiderate ai pulsanti programmabili.

Voce Impostazione della voce secondaria Descrizione

Da <1> a 
<10>

Push Auto Iris:  
Abilita la funzione di diaframma automatico 
mentre si tiene premuto il pulsante.

Push AGC:  
Attiva la funzione AGC mentre si tiene 
premuto il pulsante.

Push Auto ND  
Attiva la funzione di filtro ND automatico 
mentre si tiene premuto il pulsante.

Spotlight:  
Alterna fra Spotlight e Standard.

Backlight:  
Alterna fra Backlight e Standard.

ATW:  
Attiva o disattiva la funzione ATW.

ATW Hold:  
Sospende la funzione ATW.

SteadyShot:  
Alterna fra Active SteadyShot, 
SteadyShot e Off.

Color Bars:  
Attiva o disattiva la visualizzazione della 
barra colori.

User Menu:  
Apre e chiude il menu User.

Rec Lamp:  
Accende o spegne l’indicatore di registrazione.

S&Q Motion:  
Attiva o disattiva la modalità Slow & 
Quick Motion.  
Se mantenuto premuto, imposta la 
frequenza fotogrammi di registrazione.

Picture Cache Rec:  
Attiva o disattiva la funzione di 
registrazione cache immagine.

Rec Review:  
Attiva o disattiva la funzione Rec Review.

Thumbnail:  
Apre o chiude la schermata delle miniature.

Shot Mark1:  
Esegue la funzione Add Shot Mark1.

Shot Mark2:  
Esegue la funzione Add Shot Mark2.

System >Assignable Button
Assegna le funzioni desiderate ai pulsanti programmabili.

Voce Impostazione della voce secondaria Descrizione

Da <1> a 
<10>

Clip Flag OK:  
Esegue la funzione Add OK.  
Premere due volte per eseguire Delete 
Clip Flag.

Clip Flag NG:  
Esegue la funzione Add NG.  
Premere due volte per eseguire Delete 
Clip Flag.

Clip Flag Keep:  
Esegue la funzione Add Keep.  
Premere due volte per eseguire Delete 
Clip Flag.

High/Low Key:  
Passa, nell’ordine, da High Key (modalità 
di visualizzazione per il controllo della 
sovraesposizione delle alte luci), a Low 
Key (modalità di visualizzazione per il 
controllo delle zone di sottoesposizione) 
a Off (visualizzazione normale).  
Si applica ai sistemi in cui Monitor LUT è 
impostata su On.

System >Assignable Dial
Assegna le funzioni desiderate alla manopola programmabile e ne imposta la direzione di rotazione.

Voce Impostazione della voce secondaria Descrizione

Assignable 
Dial

Off / IRIS / ISO/Gain/EI / ND Filter / Focus / 
Audio Input Level

Assegna funzioni alla manopola 
programmabile dell’impugnatura di 
telecomando.
ISO/Gain/EI: Regola guadagno o EI.
IRIS: Regola il diaframma.
ND Filter: Regola il livello di luce.
Focus: Regola la messa a fuoco.
Audio Input Level: Regola il livello audio.

IRIS Dial (Stesse impostazioni di Assignable Dial) Quando il selettore ND/IRIS si trova sulla 
posizione IRIS, questa voce assegna le 
funzioni alla manopola IRIS.

Assignable 
Dial Direction

Normal / Opposite Imposta la direzione di rotazione della 
manopola programmabile dell’impugnatura 
di telecomando.
Normal: Ruota in avanti.
Opposite: Ruota in senso inverso.
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System >Assignable Dial
Assegna le funzioni desiderate alla manopola programmabile e ne imposta la direzione di rotazione.

Voce Impostazione della voce secondaria Descrizione

IRIS Dial 
Direction

Normal / Opposite Imposta la direzione di rotazione delle 
manopola IRIS quando il selettore ND/IRIS è 
impostato su IRIS.
Normal: Ruota in avanti.
Opposite: Ruota in senso inverso.

System >ND Dial
Imposta la direzione di rotazione delle manopola ND.

Voce Impostazione della voce secondaria Descrizione

ND Dial 
Direction

Normal / Opposite Imposta la direzione di rotazione delle 
manopola ND quando il selettore ND/IRIS è 
impostato su ND.
Normal: Ruota in avanti.
Opposite: Ruota in senso inverso.

System >Rec Lamp
Consente di specificare le impostazioni relative all’indicatore di registrazione.

Voce Impostazione della voce secondaria Descrizione

Rec Lamp On / Off Accende o spegne l’indicatore di 
registrazione.

System >Fan Control
Consente di specificare le impostazioni di comando della ventola.

Voce Impostazione della voce secondaria Descrizione

Setting Auto / Minimum / Off in Rec Imposta la modalità di controllo della ventola 
del camcorder.

[Nota]
Anche se è selezionata l’opzione Off in Rec, il 
ventilatore si attiva ugualmente se la temperatura 
interna del camcorder raggiunge un determinato 
valore.

System >HOLD Switch Setting
Consente di specificare le impostazioni relative al selettore HOLD.

Voce Impostazione della voce secondaria Descrizione

with Rec 
Button

On / Off Consente di scegliere se bloccare o meno il 
pulsante di registrazione.

with Hand 
Grip Remote

On / Off Consente di scegliere se bloccare il 
funzionamento dell’impugnatura di 
telecomando.

System >Lens
Consente di specificare le impostazioni relative agli obiettivi.

Voce Impostazione della voce secondaria Descrizione

Zoom Ring 
Direction

Left (W) / Right (T) / Right (W) / Left (T) Imposta la direzione della ghiera dello zoom.

[Nota]
Abilitato solo quando si utilizza un obiettivo con 
innesto E-mount che consente la scelta della 
direzione di azionamento della ghiera dello zoom.

Shading 
Compensation

Auto / Off Attiva o disattiva la funzione di correzione 
della luminosità ai margini.

Chroma 
Aberration 
Comp.

Auto / Off Attiva o disattiva la funzione di 
compensazione dell’aberrazione cromatica.

Distortion 
Comp.

Auto / Off Attiva o disattiva la funzione di correzione 
automatica della distorsione.

[Note]
ˎˎ Non disponibile in modalità di registrazione 

cache immagine o durante la registrazione.
ˎˎ La compensazione della distorsione non è 

applicata durante la registrazione in modalità 
4K o QFHD.
ˎˎ Quando è selezionato Auto, saranno presenti 

alcune limitazioni a Monitor LUT (pagina 91). 

System >Language
Imposta la lingua di visualizzazione.

Voce Impostazione della voce secondaria Descrizione

Select Imposta la lingua di visualizzazione.
SET: Imposta la lingua.

System >Clock Set
Consente di specificare le impostazioni relative all’orologio interno.

Voce Impostazione della voce secondaria Descrizione

Time Zone Da UTC –12:00 a UTC +14:00 Imposta la differenza rispetto all’ora UTC in 
passi di 30 minuti.

Date Mode YYMMDD / MMDDYY / DDMMYY Seleziona il formato di visualizzazione della 
data.
YYMMDD: Anno, mese, giorno
MMDDYY: Mese, giorno, anno
DDMMYY: Giorno, mese, anno

12H/24H 12H / 24H Seleziona il formato di visualizzazione 
dell’ora.
12H: Orologio a 12 ore
24H: Orologio a 24 ore
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System >Clock Set
Consente di specificare le impostazioni relative all’orologio interno.

Voce Impostazione della voce secondaria Descrizione

Date Imposta la data corrente.
SET: Imposta il valore.

Time Imposta l’ora corrente.
SET: Imposta il valore.

System >Country
Imposta la regione di utilizzo.

Voce Impostazione della voce secondaria Descrizione

NTSC/PAL Area NTSC Area / PAL Area
L’impostazione predefinita varia a seconda del 
paese di acquisto.

Imposta la regione di utilizzo.

System >Hours Meter
Visualizza il tempo cumulativo di funzionamento.

Voce Impostazione della voce secondaria Descrizione

Hours (System) Visualizza le ore d’uso totali (non può essere 
azzerato).

Hours (Reset) Visualizza le ore d’uso totali (può essere 
azzerato).

Reset Execute / Cancel Azzera l’indicazione Hours (Reset).
Execute: Reset

System >Basic Authentication
Consente di specificare le principali impostazioni relative all’autenticazione di rete.

Voce Impostazione della voce secondaria Descrizione

User Name User name
(admin)

Imposta il nome utente desiderato (da 1 a 16 
caratteri alfanumerici).
SET: Imposta il valore.

Password Password
(pxw-fs7m2)

Imposta una password (da 1 a 16 caratteri 
alfanumerici).
SET: Imposta il valore.

System >Wi-Fi
Consente di configurare le impostazioni della connessione LAN wireless.

Voce Impostazione della voce secondaria Descrizione

Wi-Fi Enable / Disable Attiva o disattiva la funzione Wi-Fi.

SSID & 
Password

Visualizza SSID e password.

System >Wi-Fi
Consente di configurare le impostazioni della connessione LAN wireless.

Voce Impostazione della voce secondaria Descrizione

Wi-Fi Direct 
Connection

Execute / Cancel Avvia una connessione di rete Wi-Fi Direct.
Execute: Connetti

Client Visualizza informazioni sul dispositivo client 
connesso (nome del modello e indirizzo 
MAC).

IP Address 192.168.1.1 Visualizza l’indirizzo IP del camcorder.

[Nota]
Non visualizzato quando si utilizza l’adattatore 
CBK-WA100.

Subnet Mask 255.255.0.0 Visualizza la subnet mask.

[Nota]
Non visualizzato quando si utilizza l’adattatore 
CBK-WA100.

MAC Address Visualizza l’indirizzo MAC del modulo Wi-Fi 
collegato al camcorder.

Regenerate 
Password

Execute / Cancel Crea una nuova password.
Execute: Rigenera

System >GPS
Consente di specificare le impostazioni relative al GPS.

Voce Impostazione della voce secondaria Descrizione

GPS On / Off Attiva o disattiva la funzione GPS.

[Nota]
Il modulo GPS è incorporato nella maniglia.

System >IR Remote
Consente di specificare le impostazioni relative al telecomando a infrarossi.

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva l’azionamento del 
camcorder tramite il telecomando a infrarossi 
fornito in dotazione.

System >Camera Battery Alarm
Consente di specificare le impostazioni relative all’allarme per bassa tensione batteria.

Voce Impostazione della voce secondaria Descrizione

Low BATT 5% / 10% / 15% / … / 45% / 50% Imposta il livello di carica rimanente della 
batteria per la visualizzazione dell’allarme di 
bassa tensione batteria (in incrementi del 
5%).



000 5. Menu visualizzati e impostazioni: Elenco delle voci del menu di configurazione80

System >Camera Battery Alarm
Consente di specificare le impostazioni relative all’allarme per bassa tensione batteria.

Voce Impostazione della voce secondaria Descrizione

BATT Empty Da 3% a 7% Imposta il livello di carica rimanente della 
batteria per la visualizzazione dell’allarme 
batteria scarica.

System >Camera DC IN Alarm
Consente di specificare le impostazioni relative all’allarme della tensione di ingresso.

Voce Impostazione della voce secondaria Descrizione

DC Low 
Voltage1

Da 11.5V a 17V Imposta la tensione alla quale visualizzare 
l’allarme di bassa tensione su ingresso DC IN.

DC Low 
Voltage2

Da 11.0V a 14.0V Imposta la tensione alla quale visualizzare 
l’allarme di tensione su ingresso DC IN 
insufficiente.

System >Ext. Unit Battery Alarm
Consente di configurare le impostazioni relative alla batteria dell’unità di estensione XDCA-FS7.

Voce Impostazione della voce secondaria Descrizione

Near End:Info 
Battery

Da 5% a 100% Imposta il livello di carica rimanente della 
batteria per la visualizzazione dell’allarme di 
bassa tensione batteria Info-Lithium (in 
incrementi del 5%).

End:Info 
Battery

Da 0% a 5% Imposta il livello di carica rimanente della 
batteria per la visualizzazione dell’allarme di 
batteria Info-Lithium esausta ed arrestare 
l’accesso ai supporti di memorizzazione.

Near End:Sony 
Battery

Da 11.5V a 17V Imposta il livello di carica rimanente della 
batteria per la visualizzazione dell’allarme di 
bassa tensione batteria per una batteria non 
Info-Lithium.

End:Sony 
Battery

Da 11.0V a 11.5V Imposta il livello di carica rimanente della 
batteria per la visualizzazione dell’allarme di 
batteria esausta per batterie non Info-
Lithium ed arrestare l’accesso ai supporti di 
memorizzazione.

Near 
End:Other 
Battery

Da 11.5V a 17V (11.8V) Imposta il livello di carica rimanente della 
batteria per la visualizzazione dell’allarme di 
bassa tensione batteria per una batteria 
Anton/Bauer.

System >Ext. Unit Battery Alarm
Consente di configurare le impostazioni relative alla batteria dell’unità di estensione XDCA-FS7.

Voce Impostazione della voce secondaria Descrizione

End:Other 
Battery

Da 11.0V a 14.0V Imposta il livello di carica rimanente della 
batteria per la visualizzazione dell’allarme di 
batteria esausta per batterie Anton/Bauer ed 
arrestare l’accesso ai supporti di 
memorizzazione.

Detected 
Battery

Visualizza il tipo di alimentazione collegata 
all’unità di estensione XDCA-FS7.
Se è connessa una batteria all’unità di 
estensione XDCA-FS7, visualizza “Info 
Battery”, “Sony Battery” o “Other Battery”. Se è 
collegata una sorgente di alimentazione in 
corrente continua, viene visualizzato “DC IN”.
Se l’alimentazione proviene da batteria o 
alimentatore a corrente continua connesso 
al camcorder, viene visualizzata l’indicazione 
“ --- ”.

System >Ext. Unit DC IN Alarm
Consente di configurare le impostazioni relative all’allarme della tensione di ingresso sull’unità di 
estensione XDCA-FS7

Voce Impostazione della voce secondaria Descrizione

DC Low 
Voltage1

Da 11.5V a 17V Imposta la tensione alla quale visualizzare 
l’allarme di bassa tensione su ingresso DC IN.

DC Low 
Voltage2

Da 11.0V a 14.0V Imposta la tensione alla quale visualizzare 
l’allarme di tensione su ingresso DC IN 
insufficiente.

System >All Reset
Ripristina i valori predefiniti di fabbrica di tutte le impostazioni.

Voce Impostazione della voce secondaria Descrizione

Reset Execute / Cancel Ripristina i valori predefiniti di fabbrica di 
tutte le impostazioni.
Execute: Reset
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System >APR
Esegue la funzione APR.

Voce Impostazione della voce secondaria Descrizione

APR Execute / Cancel Esegue la funzione APR di ricostruzione 
automatica pixel per la regolazione 
automatica del sensore di immagine.
Execute: Run

[Nota]
Montare sempre il coperchietto dell’obiettivo 
prima di eseguire la funzione APR.

System >Camera Config
Consente di specificare le impostazioni relative all’uscita in modalità down-converter.

Voce Impostazione della voce secondaria Descrizione

HD/2K 
Modulation

High / Low Imposta la larghezza di banda in uscita della 
modalità down-converter per la conversione 
in HD e 2K

System >Version
Visualizza informazioni sulla versione.

Voce Impostazione della voce secondaria Descrizione

Number x.xx Visualizza la versione del software del 
camcorder.

Version Up Execute / Cancel Esegue l’upgrade del camcorder.*
Execute: Esegue l’aggiornamento
*	 L’upgrade aggiorna il software del camcorder.

Lens Version 
Number

xx Visualizza la versione dell’obiettivo con 
innesto E-mount.

Lens Version 
Up

Execute / Cancel Aggiorna il software dell’obiettivo E-mount 
(pagina 103).
Execute: Esegue l’aggiornamento

Ext. Unit 
Version 
Number

x.xx Visualizza la versione del software dell’unità 
di estensione XDCA-FS7.

Ext. Unit 
Version Up

Execute / Cancel Esegue l’upgrade dell’unità di estensione 
XDCA-FS7.*
Execute: Esegue l’aggiornamento
*	 L’upgrade aggiorna il software dell’unità di 

estensione XDCA-FS7.
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Connessione di monitor e dispositivi di registrazione esterni
Per visualizzare le immagini di registrazione e 
riproduzione del camcorder su un monitor esterno, 
selezionare il segnale di uscita del camcorder e 
utilizzare il cavo appropriato per il monitor esterno 
da collegare.
È possibile anche collegare dispositivi di 
registrazione, ad esempio un VTR, e registrare il 
segnale in uscita dal camcorder.
È possibile visualizzare sul monitor esterno le 
stesse informazioni che sono visibili nel mirino, ad 
esempio informazioni di stato e menu. Impostare 
Output Display (pagina 66) nel menu Video su 
On per il tipo di segnale da inviare al monitor.

Connettore SDI OUT (tipo BNC)

Attivare o disattivare l’uscita e selezionare 
il formato di uscita mediante il menu Video 
(pagina 65).
Per la connessione, utilizzare un cavo coassiale da 
75 Ω disponibile in commercio.

[Nota]
Controllare la messa a terra della connessione fra il 
camcorder e il dispositivo esterno prima di accendere i 
dispositivi.

(Si consiglia di accendere il camcorder e il 
dispositivo esterno dopo la connessione del cavo 
coassiale da 75 Ω).
Se il dispositivo esterno deve essere collegato al 
camcorder mentre il camcorder è acceso, collegare 
il cavo coassiale da 75 Ω prima al dispositivo 
esterno e solo successivamente al camcorder.

Per avviare la registrazione simultaneamente sul 
camcorder e sul dispositivo esterno

Con l’uscita segnale SDI abilitata, impostare SDI/
HDMI Rec Control (pagina 71) >Setting nel 
menu Recording su SDI/HDMI Remote I/F o Parallel 
Rec per abilitare l’emissione di un segnale di 
trigger REC diretto al dispositivo esterno connesso 

al connettore SDI OUT. Questo sincronizzerà 
la registrazione sul dispositivo esterno con il 
camcorder (pagina 43).

Connettore HDMI OUT (Type A)

Attivare o disattivare l’uscita e selezionare 
il formato di uscita mediante il menu Video 
(pagina 65).
Per la connessione, utilizzare un cavo HDMI ad alta 
velocità disponibile in commercio.
Selezionare il tipo di dispositivo collegato con la 
voce HDMI Target Device (pagina 65) del menu 
Video.

Connettore RAW OUT (tipo BNC)

Se viene montata un’unità di estensione XDCA-FS7 
sul camcorder, è possibile utilizzare un registratore 
RAW esterno, ad esempio un registratore AXS-R5, 
connesso al connettore RAW OUT dell’unità XDCA-
FS7 (pagina 28).
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Sincronizzazione esterna
Per le riprese con più camcorder, è possibile 
sincronizzare i camcorder a un segnale di 
riferimento specifico o ai codici temporali 
sincronizzati tramite il connettore Genlock delle 
unità XDCA-FS7 (pagina 8) montate sui 
camcorder.

[Nota]
Non è possibile utilizzare il pacco batteria del camcorder 
quando è montata un’unità di estensione XDCA-FS7. È 
necessario montare un pacco batteria sull’unità XDCAFS7 
oppure collegare un alimentatore esterno.

Sincronizzazione della fase dei 
segnali video (genlock)

Abilitare la funzione genlock fornendo un 
segnale di riferimento ai connettori GENLOCK IN 
(pagina 8) delle unità XDCA-FS7 montate sui 
camcorder.
I segnali di riferimento utilizzabili variano a 
seconda della frequenza fotogrammi del formato 
di registrazione selezionato.

Per la zona NTSC
Frequenza 
fotogrammi del 
formato di 
registrazione

Segnali di riferimento validi

59.94P 1920×1080 59.94i
720×486 59.94i
1280×720 59.94P

29.97P 1920×1080 59.94i
720×486 59.94i

24.0P 1920×1080 48i (24PsF)

23.98P 1920×1080 47.95i (23.98PsF)

59.94i 1920×1080 59.94i
720×486 59.94i

Per la zona PAL
Frequenza 
fotogrammi del 
formato di 
registrazione

Segnali di riferimento validi

50P 1920×1080 50i
720×576 50i
1280×720 50P

25P 1920×1080 50i
720×576 50i

50i 1920×1080 50i
720×576 50i

[Note]
ˎˎ Se il formato di registrazione selezionato è 1280×720 60P, 

è necessario fornire sia un segnale video che un segnale 
di tempo.
ˎˎ Se il segnale di riferimento non è stabile, sarà impossibile 

ottenere la sincronizzazione genlock.
ˎˎ La sottoportante non è sincronizzata.

Sincronizzazione del codice 
temporale con altri dispositivi

Impostare l’unità che fornisce il codice temporale 
su una modalità in cui il codice temporale continui 
ad avanzare (es. Free Run o Clock).

1	 Impostare l’opzione Timecode (pagina 69) 
del menu TC/UB come indicato di seguito. 
Mode: Preset
Run: Free Run

2	 Premere il pulsante programmabile 
(pagina 38) a cui è assegnata la funzione 
DURATION/TC/UBIT per visualizzare il codice 
temporale sullo schermo.

3	 Controllare che il selettore TC IN/OUT 
(pagina 8) dell’unità XDCA-FS7 si trovi nella 
posizione IN e fornire un segnale video di 
riferimento HD o SD e un codice temporale 
sincronizzato con il segnale video sui 
connettori Genlock e TC IN/OUT 
rispettivamente.

Il generatore del codice temporale del camcorder 
si sincronizza con il codice temporale di 
riferimento e sullo schermo appare l’indicazione 
“EXT-LK”.
Una volta trascorsi dieci secondi circa 
dall’acquisizione della sincronizzazione, lo stato di 
sincronizzazione esterno viene mantenuto anche 
se la sorgente di riferimento esterna del codice 
temporale viene scollegata.

[Note]
ˎˎ Controllare che il codice temporale di riferimento e il 

segnale video di riferimento siano in un rapporto di fase 
conforme agli standard SMPTE per i codici temporali.
ˎˎ Durante il funzionamento in modalità di sincronizzazione 

esterna, il codice temporale acquisisce istantaneamente 
la sincronizzazione con il codice temporale esterno e 
nella sezione di visualizzazione dei dati viene visualizzato 
il valore del codice temporale esterno. Tuttavia, non 
avviare immediatamente la registrazione. Prima di avviare 
la registrazione è necessario attendere alcuni secondi la 
stabilizzazione del generatore del codice temporale.
ˎˎ Se la frequenza del segnale video di riferimento e 

la frequenza fotogrammi del camcorder non sono 
identiche, non sarà possibile ottenere la sincronizzazione 
e il camcorder non potrà funzionare correttamente. In 
questo caso, il codice temporale non potrà sincronizzarsi 
correttamente con il codice temporale esterno.
ˎˎ Se la sorgente del codice temporale esterno viene 

disconnessa, il codice temporale potrà variare di un 
fotogramma all’ora rispetto al codice temporale di 
riferimento.

Per rilasciare la sincronizzazione esterna

Cambiare l’impostazione di Timecode nel menu 
TC/UB oppure spegnere il camcorder.
La sincronizzazione esterna si disconnette anche 
se si avvia la registrazione in modalità Quick & Slow 
Motion.

Sincronizzazione del codice 
temporale di un altro dispositivo con 
il codice temporale del camcorder

Impostare l’unità che fornisce il codice temporale 
su una modalità in cui il codice temporale continui 
ad avanzare (es. Free Run o Clock).

1	 Impostare il codice temporale del camcorder 
con l’opzione Timecode (pagina 69) del 
menu TC/UB.

2	 Controllare che il selettore TC IN/OUT 
(pagina 8) della unità XDCA-FS7 si trovi 
nella posizione OUT, quindi collegare il 
connettore TC IN/OUT e il connettore REF OUT 
(pagina 8) agli ingressi del codice 
temporale e del segnale di riferimento esterno, 
rispettivamente, del dispositivo che si desidera 
sincronizzare. 
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Gestione ed editing di clip con un computer
Connessione con cavo USB

Utilizzo di un lettore di schede XQD (opzione)

Collegare un lettore di schede MRW-E90 XQD 
(opzione) mediante un cavo USB, quindi inserire 
una scheda di memoria nello slot. La scheda di 
memoria viene riconosciuta come un’unità di 
estensione del computer.

Utilizzo della modalità di memorizzazione di 
massa

Collegare il camcorder mediante un cavo USB, 
quindi inserire una scheda di memoria nello slot. 
La scheda di memoria viene riconosciuta come 
un’unità di estensione del computer.

1	 Spostare l’interruttore POWER del camcorder 
su ON.
Sullo schermo o nel mirino viene visualizzato 
un messaggio di conferma della connessione 
USB.

	 [Nota]
Il messaggio di conferma della connessione USB 
non viene visualizzato se è già visualizzato un altro 
messaggio di conferma o un indicatore di avanzamento, 
ad esempio durante la formattazione o il recupero di 
una scheda di memoria XQD.
Il messaggio di conferma verrà visualizzato al termine 
della formattazione o del recupero. Il messaggio di 
conferma USB non è visualizzato neanche quando 
è visualizzata la schermata delle proprietà del clip. Il 
messaggio verrà visualizzato al termine dell’operazione 
o quando si ritorna alla schermata delle miniature.

2	 Ruotare la manopola SEL/SET e selezionare 
Execute.

3	 Su Windows, controllare che la scheda sia 
aggiunta come disco rimovibile nella finestra 
“My Computer”.
Su Macintosh, controllare che sia stata creata 
sul Desktop una cartella con il nome “NO 
NAME” o “Untitled” (modificabile).

[Note]
ˎˎ Non eseguire le seguenti operazioni se l’indicatore di 

accesso è illuminato in rosso.
–– Spegnere l’apparecchio o scollegare il cavo di 

alimentazione
–– Rimuovere la scheda di memoria XQD
–– Scollegare il cavo USB

ˎˎ Il funzionamento non è garantito con tutti i computer.

Utilizzo di sistemi di editing non lineare

In un sistema di editing non lineare, è necessario 
utilizzare un software di editing (opzione) che 
supporti i formati registrati dal camcorder.
Utilizzare un software applicativo dedicato per 
salvare in anticipo sul disco rigido del computer i 
clip di cui eseguire l’editing.
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Precauzioni per l’uso
La ventola è una parte di consumo e necessita di 
una sostituzione periodica.
Se l’apparecchio viene utilizzato a temperatura 
ambiente, il ciclo normale di sostituzione è di 
circa 5 anni. Tuttavia, ciò ha un valore puramente 
indicativo e non implica alcuna garanzia sulla 
durata di vita prevista di questo componente. 
Per ulteriori informazioni sulla sostituzione dei 
componenti, rivolgersi al proprio rivenditore.

Qualora l’unità venga spostata rapidamente 
da un ambiente freddo a uno caldo, oppure se 
la temperatura ambiente dovesse aumentare 
improvvisamente, è possibile che si formi 
umidità sulle superfici esterne dell’unità e/o al 
suo interno. Questo fenomeno è denominato 
condensazione. In tal caso, spegnere l’unità ed 
attendere la scomparsa della condensazione prima 
di riavviarla. L’utilizzo dell’unità mentre è presente 
condensazione può causare danni all’unità stessa.

Il pannello LCD di cui è dotato l’apparecchio è 
prodotto con tecnologia ad alta precisione che 
consente di ottenere una percentuale di pixel 
funzionanti minima di ben 99,99%. È quindi 
possibile che una piccolissima percentuale dei 
pixel possa rimanere “bloccata”, sempre disattivata 
(nera), sempre attivata (rossa, verde o blu) oppure 
lampeggiante. È inoltre possibile che, dopo un 
lungo periodo d’uso, alcuni pixel si “blocchino” 
spontaneamente a causa delle caratteristiche 
fisiche del display a cristalli liquidi. Tali fenomeni 
non sono il risultato di guasti e non hanno alcun 
effetto sui dati registrati.

Il morsetto della batteria dell’apparecchio (il 
connettore per pacchi batteria e adattatori CA) è 
un prodotto di consumo.
Se i piedini del morsetto sono piegati e deformati 
a causa di urti o vibrazioni, o se vengono corrosi 
a causa di un uso prolungato all’aria aperta, 
l’alimentazione potrebbe non essere fornita 
correttamente.
Si consiglia di eseguire dei controlli periodici 

per assicurare il funzionamento corretto 
dell’apparecchio e prolungarne la vita utile.
Per ulteriori informazioni sui controlli, contattare il 
servizio tecnico o un rappresentante Sony.

Informazioni sulla batteria ricaricabile incorporata

Il camcorder è dotato di una batteria ricaricabile 
interna che consente la memorizzazione di data, 
ora e altre impostazioni anche quando è spento. 
La batteria interna si ricarica mentre il camcorder 
rimane collegato a una presa di corrente di rete 
tramite l’adattatore CA o a un pacco batteria 
completamente carico. La ricarica richiede 24 ore 
indipendentemente dal fatto che il camcorder sia 
acceso o spento. Se non è connesso un adattatore 
CA o il camcorder viene utilizzato senza pacco 
batteria, la batteria ricaricabile si scaricherà 
completamente dopo circa 3 mesi. Utilizzare il 
camcorder dopo aver ricaricato la batteria. Tuttavia, 
anche se la batteria ricaricabile interna è scarica, 
il funzionamento del camcorder non risulta 
compromesso purché non si registri data e ora.
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Manopola ND FILTER
Se il filtro ND non si muove, è possibile spostarlo 
manualmente sulla posizione Cear utilizzando la 
procedura descritta di seguito.

1	 Spostare l’interruttore POWER del camcorder 
su Off.

2	 Rimuovere il coperchietto rotondo sul lato 
inferiore.

3	 Inserire un piccolo cacciavite nel foro e 
ruotarlo in senso antiorario.
ˎˎ Il filtro ND si sposta sulla posizione Clear 
ruotando in senso antiorario. Continuare a 
ruotare il cacciavite fino a raggiungere la 
posizione Clear.
ˎˎ Utilizzare un cacciavite con diametro 
massimo di 2,4 mm. La profondità di 
inserimento del cacciavite è di circa 3,2 cm.

Foro per cacciavite
(con coperchietto rimosso)

4	 Spostare il selettore PRESET/VARIABLE 
(pagina 6) sulla posizione PRESET e 
spostare la manopola ND FILTER (pagina 6) 
su Clear.

[Note]
ˎˎ Non utilizzare questa procedura durante il normale 

funzionamento dell’apparecchio. Utilizzare questa 
procedura solo se il filtro ND non si muove. Il filtro ND 
potrebbe danneggiarsi se questa procedura viene 
utilizzata durante il normale funzionamento. 
ˎˎ Dopo aver utilizzato questa procedura, rivolgersi a un 

centro di assistenza Sony per la riparazione del camcorder.
ˎˎ Dopo l’esecuzione di questa procedura, sarà possibile 

eseguire riprese anche se viene visualizzato un messaggio 
di errore.
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Le impostazioni predefinite sono indicate in grassetto (ad esempio, 2048×1080P (Level A)). 

[Note]
ˎˎ La risoluzione del formato di registrazione è limitata dall’impostazione di Base Setting >Imager Scan Mode nel menu System 

(pagina 75).
ˎˎ Se la risoluzione dell’uscita video è superiore a quella dell’immagine, non viene emessa nessuna immagine riprodotta.

Formati di uscita per il connettore SDI OUT/HDMI OUT

Quando Country >NTSC/PAL Area nel menu System è impostato su NTSC Area

Quando si utilizza una configurazione di base (XAVC-I / XAVC-L / MPEG HD)
Impostazioni del 
formato di 
registrazione
(Rec Format >Video 
Format nel menu 
System)

Impostazioni di uscita SDI/HDMI
(Output Format >SDI e HDMI nel 
menu Video)

Segnale di uscita SDI Segnale di uscita 
HDMI

SDI HDMI

4096×2160 59.94P – 4096×2160P Nessuna uscita 4096×2160 59.94P

– 3840×2160P Nessuna uscita 3840×2160 59.94P

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P 
Level-A

1920×1080 59.94P

1920×1080P 
(Level B)

– 1920×1080 59.94P 
Level-B

Nessuna uscita

1920×1080i 1920×1080i 1920×1080 59.94i 1920×1080 59.94i

4096×2160 29.97P – 4096×2160P Nessuna uscita 4096×2160 29.97P

– 3840×2160P Nessuna uscita 3840×2160 29.97P

1920×1080PsF 1920×1080i 1920×1080 29.97PsF 1920×1080 29.97PsF

4096×2160 24.00P – 4096×2160P Nessuna uscita 4096×2160 24P

– 3840×2160P Nessuna uscita 3840×2160 24P

1920×1080PsF – 1920×1080 24PsF Nessuna uscita

– 1920×1080P Nessuna uscita 1920×1080 24P (Pure)

4096×2160 23.98P – 4096×2160P Nessuna uscita 4096×2160 23.98P

– 3840×2160P Nessuna uscita 3840×2160 23.98P

1920×1080PsF – 1920×1080 23.98PsF Nessuna uscita

– 1920×1080P Nessuna uscita 1920×1080 23.98P 
(Pure)

Impostazioni del 
formato di 
registrazione
(Rec Format >Video 
Format nel menu 
System)

Impostazioni di uscita SDI/HDMI
(Output Format >SDI e HDMI nel 
menu Video)

Segnale di uscita SDI Segnale di uscita 
HDMI

SDI HDMI

3840×2160 59.94P – 4096×2160P Nessuna uscita 4096×2160 59.94P

– 3840×2160P Nessuna uscita 3840×2160 59.94P

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P 
Level-A

1920×1080 59.94P

1920×1080P 
(Level B)

– 1920×1080 59.94P 
Level-B

Nessuna uscita

1920×1080i 1920×1080i 1920×1080 59.94i 1920×1080 59.94i

3840×2160 29.97P – 4096×2160P Nessuna uscita 4096×2160 29.97P

– 3840×2160P Nessuna uscita 3840×2160 29.97P

1920×1080PsF 1920×1080i 1920×1080 29.97PsF 1920×1080 29.97PsF

3840×2160 23.98P – 4096×2160P Nessuna uscita 4096×2160 23.98P

– 3840×2160P Nessuna uscita 3840×2160 23.98P

1920×1080PsF – 1920×1080 23.98PsF Nessuna uscita

– 1920×1080P Nessuna uscita 1920×1080 23.98P 
(Pure)

1920×1080 59.94P 2048×1080P 
(Level A)

– 2048×1080 59.94P 
Level-A

Nessuna uscita

2048×1080P 
(Level B)

– 2048×1080 59.94P 
Level-B

Nessuna uscita

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P 
Level-A

1920×1080 59.94P

1920×1080P 
(Level B)

– 1920×1080 59.94P 
Level-B

Nessuna uscita

1920×1080i 1920×1080i 1920×1080 59.94i 1920×1080 59.94i

– 720×480i Nessuna uscita 720×480 59.94i

– 720×480P Nessuna uscita 720×480 59.94P

1920×1080 59.94i 1920×1080i 1920×1080i 1920×1080 59.94i 1920×1080 59.94i

– 720×480i Nessuna uscita 720×480 59.94i

– 720×480P Nessuna uscita 720×480 59.94P

1920×1080 29.97P 2048×1080PsF – 2048×1080 29.97PsF Nessuna uscita

1920×1080PsF 1920×1080i 1920×1080 29.97PsF 1920×1080 29.97PsF

– 720×480i Nessuna uscita 720×480 59.94i (PsF)

Formati di uscita e limitazioni
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Impostazioni del 
formato di 
registrazione
(Rec Format >Video 
Format nel menu 
System)

Impostazioni di uscita SDI/HDMI
(Output Format >SDI e HDMI nel 
menu Video)

Segnale di uscita SDI Segnale di uscita 
HDMI

SDI HDMI

1920×1080 23.98P 2048×1080PsF – 2048×1080 23.98PsF Nessuna uscita

1920×1080PsF – 1920×1080 23.98PsF Nessuna uscita

– 1920×1080P Nessuna uscita 1920×1080 23.98P 
(Pure)

1920×1080i 
(2-3PD)

1920×1080i 
(2-3PD)

1920×1080 59.94i 
(2-3PD)

1920×1080 59.94i 
(2-3PD)

– 720×480i 
(2-3PD)

Nessuna uscita 720×480 59.94i 
(2-3PD)

1280×720 59.94P 1280×720P 1280×720P 1280×720 59.94P 1280×720 59.94P

– 720×480i Nessuna uscita 720×480 59.94i

– 720×480P Nessuna uscita 720×480 59.94P

1280×720 29.97P 1280×720P 1280×720P 1280×720 59.94P 
(2-2RP)

1280×720 59.94P 
(2-2RP)

– 720×480i Nessuna uscita 720×480 59.94i (PsF)

1280×720 23.98P 1280×720P 
(2-3PD)

1280×720P 
(2-3PD)

1280×720 59.94P 
(2-3PD)

1280×720 59.94P 
(2-3PD)

– 720×480i 
(2-3PD)

Nessuna uscita 720×480 59.94i

Quando si utilizza un’unità di estensione (RAW)
Impostazioni del 
formato di 
registrazione
(Rec Format >RAW 
Output Format e Video 
Format nel menu 
System)

Impostazioni di uscita SDI/HDMI
(Output Format >SDI e HDMI nel 
menu Video)

Segnale di uscita SDI Segnale di uscita 
HDMI

SDI HDMI

RAW Output Format
4096×2160 59.94P

Video Format (valore 
fisso)

1920×1080 59.94P

2048×1080P 
(Level A)

– 2048×1080 59.94P 
Level-A

Nessuna uscita

2048×1080P 
(Level B)

– 2048×1080 59.94P 
Level-B

Nessuna uscita

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P 
Level-A

1920×1080 59.94P

1920×1080P 
(Level B)

– 1920×1080 59.94P 
Level-B

Nessuna uscita

1920×1080i 1920×1080i 1920×1080 59.94i 1920×1080 59.94i

RAW Output Format
4096×2160 59.94P

Video Format (valore 
fisso)

1280×720 59.94P

2048×1080P 
(Level A)

– 2048×1080 59.94P 
Level-A

Nessuna uscita

2048×1080P 
(Level B)

– 2048×1080 59.94P 
Level-B

Nessuna uscita

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P 
Level-A

1920×1080 59.94P

1920×1080P 
(Level B)

– 1920×1080 59.94P 
Level-B

Nessuna uscita

1280×720P 1280×720P 1280×720 59.94P 1280×720 59.94P

RAW Output Format
2048×1080 59.94P

Video Format (valore 
fisso)

1920×1080 59.94P 

2048×1080P 
(Level A)

– 2048×1080 59.94P 
Level-A

Nessuna uscita

2048×1080P 
(Level B)

– 2048×1080 59.94P 
Level-B

Nessuna uscita

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P 
Level-A

1920×1080 59.94P

1920×1080P 
(Level B)

– 1920×1080 59.94P 
Level-B

Nessuna uscita

1920×1080i 1920×1080i 1920×1080 59.94i 1920×1080 59.94i
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Impostazioni del 
formato di 
registrazione
(Rec Format >RAW 
Output Format e Video 
Format nel menu 
System)

Impostazioni di uscita SDI/HDMI
(Output Format >SDI e HDMI nel 
menu Video)

Segnale di uscita SDI Segnale di uscita 
HDMI

SDI HDMI

RAW Output Format
2048×1080 59.94P

Video Format (valore 
fisso)

1280×720 59.94P 

2048×1080P 
(Level A)

– 2048×1080 59.94P 
Level-A

Nessuna uscita

2048×1080P 
(Level B)

– 2048×1080 59.94P 
Level-B

Nessuna uscita

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P 
Level-A

1920×1080 59.94P

1920×1080P 
(Level B)

– 1920×1080 59.94P 
Level-B

Nessuna uscita

1280×720P 1280×720P 1280×720 59.94P 1280×720 59.94P

RAW Output Format
4096×2160 29.97P

Video Format (valore 
fisso)

1920×1080 29.97P

2048×1080PsF – 2048×1080 29.97PsF Nessuna uscita

1920×1080PsF 1920×1080i 1920×1080 29.97PsF 1920×1080 29.97PsF

RAW Output Format
2048×1080 29.97P

Video Format (valore 
fisso)

1920×1080 29.97P 

2048×1080PsF – 2048×1080 29.97PsF Nessuna uscita

1920×1080PsF 1920×1080i 1920×1080 29.97PsF 1920×1080 29.97PsF

RAW Output Format
4096×2160 23.98P

Video Format (valore 
fisso)

1920×1080 23.98P

2048×1080PsF – 2048×1080 23.98PsF Nessuna uscita

1920×1080PsF – 1920×1080 23.98PsF Nessuna uscita

– 1920×1080P Nessuna uscita 1920×1080 23.98P 
(Pure)

RAW Output Format
2048×1080 23.98P

Video Format (valore 
fisso)

1920×1080 23.98P

2048×1080PsF – 2048×1080 23.98PsF Nessuna uscita

1920×1080PsF – 1920×1080 23.98PsF Nessuna uscita

– 1920×1080P Nessuna uscita 1920×1080 23.98P 
(Pure)

Quando si utilizza un’unità di estensione (ProRes 422)
Impostazioni del 
formato di 
registrazione
(Rec Format >Video 
Format nel menu 
System)

Impostazioni di uscita SDI/HDMI
(Output Format >SDI e HDMI nel 
menu Video)

Segnale di uscita SDI Segnale di uscita 
HDMI

SDI HDMI

1920×1080 59.94i 1920×1080i 1920×1080i 1920×1080 59.94i 1920×1080 59.94i

1920×1080 29.97P 1920×1080PsF 1920×1080i SDI OUT 1
1920×1080 29.97P
SDI OUT 2
1920×1080 29.97PsF

1920×1080 29.97PsF

1920×1080 23.98P 1920×1080P 1920×1080P 1920×1080 23.98P*1 1920×1080 23.98P 
(Pure)

*1	Non può emettere un segnale compatibile con l’adattatore CBK-WA100.

Quando Country >NTSC/PAL Area nel menu System è impostato su PAL Area

Quando si utilizza una configurazione di base (XAVC-I / XAVC-L / MPEG HD)
Impostazioni del 
formato di 
registrazione
(Rec Format >Video 
Format nel menu 
System)

Impostazioni di uscita SDI/HDMI
(Output Format >SDI e HDMI nel 
menu Video)

Segnale di uscita SDI Segnale di uscita 
HDMI

SDI HDMI

4096×2160 50P – 4096×2160P Nessuna uscita 4096×2160 50P

– 3840×2160P Nessuna uscita 3840×2160 50P

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P 
Level-A

1920×1080 50P

1920×1080P 
(Level B)

– 1920×1080 50P 
Level-B

Nessuna uscita

1920×1080i 1920×1080i 1920×1080 50i 1920×1080 50i

4096×2160 25P – 4096×2160P Nessuna uscita 4096×2160 25P

– 3840×2160P Nessuna uscita 3840×2160 25P

1920×1080PsF 1920×1080i 1920×1080 25PsF 1920×1080 25PsF
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Impostazioni del 
formato di 
registrazione
(Rec Format >Video 
Format nel menu 
System)

Impostazioni di uscita SDI/HDMI
(Output Format >SDI e HDMI nel 
menu Video)

Segnale di uscita SDI Segnale di uscita 
HDMI

SDI HDMI

3840×2160 50P – 4096×2160P Nessuna uscita 4096×2160 50P

– 3840×2160P Nessuna uscita 3840×2160 50P

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P 
Level-A

1920×1080 50P

1920×1080P 
(Level B)

– 1920×1080 50P 
Level-B

Nessuna uscita

1920×1080i 1920×1080i 1920×1080 50i 1920×1080 50i

3840×2160 25P – 4096×2160P Nessuna uscita 4096×2160 25P

– 3840×2160P Nessuna uscita 3840×2160 25P

1920×1080PsF 1920×1080i 1920×1080 25PsF 1920×1080 25PsF

1920×1080 50P 2048×1080P 
(Level A)

– 2048×1080 50P 
Level-A

Nessuna uscita

2048×1080P 
(Level B)

– 2048×1080 50P 
Level-B

Nessuna uscita

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P 
Level-A

1920×1080 50P

1920×1080P 
(Level B)

– 1920×1080 50P 
Level-B

Nessuna uscita

1920×1080i 1920×1080i 1920×1080 50i 1920×1080 50i

– 720×576i Nessuna uscita 720×576 50i

– 720×576P Nessuna uscita 720×576 50P

1920×1080 50i 1920×1080i 1920×1080i 1920×1080 50i 1920×1080 50i

– 720×576i Nessuna uscita 720×576 50i

– 720×576P Nessuna uscita 720×576 50P

1920×1080 25P 2048×1080PsF – 2048×1080 25PsF Nessuna uscita

1920×1080PsF 1920×1080i 1920×1080 25PsF 1920×1080 50i (PsF)

– 720×576i Nessuna uscita 720×576 50i (PsF)

1280×720 50P 1280×720P 1280×720P 1280×720 50P 1280×720 50P

– 720×576i Nessuna uscita 720×576 50i

– 720×576P Nessuna uscita 720×576 50P

1280×720 25P 1280×720P 1280×720P 1280×720 50P (2-2RP) 1280×720 50P (2-2RP)

– 720×576i Nessuna uscita 720×576 50i (PsF)

Quando si utilizza un’unità di estensione (RAW)
Impostazioni del 
formato di 
registrazione
(Rec Format >RAW 
Output Format e Video 
Format nel menu 
System)

Impostazioni di uscita SDI/HDMI
(Output Format >SDI e HDMI nel 
menu Video)

Segnale di uscita SDI Segnale di uscita 
HDMI

SDI HDMI

RAW Output Format
4096×2160 50P

Video Format (valore 
fisso)

1920×1080 50P

2048×1080P 
(Level A)

– 2048×1080 50P 
Level-A

Nessuna uscita

2048×1080P 
(Level B)

– 2048×1080 50P 
Level-B

Nessuna uscita

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P 
Level-A

1920×1080 50P

1920×1080P 
(Level B)

– 1920×1080 50P 
Level-B

Nessuna uscita

1920×1080i 1920×1080i 1920×1080 50i 1920×1080 50i

RAW Output Format
4096×2160 50P

Video Format (valore 
fisso)

1280×720 50P 

2048×1080P 
(Level A)

– 2048×1080 50P 
Level-A

Nessuna uscita

2048×1080P 
(Level B)

– 2048×1080 50P 
Level-B

Nessuna uscita

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P 
Level-A

1920×1080 50P

1920×1080P 
(Level B)

– 1920×1080 50P 
Level-B

Nessuna uscita

1280×720P 1280×720P 1280×720 50P 1280×720 50P

RAW Output Format
2048×1080 50P

Video Format (valore 
fisso)

1920×1080 50P

2048×1080P 
(Level A)

– 2048×1080 50P 
Level-A

Nessuna uscita

2048×1080P 
(Level B)

– 2048×1080 50P 
Level-B

Nessuna uscita

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P 
Level-A

1920×1080 50P

1920×1080P 
(Level B)

– 1920×1080 50P 
Level-B

Nessuna uscita

1920×1080i 1920×1080i 1920×1080 50i 1920×1080 50i
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Impostazioni del 
formato di 
registrazione
(Rec Format >RAW 
Output Format e Video 
Format nel menu 
System)

Impostazioni di uscita SDI/HDMI
(Output Format >SDI e HDMI nel 
menu Video)

Segnale di uscita SDI Segnale di uscita 
HDMI

SDI HDMI

RAW Output Format
2048×1080 50P

Video Format (valore 
fisso)

1280×720 50P 

2048×1080P 
(Level A)

– 2048×1080 50P 
Level-A

Nessuna uscita

2048×1080P 
(Level B)

– 2048×1080 50P 
Level-B

Nessuna uscita

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P 
Level-A

1920×1080 50P

1920×1080P 
(Level B)

– 1920×1080 50P 
Level-B

Nessuna uscita

1280×720P 1280×720P 1280×720 50P 1280×720 50P

RAW Output Format
4096×2160 25P

Video Format (valore 
fisso)

1920×1080 25P 

2048×1080PsF – 2048×1080 25PsF Nessuna uscita

1920×1080PsF 1920×1080i 1920×1080 25PsF 1920×1080 25PsF

RAW Output Format
2048×1080 25P

Video Format (valore 
fisso)

1920×1080 25P 

2048×1080PsF – 2048×1080 25PsF Nessuna uscita

1920×1080PsF 1920×1080i 1920×1080 25PsF 1920×1080 25PsF

Quando si utilizza un’unità di estensione (ProRes 422)
Impostazioni del 
formato di 
registrazione
(Rec Format >Video 
Format nel menu 
System)

Impostazioni di uscita SDI/HDMI
(Output Format >SDI e HDMI nel 
menu Video)

Segnale di uscita SDI Segnale di uscita 
HDMI

SDI HDMI

1920×1080 50i 1920×1080i 1920×1080i 1920×1080 50i 1920×1080 50i

1920×1080 25P 1920×1080PsF 1920×1080PsF SDI OUT 1
1920×1080 25P
SDI OUT 2
1920×1080 25PsF

1920×1080 50i (PsF)

Impostazioni di uscita HDMI per dispositivi HDMI

Output Setting >HDMI 
Target Device nel menu 
Video

Output Display >SDI/HDMI nel menu Video Uscita HDMI

OSD On/Off MLUT On/Off

Recorder (predefin.) SDI=On, HDMI=On (predefin.)
*	 In grigio, non selezionabile.

– Segue SDI1

SDI=On, HDMI=Off Off

SDI=Off, HDMI=Off Off

Monitor SDI=On, HDMI=On (predefin.) On Segue SDI2

SDI=On, HDMI=Off
*	 In grigio, non selezionabile.

–

SDI=Off, HDMI=Off Off

[Note]
ˎˎ Se con il cambiamento di HDMI Target Device le impostazioni correnti di Output Display diventano non più disponibili, tali 

impostazioni cambieranno come segue.
–– Viene impostato automaticamente il valore predefinito.
–– Se il valore predefinito non può essere selezionato, viene impostato automaticamente “SDI=On, HDMI=On.”

ˎˎ HDMI Target Device non può essere impostato su Recorder se Codec è impostato su ProRes.

Stati in cui Monitor LUT non può essere configurata indipendentemente

Nei seguenti casi, Monitor LUT >SDI2, HDMI e Viewfinder nel menu Video non possono essere impostate 
individualmente. Sono sincronizzate con l’impostazione SDI1 & Internal Rec.
ˎˎ Quando Output Format >HDMI nel menu Video è 4096×2160 o 3840×2160
ˎˎ Quando S&Q Motion >Setting nel menu Recording è On
ˎˎ Quando Lens >Distortion Comp. nel menu System è Auto
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Impostazioni del menu Output e spazio colore dell’uscita video quando Preset 
Select è BT.2020

Quando Matrix >Preset Select nel menu Paint è impostato su BT.2020, lo spazio colore del video registrato 
sarà BT.2020. Lo spazio colore dell’uscita video varia come descritto di seguito, in base alle impostazioni di 
Output Format e Output Color Space.

Output Format nel menu Video Output Setting >Output Color 
Space nel menu Video

HDMI SDI1 SDI2

HDMI SDI

4K/QFHD – BT.2020 BT.2020 – –

HD 2K/HD SDI2 BT.709 *1 BT.2020 BT.709

SDI2 BT.2020 BT.2020 BT.2020 BT.2020

All BT.709 BT.709 BT.709 BT.709

*1	Lo spazio colore sarà BT.2020 se HDMI Target Device è impostato su Recorder e BT.709 se impostato su Monitor.

[Nota]
Quando si riproducono clip registrati con la gamma di colore BT.20202 e il video viene emesso su un’uscita video impostata 
sulla gamma di colore BT.709, lo spazio colore non viene convertito e alcuni colori potrebbero apparire differenti.
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Avvisi durante l’utilizzo
Qualora si verifichino avvisi, avvertenze o condizioni che richiedono una conferma, il mirino del camcorder 
visualizza un messaggio, gli indicatori di registrazione iniziano a lampeggiare e viene emesso un segnale 
acustico.
Il segnale acustico di avvertimento viene emesso dall’altoparlante integrato e sul connettore cuffie.

Messaggi di errore

Il camcorder si arresterà nel caso abbia luogo una condizione che causa la visualizzazione di un messaggio 
del tipo seguente.

Messaggio
sul mirino

Segnale 
acustico di 
avvertimento

Indicatore di 
registrazione

Causa e soluzione

E + codice d’errore Continuo Lampeggia 
rapidamente

Indica un’anomalia del camcorder. La registrazione si 
arresta, anche se il mirino continua a visualizzare REC.
Spegnere il camcorder e verificare eventuali problemi 
nei dispositivi collegati, cavi o supporti di 
memorizzazione. Se il messaggio d’errore persiste dopo 
aver riacceso il camcorder, rivolgersi al proprio 
rappresentante di assistenza tecnica Sony.
(Se il camcorder non si spegne spostando su OFF 
l’interruttore di alimentazione POWER, rimuovere la 
batteria o scollegare l’alimentazione dal connettore DC 
IN).

Messaggi di avvertimento

Qualora vengano visualizzati i seguenti messaggi, eseguire le procedure indicate.

Messaggio
sul mirino

Segnale 
acustico di 
avvertimento

Indicatore di 
registrazione

Causa e soluzione

Media Near Full Intermittente Lampeggiante La capacità rimanente sulla scheda di memoria XQD si 
sta esaurendo.
Sostituire non appena possibile.

Media Full Continuo Lampeggia 
rapidamente

Non è possibile registrare, copiare o dividere clip perché 
la capacità rimanente sulla scheda XQD è insufficiente.
Sostituire immediatamente.

Messaggio
sul mirino

Segnale 
acustico di 
avvertimento

Indicatore di 
registrazione

Causa e soluzione

Battery Near End Intermittente Lampeggiante La carica rimanente del pacco batteria si sta esaurendo.
Ricaricare non appena possibile.

Battery End Continuo Lampeggia 
rapidamente

Il pacco batteria è scarico. La registrazione è disabilitata.
Arrestare le operazioni e sostituire il pacco batteria.

Temperature High Intermittente Lampeggiante La temperatura interna è elevata.
Spegnere il camcorder e lasciarlo raffreddare prima di 
utilizzarlo nuovamente.

Voltage Low Intermittente Lampeggiante La tensione sul connettore DC IN è bassa (livello 1). 
Controllare la sorgente di alimentazione.

Insufficient Voltage Continuo Lampeggia 
rapidamente

La tensione sul connettore DC IN è insufficiente (livello 
2). La registrazione è disabilitata.
Collegare un’altra sorgente di alimentazione.

Messaggi di avviso e operativi

Al centro dello schermo potranno essere visualizzati i seguenti messaggi di avviso e operativi. Seguire le 
istruzioni fornite per risolvere il problema.

Messaggio sul mirino Causa e soluzione

Battery Error
Please Change Battery

È stata rilevata un’anomalia nel pacco batteria.
Sostituire con un pacco batteria normale.

Backup Battery End
Please Change

La carica della batteria di backup è insufficiente.
Caricare la batteria di backup.

Unknown Media (A) 1)

Please Change
È stata inserita una scheda di memoria che è stata partizionata 
oppure una scheda di memoria contenente un numero di clip 
superiore al massimo gestibile da questo camcorder.
La scheda non può essere utilizzata nel camcorder e deve essere 
sostituita.

Cannot Use Media (A) 1)

Unsupported File System
È stata inserita una scheda con un file system diverso oppure non 
formattata.
La scheda non può essere utilizzata nel camcorder e deve essere 
sostituita oppure formattata con il camcorder.

Media Error
Media (A) 1) Needs to be Restored

Si è verificato un errore sulla scheda di memoria e la scheda deve 
essere ripristinata.
Ripristinare la scheda di memoria.
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Messaggio sul mirino Causa e soluzione

Media Error
Cannot Record to Media (A) 1)

La scheda di memoria potrebbe essere danneggiata e non può 
essere utilizzata per la registrazione.
La riproduzione è possibile, è consigliabile quindi eseguire una 
copia e sostituire la scheda di memoria.

Media Error
Cannot Use Media (A) 1)

La scheda di memoria potrebbe essere danneggiata e non può 
essere utilizzata per la registrazione o la riproduzione.
La scheda non può essere utilizzata nel camcorder e deve essere 
sostituita.

Media (A) 1) Error
Recording Halted
Playback Halted

La registrazione e la riproduzione sono state arrestate a causa di un 
errore durante l’utilizzo della scheda di memoria.
Se il problema persiste, sostituire la scheda di memoria.

Media Reached Rewriting Limit
Change Media (A) 1)

La scheda di memoria ha raggiunto la fine della sua vita utile.
Eseguire un backup e sostituire la scheda immediatamente. Se si 
continua a utilizzare la scheda è possibile che la scheda non 
consenta più l’esecuzione di registrazioni o riproduzioni.
Per ulteriori informazioni, consultare le istruzioni per l’uso della 
scheda di memoria.

Fan Stopped La ventola di raffreddamento si è arrestata.
Evitare l’utilizzo a temperature elevate. Scollegare l’alimentazione e 
contattare il rappresentante di assistenza tecnica Sony.

Invalid setting value was reset:
Media/Clip Naming/Camera Position
Please save All File again

Le impostazioni di formato di Clip Naming sono state ripristinate 
perché è stato caricato un file ALL non valido.
Configurare le impostazioni di formato desiderate e provare a 
salvare il file ALL di nuovo.

1)	 Per la scheda dello slot B è visualizzato “(B)”.
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Impostazioni salvate in file
Si: impostazione salvata
No: impostazione non salvata

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Camera ISO/Gain/EI Mode Sì Sì

ISO/Gain<H> Sì Sì

ISO/Gain<M> Sì Sì

ISO/Gain<L> Sì Sì

Exposure Index<H> Sì Sì

Exposure Index<M> Sì Sì

Exposure Index<L> Sì Sì

Shockless Gain Sì Sì

ND Filter Preset1 Sì Sì

Preset2 Sì Sì

Preset3 Sì Sì

Auto Exposure Level Sì Sì

Mode Sì Sì

Speed Sì Sì

AGC Sì Sì

AGC Limit Sì Sì

Auto ND Filter Sì Sì

Auto Shutter Sì Sì

A.SHT Limit Sì Sì

Clip High light Sì Sì

Detect Window Sì Sì

Detect Window Indication Sì Sì

Focus Focus Area Sì No

Focus Area (Push AF) Sì No

AF Assist Sì No

Shutter Mode Sì Sì

Shutter Speed Sì Sì

Shutter Angle Sì Sì

ECS Frequency Sì Sì

Color Bars Setting No No

Type Sì No

Noise Suppression Setting Sì Sì

Level Sì Sì

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Camera Flicker Reduce Mode Sì No

Frequency Sì No

SteadyShot Setting Sì No

Handle Zoom Zoom Speed Type Sì No

Zoom Speed Sì No

Auto Black Balance Auto Black Balance – –

AF Micro Adjustment Setting No No

Amount No No

Clear All – –

Video Light Set Video Light Set Sì No

Paint White Preset White Sì Sì

Color Temp <A> Sì Sì

Color Temp Balance <A> Sì Sì

R Gain <A> Sì Sì

B Gain <A> Sì Sì

Color Temp <B> Sì Sì

Color Temp Balance <B> Sì Sì

R Gain <B> Sì Sì

B Gain <B> Sì Sì

Filter White Memory Sì No

Shockless White Sì Sì

White Switch<B> Sì No

ATW Speed Sì Sì

Offset White Offset White <A> Sì Sì

Warm Cool <A> Sì Sì

Warm Cool Balance <A> Sì Sì

Offset White <B> Sì Sì

Warm Cool <B> Sì Sì

Warm Cool Balance <B> Sì Sì

Offset White<ATW> Sì Sì

Warm Cool<ATW> Sì Sì

Warm Cool Balance<ATW> Sì Sì
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Paint Black Setting Sì Sì

Master Black Sì Sì

R Black Sì Sì

B Black Sì Sì

Gamma Setting Sì Sì

Step Gamma Sì Sì

Master Gamma Sì Sì

R Gamma Sì Sì

G Gamma Sì Sì

B Gamma Sì Sì

Gamma Category Sì Sì

Gamma Select Sì Sì

Black Gamma Setting Sì Sì

Range Sì Sì

Master Black Gamma Sì Sì

Knee Setting Sì Sì

Auto Knee Sì Sì

Point Sì Sì

Slope Sì Sì

Knee Saturation Sì Sì

Knee Saturation Level Sì Sì

White Clip Setting Sì Sì

Level Sì Sì

Detail Setting Sì Sì

Level Sì Sì

H/V Ratio Sì Sì

Crispening Sì Sì

Level Depend Sì Sì

Level Depend Level Sì Sì

Frequency Sì Sì

Knee Aperture Sì Sì

Knee Aperture Level Sì Sì

Limit Sì Sì

White Limit Sì Sì

Black Limit Sì Sì

V Black Limit Sì Sì

V Detail Creation Sì Sì

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Paint Skin Detail Setting Sì Sì

Area Detection – –

Area Indication No No

Level Sì Sì

Saturation Sì Sì

Hue Sì Sì

Width Sì Sì

Aperture Setting Sì Sì

Level Sì Sì

Matrix Setting Sì Sì

Adaptive Matrix Sì Sì

Preset Matrix Sì Sì

Preset Select Sì Sì

User Matrix Sì Sì

Level Sì Sì

Phase Sì Sì

User Matrix R-G Sì Sì

User Matrix R-B Sì Sì

User Matrix G-R Sì Sì

User Matrix G-B Sì Sì

User Matrix B-R Sì Sì

User Matrix B-G Sì Sì

Multi Matrix Setting Sì Sì

Area Indication No No

Color Detection – –

Axis No No

Hue Sì Sì

Saturation Sì Sì

Maintenance Test Saw Sì No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Audio Audio Input CH1 Input Select Sì No

CH2 Input Select Sì No

CH3 Input Select Sì No

CH4 Input Select Sì No

INPUT1 MIC Reference Sì No

INPUT2 MIC Reference Sì No

CH1 Wind Filter Sì No

CH2 Wind Filter Sì No

CH3 Wind Filter Sì No

CH4 Wind Filter Sì No

CH3 Level Control Sì No

CH4 Level Control Sì No

CH3 Input Level Sì No

CH4 Input Level Sì No

Audio Input Level Sì No

Limiter Mode Sì No

CH1&2 AGC Mode Sì No

CH3&4 AGC Mode Sì No

AGC Spec Sì No

1kHz Tone on Color Bars Sì No

CH1 Level Sì No

CH2 Level Sì No

CH3 Level Sì No

CH4 Level Sì No

Audio Output Monitor CH Sì No

Monitor Volume Sì No

Headphone Out Sì No

Alarm Volume Sì No

Output Limiter Sì No

HDMI Output CH Sì No

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Video Output On/Off SDI Sì No

HDMI Sì No

Output Format SDI Sì No

HDMI Sì No

REF No No

Output Setting HDMI Target Device Sì No

Output Color Space Sì No

4K/2K to HD Conv. Sì No

Monitor LUT Category Sì No

LUT Select Sì No

Look Profile Select Sì No

User 3D LUT Select Sì No

SDI1 & Internal Rec Sì No

SDI2 Sì No

HDMI Sì No

Viewfinder Sì No

Output Display SDI2 Sì No

HDMI Sì No

VF VF Setting Brightness Sì No

Color Mode Sì No

Peaking Setting Sì No

Peaking Type Sì No

Frequency Sì No

Normal Peaking Level Sì No

Color Sì No

Color Peaking Level Sì No

Zebra Setting Sì No

Zebra Select Sì No

Zebra1 Level Sì No

Zebra1 Aperture Level Sì No

Zebra2 Level Sì No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

VF Marker Setting Sì No

Color Sì No

Center Maker Sì No

Safety Zone Sì No

Safety Area Sì No

Aspect Marker Sì No

Aspect Mask Sì No

Aspect Safety Zone Sì No

Aspect Safety Area Sì No

Aspect Select Sì No

User Box Sì No

User Box Width Sì No

User Box Height Sì No

User Box H Position Sì No

User Box V Position Sì No

100% Marker Sì No

Guide Frame Sì No

Display On/Off Setting Sì No

Shutter Setting Sì No

ND Filter Value Sì No

Gain Setting Sì No

Rec/Play Status Sì No

HXR-IFR5 Rec Control Sì No

Color Temp. Sì No

Frame Rate / Interval Sì No

Battery Remain Sì No

Timecode Sì No

Audio Manual Sì No

Audio Level Meter Sì No

Media Status Sì No

Focus Position Sì No

Iris Position Sì No

Zoom Position Sì No

SteadyShot Sì No

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

VF Display On/Off Focus Mode Sì No

Focus Area Indicator Sì No

Focus Area Ind. (Push AF) Sì No

Focus Indicator Sì No

Auto Shutter Sì No

AGC Sì No

Auto ND Filter Sì No

Auto Iris Sì No

AE Mode Sì No

Auto Exposure Level Sì No

White Balance Mode Sì No

SDI/HDMI Rec Control Sì No

Rec Format Sì No

Gamma Sì No

Timecode Lock Sì No

Wi-Fi Condition Sì No

Clip Name Sì No

Focus Assist Indicator Sì No

Focus Area Marker Sì No

Video Level Warning Sì No

Clip Number Sì No

GPS Sì No

Level Gauge Sì No

Lens Info Sì No

Notice Message Sì No

Video Signal Monitor Setting Sì No

Source Sì No

TC/UB Timecode Mode Sì No

Run Sì No

Setting No No

Reset – –

TC Format Sì No

TC Display Display Select Sì No

User Bits Mode Sì No

Setting No No

HDMI TC Out Setting Sì No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Recording S&Q Motion Setting Sì No

High Frame Rate Mode Sì No

Frame Rate Sì No

Interval Rec Setting No No

Interval Time Sì No

Number of Frames Sì No

Pre-Lighting Sì No

Picture Cache Rec Setting Sì No

Cache Rec Time Sì No

Simul Rec Setting Sì No

Rec Button Set Sì No

SDI/HDMI Rec Control Setting Sì No

Thumbnail Display Clip Properties – –

Set Index Picture – –

Thumbnail View Essence Mark Thumbnail – –

Clip Thumbnail – –

Set Shot Mark Add Shot Mark1 – –

Delete Shot Mark1 – –

Add Shot Mark2 – –

Delete Shot Mark2 – –

Set Clip Flag Add OK – –

Add NG – –

Add KEEP – –

Delete Clip Flag – –

Lock/Unlock Clip Select Clip – –

Lock All Clips – –

Unlock All Clips – –

Delete Clip Select Clip – –

All Clips – –

Filter Clips OK – –

NG – –

KEEP – –

None – –

Customize View Thumbnail Caption Sì Sì

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Media Update Media Media(A) – –

Media(B) – –

Format Media Media(A) – –

Media(B) – –

SD Card – –

Clip Auto Naming Sì No

Camera ID Sì No

Reel Number Sì No

Camera Position Sì No

Title Prefix Sì No

Number Set No No

File All File Load SD Card – –

Save SD Card – –

File ID Sì No

Scene File Recall Internal Memory – –

Store Internal Memory – –

Load SD Card – –

Save SD Card – –

File ID No Sì

Scene White Data Sì No

User Menu Item Load SD Card – –

Save SD Card – –

File ID No No

User Gamma Current Settings – –

Load SD Card – –

Reset – –

Monitor LUT Current Settings – –

Load SD Card – –

Reset – –

Monitor 3D LUT Current Settings – –

Load SD Card – –

Reset – –

Lens File White Offset R No No

White Offset B No No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

System Base Setting Shooting Mode Sì No

Color Space Sì No

Imager Scan Mode Sì No

Rec/Out EI Applied Sì No

Codec Select Sì No

Rec Format Video Format Sì No

RAW Output Format Sì No

Genlock Reference – –

Assignable Button <1> Sì No

<2> Sì No

<3> Sì No

<4> Sì No

<5> Sì No

<6> Sì No

<7> Sì No

<8> Sì No

<9> Sì No

<10> Sì No

Assignable Dial Assignable Dial Sì No

IRIS Dial Sì No

Assignable Dial Direction Sì No

IRIS Dial Direction Sì No

ND Dial ND Dial Direction Sì No

Rec Lamp Rec Lamp Sì No

Fan Control Setting Sì No

HOLD Switch Setting With Rec Button Sì No

With Hand Grip Remote Sì No

Lens Zoom Ring Direction Sì No

Distortion Comp. Sì No

Language Select Sì No

Clock Set Time Zone Sì No

Date Mode Sì No

12H/24H Sì No

Date No No

Time No No

Country NTSC/PAL Area Sì No

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

System Hours Meter Hours (System) – –

Hours (Reset) – –

Reset – –

Basic Authentication User Name No No

Password No No

Wi-Fi Wi-Fi Sì No

SSID & Password – –

Wi-Fi Direct Connection – –

Client – –

IP Address – –

Subnet Mask – –

MAC Address – –

Regenerate Password – –

GPS GPS Sì No

IR Remote Setting Sì No

Camera Battery Alarm Low BATT Sì No

BATT Empty Sì No

Camera DC IN Alarm DC Low Voltage1 Sì No

DC Low Voltage2 Sì No

Ext.  Unit Battery Alarm Near End:Info Battery Sì No

End:Info Battery Sì No

Near End:Sony Battery Sì No

End:Sony Battery Sì No

Near End:Other Battery Sì No

End:Other Battery Sì No

Detected Battery No No

Ext.  Unit DC IN Alarm DC Low Voltage1 Sì No

DC Low Voltage2 Sì No

All Reset Reset – –

APR APR – –

Camera Config HD/2K Modulation Sì No

Version Number – –

Version Up – –

Lens Version Number – –

Lens Version Up – –

Ext.  Unit Version Number – –

Ext.  Unit Version Up – –
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Diagrammi a blocchi
Fare riferimento alle voci relative in “Impostazione dell’audio da registrare” (pagina 36) e “Elenco delle 
voci del menu di configurazione” (pagina 53).
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*	 Impostare su MAN con ingresso audio da adattatore XLR.
 

Audio Input (CH3&CH4)
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*	 Impostare su Manual con ingresso audio da adattatore XLR.
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Aggiornamento del software di un obiettivo con innesto E-mount
Il camcorder consente di aggiornare il software di 
obiettivi con innesto E-mount.
Fare riferimento al sito Web dell’obiettivo per 
informazioni sugli obiettivi che possono essere 
aggiornati e per ottenere il necessario firmware.

Verifica della versione

1	 Montare un obiettivo E-mount sul camcorder 
(pagina 18).

2	 Selezionare Version nel menu System per 
visualizzare Lens Version Number 
(pagina 81).
Il numero della versione dell’obiettivo E-mount 
viene visualizzato sul lato.

Aggiornamento del software

1	 Collegare l’adattatore CA (pagina 13).

	 [Nota]
	 Si consiglia l’utilizzo con una batteria completamente 
carica.

2	 Montare un obiettivo E-mount sul camcorder 
(pagina 18).

3	 Formattare una scheda SD con il camcorder 
(pagina 26).

4	 Copiare il software Windows di aggiornamento 
(con estensione “.exe”) nella cartella radice della 
scheda SD, quindi inserire la scheda SD nello 
slot UTILITY SD del camcorder (pagina 26).

5	 Selezionare Execute in Version >Lens Version 
Up nel menu System (pagina 81).
Viene visualizzato un messaggio di conferma.

6	 Selezionare Execute.
Si avviano le preparazioni per l’aggiornamento 
della versione. Al termine della preparazione, 
appare un messaggio di conferma.

7	 Selezionare Execute.
L’aggiornamento della versione viene eseguito. 
Al termine della procedura di aggiornamento 
della versione viene visualizzato il messaggio 
di conferma “Lens Version Up OK”.

8	 Spegnere il camcorder.

[Note]
ˎˎ Attendere sempre la conclusione della procedura di 

aggiornamento prima di eseguire le seguenti operazioni:
–– Espulsione della scheda SD
–– Rimozione dell’obiettivo
–– Spegnimento dell’alimentazione

ˎˎ Se viene visualizzato il messaggio “Lens Version Up NG”, 
controllare i contenuti del messaggio visualizzato e 
provare a ripetere la procedura di aggiornamento.
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Licenze
Licenza MPEG-4 AVC Patent Portfolio

QUESTO PRODOTTO È SOGGETTO A LICENZA AVC 
PATENT PORTFOLIO PER USO PERSONALE E NON 
COMMERCIALE DEL CLIENTE O ALTRI USI PER I 
QUALI NON SI RICEVE ALCUN COMPENSO PER
(i)	 CODIFICARE VIDEO IN CONFORMITÀ ALLO 

STANDARD AVC (“AVC VIDEO”) E/O
(ii)	DECODIFICARE VIDEO AVC CODIFICATO DA UN 

CLIENTE IMPEGNATO IN ATTIVITÀ PERSONALE 
E/O OTTENUTO DA UN PROVIDER VIDEO CON 
LICENZA PER FORNIRE VIDEO AVC.

NESSUNA LICENZA È CONCESSA O È DA 
RITENERSI IMPLICITA PER ALTRO USO. ULTERIORI 
INFORMAZIONI SONO DISPONIBILI PRESSO MPEG 
LA, L.L.C. VISITARE IL SITO
HTTP://WWW.MPEGLA.COM

Ottenere software sotto licenza GPL/
LGPL

Questo prodotto utilizza software a cui si applicano 
le licenze GPL/LGPL. Questa nota ha lo scopo 
di informare l’utente del suo diritto di accesso, 
modifica e ridistribuzione del codice sorgente per 
tali programmi software secondo le condizioni 
stabilite dalle licenze GPL/LGPL.
Il codice sorgente è fornito su Internet. Per il 
download, utilizzare il seguente URL e seguire le 
istruzioni.
http://www.sony.net/Products/Linux/common/
search.html

Preferiremmo non essere contattati relativamente 
al contenuto del codice sorgente.

Per i contenuti di queste licenze, vedere “License1.
pdf” nella cartella “License” del CD-ROM fornito.

Per visualizzare i file PDF deve essere installato 
Adobe Reader sul computer.
Se Adobe Reader non è installato sul computer, è 
possibile scaricarlo accedendo al seguente URL.
http://get.adobe.com/reader/

CONTRATTO DI LICENZA PER L’UTENTE 
FINALE
IMPORTANT: 
BEFORE USING THE SOFTWARE CONTAINED IN 
THE SOLID STATE MEMORY CAMCORDER, PLEASE 
READ THIS END USER LICENSE AGREEMENT (“EULA”) 
CAREFULLY.  BY USING THE SOFTWARE YOU ARE 
ACCEPTING THE TERMS OF THIS EULA.  IF YOU DO 
NOT ACCEPT THE TERMS OF THIS EULA, YOU MAY 
NOT USE THE SOFTWARE.

This EULA is a legal agreement between you and 
Sony Corporation (“SONY”).  This EULA governs 
your rights and obligations regarding the software 
of SONY and/or its third party licensors (including 
SONY’s affiliates) and their respective affiliates 
(collectively, the “THIRD-PARTY SUPPLIERS”) contained 
in the wireless adapter, together with any updates/ 
upgrades provided by SONY, any printed, on-line or 
other electronic documentation for such software, 
and any data files created by operation of such 
software (collectively, the “SOFTWARE”).

Notwithstanding the foregoing, any software in 
the SOFTWARE having a separate end user license 
agreement (including, but not limited to, GNU 
General Public license and Lesser/Library General 
Public License) shall be covered by such applicable 
separate end user license agreement in lieu of the 
terms of this EULA to the extent required by such 
separate end user license agreement (“EXCLUDED 
SOFTWARE”).

SOFTWARE LICENSE
The SOFTWARE is licensed, not sold.  The SOFTWARE 
is protected by copyright and other intellectual 
property laws and international treaties.

COPYRIGHT
All right and title in and to the SOFTWARE (including, 
but not limited to, any images, photographs, 
animation, video, audio, music, text and “applets” 
incorporated into the SOFTWARE) is owned by SONY 
or one or more of the THIRD-PARTY SUPPLIERS.

GRANT OF LICENSE
SONY grants you a limited license to use the 
SOFTWARE solely in connection with the wireless 
adapter and only for your individual use.  SONY and 
the THIRD-PARTY SUPPLIERS expressly reserve all 
rights, title and interest (including, but not limited 
to, all intellectual property rights) in and to the 
SOFTWARE that this EULA does not specifically grant 
to you.

REQUIREMENTS AND LIMITATIONS
You may not copy, publish, adapt, redistribute, 
attempt to derive source code, modify, reverse 
engineer, decompile, or disassemble any of the 
SOFTWARE, whether in whole or in part, or create 
any derivative works from or of the SOFTWARE unless 
such derivative works are intentionally facilitated 
by the SOFTWARE.  You may not modify or tamper 
with any digital rights management functionality of 
the SOFTWARE.  You may not bypass, modify, defeat 
or circumvent any of the functions or protections 
of the SOFTWARE or any mechanisms operatively 
linked to the SOFTWARE.  You may not separate any 
individual component of the SOFTWARE for use on 
more than one wireless adapter unless expressly 
authorized to do so by SONY.  You may not remove, 
alter, cover or deface any trademarks or notices 
on the SOFTWARE.  You may not share, distribute, 
rent, lease, sublicense, assign, transfer or sell the 
SOFTWARE.  The software, network services or 
other products other than SOFTWARE upon which 
the SOFTWARE’S performance depends might be 
interrupted or discontinued at the discretion of the 
suppliers (software suppliers, service suppliers, or 
SONY).  SONY and such suppliers do not warrant that 

the SOFTWARE, network services, contents or other 
products will continue to be available, or will operate 
without interruption or modification. 

EXCLUDED SOFTWARE AND OPEN SOURCE 
COMPONENTS
Notwithstanding the foregoing limited license 
grant, you acknowledge that the SOFTWARE may 
include EXCLUDED SOFTWARE.  Certain EXCLUDED 
SOFTWARE may be covered by open source 
software licenses (“Open Source Components”), 
which means any software licenses approved as 
open source licenses by the Open Source Initiative 
or any substantially similar licenses, including but 
not limited to any license that, as a condition of 
distribution of the software licensed under such 
license, requires that the distributor make the 
software available in source code format.  If and to 
the extent disclosure is required, please visit www.
sony.com/linux or other SONY-designated web site 
for a list of applicable OPEN SOURCE COMPONENTS 
included in the SOFTWARE from time to time, and 
the applicable terms and conditions governing its 
use.  Such terms and conditions may be changed 
by the applicable third party at any time without 
liability to you.  To the extent required by the licenses 
covering EXCLUDED SOFTWARE, the terms of such 
licenses will apply in lieu of the terms of this EULA.  
To the extent the terms of the licenses applicable to 
EXCLUDED SOFTWARE prohibit any of the restrictions 
in this EULA with respect to such EXCLUDED 
SOFTWARE, such restrictions will not apply to such 
EXCLUDED SOFTWARE.  To the extent the terms of 
the licenses applicable to Open Source Components 
require SONY to make an offer to provide source 
code in connection with the SOFTWARE, such offer is 
hereby made. 

USE OF SOFTWARE WITH COPYRIGHTED 
MATERIALS
The SOFTWARE may be capable of being used 
by you to view, store, process and/or use content 
created by you and/or third parties.  Such content 
may be protected by copyright, other intellectual 
property laws, and/or agreements.  You agree 
to use the SOFTWARE only in compliance with 
all such laws and agreements that apply to such 
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content.  You acknowledge and agree that SONY 
may take appropriate measures to protect the 
copyright of content stored, processed or used by 
the SOFTWARE.  Such measures include, but are not 
limited to, counting the frequency of your backup 
and restoration through certain SOFTWARE features, 
refusal to accept your request to enable restoration 
of data, and termination of this EULA in the event of 
your illegitimate use of the SOFTWARE. 

CONTENT SERVICE 
PLEASE ALSO NOTE THAT THE SOFTWARE MAY BE 
DESIGNED TO BE USED WITH CONTENT AVAILABLE 
THROUGH ONE OR MORE CONTENT SERVICES 
(“CONTENT SERVICE”).  USE OF THE SERVICE AND 
THAT CONTENT IS SUBJECT TO THE TERMS OF SERVICE 
OF THAT CONTENT SERVICE.  IF YOU DECLINE TO 
ACCEPT THOSE TERMS, YOUR USE OF THE SOFTWARE 
WILL BE LIMITED.  You acknowledge and agree that 
certain content and services available through the 
SOFTWARE may be provided by third parties over 
which SONY has no control.  USE OF THE CONTENT 
SERVICE REQUIRES AN INTERNET CONNECTION.  THE 
CONTENT SERVICE MAY BE DISCONTINUED AT ANY 
TIME.

INTERNET CONNECTIVITY AND THIRD PARTY 
SERVICES
You acknowledge and agree that access to certain 
SOFTWARE features may require an Internet 
connection for which you are solely responsible.  
Further, you are solely responsible for payment of 
any third party fees associated with your Internet 
connection, including but not limited to Internet 
service provider or airtime charges.  Operation of the 
SOFTWARE may be limited or restricted depending 
on the capabilities, bandwidth or technical 
limitations of your Internet connection and service.  
The provision, quality and security of such Internet 
connectivity are the sole responsibility of the third 
party providing such service. 

EXPORT AND OTHER REGULATIONS
You agree to comply with all applicable export and 
re-export restrictions and regulations of the area 
or country in which you reside, and not to transfer, 
or authorize the transfer, of the SOFTWARE to a 

prohibited country or otherwise in violation of any 
such restrictions or regulations.

HIGH RISK ACTIVITIES
The SOFTWARE is not fault-tolerant and is not 
designed, manufactured or intended for use or 
resale as on-line control equipment in hazardous 
environments requiring fail-safe performance, 
such as in the operation of nuclear facilities, aircraft 
navigation or communication systems, air traffic 
control, direct life support machines, or weapons 
systems, in which the failure of the SOFTWARE could 
lead to death, personal injury, or severe physical or 
environmental damage (“HIGH RISK ACTIVITIES”).  
SONY, each of the THIRD-PARTY SUPPLIERS, and each 
of their respective affiliates specifically disclaim any 
express or implied warranty, duty or condition of 
fitness for HIGH RISK ACTIVITIES.

EXCLUSION OF WARRANTY ON SOFTWARE
You acknowledge and agree that use of the 
SOFTWARE is at your sole risk and that you 
are responsible for use of the SOFTWARE.  The 
SOFTWARE is provided “AS IS,” without warranty, duty 
or condition of any kind.

SONY AND EACH OF THE THIRD-PARTY SUPPLIERS 
(for purposes of this Section, SONY and each of 
the THIRD-PARTY SUPPLIERS shall be collectively 
referred to as “SONY”) EXPRESSLY DISCLAIM ALL 
WARRANTIES, DUTIES OR CONDITIONS, EXPRESS 
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY, 
NONINFRINGEMENT AND FITNESS FOR A PARTICULAR 
PURPOSE.  SONY DOES NOT WARRANT OR MAKE ANY 
CONDITIONS OR REPRESENTATIONS (A) THAT THE 
FUNCTIONS CONTAINED IN ANY OF THE SOFTWARE 
WILL MEET YOUR REQUIREMENTS OR THAT THEY 
WILL BE UPDATED, (B) THAT THE OPERATION OF ANY 
OF THE SOFTWARE WILL BE CORRECT OR ERROR-
FREE OR THAT ANY DEFECTS WILL BE CORRECTED, 
(C) THAT THE SOFTWARE WILL NOT DAMAGE ANY 
OTHER SOFTWARE, HARDWARE OR DATA, (D) THAT 
ANY SOFTWARE, NETWORK SERVICES (INCLUDING 
THE INTERNET) OR PRODUCTS (OTHER THAN 
THE SOFTWARE) UPON WHICH THE SOFTWARE’S 
PERFORMANCE DEPENDS WILL CONTINUE TO BE 

AVAILABLE, UNINTERRUPTED OR UNMODIFIED, AND 
(E) REGARDING THE USE OR THE RESULTS OF THE USE 
OF THE SOFTWARE IN TERMS OF ITS CORRECTNESS, 
ACCURACY, RELIABILITY, OR OTHERWISE. 

NO ORAL OR WRITTEN INFORMATION OR ADVICE 
GIVEN BY SONY OR AN AUTHORIZED REPRESENTATIVE 
OF SONY SHALL CREATE A WARRANTY, DUTY OR 
CONDITION OR IN ANY WAY INCREASE THE SCOPE OF 
THIS WARRANTY.  SHOULD THE SOFTWARE PROVE 
DEFECTIVE YOU ASSUME THE ENTIRE COST OF ALL 
NECESSARY SERVICING, REPAIR OR CORRECTION.  
SOME JURISDICTIONS DO NOT ALLOW THE 
EXCLUSION OF IMPLIED WARRANTIES, SO THESE 
EXCLUSIONS MAY NOT APPLY TO YOU.

LIMITATION OF LIABILITY
SONY AND EACH OF THE THIRD-PARTY SUPPLIERS 
(for purposes of this Section, SONY and each of 
the THIRD-PARTY SUPPLIERS shall be collectively 
referred to as “SONY”) SHALL NOT BE LIABLE FOR ANY 
INCIDENTAL OR CONSEQUENTIAL DAMAGES FOR 
BREACH OF ANY EXPRESS OR IMPLIED WARRANTY, 
BREACH OF CONTRACT, NEGLIGENCE, STRICT 
LIABILITY OR UNDER ANY OTHER LEGAL THEORY 
RELATED TO THE SOFTWARE, INCLUDING, BUT NOT 
LIMITED TO, ANY DAMAGES ARISING OUT OF LOSS 
OF PROFITS, LOSS OF REVENUE, LOSS OF DATA, LOSS 
OF USE OF THE SOFTWARE OR ANY ASSOCIATED 
HARDWARE, DOWN TIME AND USER’ S TIME, EVEN 
IF ANY OF THEM HAVE BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES.  IN ANY CASE, EACH 
AND ALL OF THEIR AGGREGATE LIABILITY UNDER ANY 
PROVISION OF THIS EULA SHALL BE LIMITED TO THE 
AMOUNT ACTUALLY PAID FOR THE PRODUCT.  SOME 
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR 
LIMITATION OF INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THE ABOVE EXCLUSION OR LIMITATION 
MAY NOT APPLY TO YOU.

CONSENT TO USE OF NON-PERSONAL 
INFORMATION, LOCATION DATA, DATA 
SECURITY
You acknowledge and agree that SONY and its 
affiliates, partners and agents may read, collect, 
transfer, process and store certain information 
collected from the SOFTWARE, including but not 

limited to information about (i) the SOFTWARE and 
(ii) the software applications, contents and peripheral 
devices that interact with your wireless adapter and 
the SOFTWARE (“Information”).  Information includes, 
but is not limited to: (1) unique identifiers relating 
to your wireless adapter and its components; (2) 
performance of the wireless adapter, the SOFTWARE 
and their components; (3) configurations of your 
wireless adapter, the SOFTWARE and the software 
applications, contents and peripheral devices 
that interact with the wireless adapter and the 
SOFTWARE; (4) use and frequency of use of the 
functions of (x) the SOFTWARE, and (y) the software 
applications, contents and peripheral devices that 
interact with the SOFTWARE; and (5) location data, 
as indicated below.  SONY and its affiliates, partners 
and agents may use and disclose Information subject 
to applicable laws in order to improve its products 
and services or to provide products or services to 
you.  Such uses include, but are not limited to: (a) 
administering the functionalities of the SOFTWARE; 
(b) to improve, service, update or upgrade the 
SOFTWARE; (c) improving, developing and enhancing 
the current and future products and services of SONY 
and other parties; (d) to provide you with information 
about the products and services offered by SONY 
and other parties; (e) complying with applicable laws 
or regulations; and (f ) to the extent offered, providing 
you with location-based services of SONY and other 
parties, as indicated below.  In addition, SONY retains 
the right to use Information to protect itself and third 
parties from illegal, criminal or harmful conduct.

Certain services available through the SOFTWARE 
may rely upon location information, including, but 
not limited to, the geographic location of the wireless 
adapter.  You acknowledge that for the purpose 
of providing such services, SONY, the THIRDPARTY 
SUPPLIERS or their partners may collect, archive, process 
and use such location data, and that such services are 
governed by the privacy policies of SONY or such third 
party.  By reviewed the privacy policies applicable to 
such services and consent to such activities. 

SONY, its affiliates, partners and agents will not 
intentionally use Information to personally identify 
the owner or user of the SOFTWARE without your 
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knowledge or consent.  Any use of Information will 
be in accordance with the privacy policies of SONY or 
such third party. 
Please contact applicable contact address of each 
area or country for SONY’ s current privacy policy.  
Please contact applicable third parties for privacy 
policies relating to personally identifiable and other 
information you provide when you use or access 
third party software or services. 

Information may be processed, stored or transferred 
to SONY, its affiliates or agents which are located in 
countries outside of your country of residence.  Data 
protection and information privacy laws in certain 
countries may not offer the same level of protection 
as your country of residence and you may have fewer 
legal rights in relation to Information processed and 
stored in, or transferred to, such countries.  SONY will 
use reasonable efforts to take appropriate technical 
and organizational steps to prevent unauthorized 
access to or disclosure of Information, but does not 
warrant it will eliminate all risk of misuse of such 
Information.

AUTOMATIC UPDATE FEATURE
From time to time, SONY or the THIRD-PARTY 
SUPPLIERS may automatically update or otherwise 
modify the SOFTWARE, including, but not limited to, 
for purposes of enhancement of security functions, 
error correction and improvement of functions, at 
such time as you interact with SONY’ s or third parties’ 
servers, or otherwise.  Such updates or modifications 
may delete or change the nature of features or 
other aspects of the SOFTWARE, including, but 
not limited to, functions you may rely upon.  You 
acknowledge and agree that such activities may 
occur at SONY’ s sole discretion and that SONY may 
condition continued use of the SOFTWARE upon 
your complete installation or acceptance of such 
update or modifications.  Any updates/modifications 
shall be deemed to be, and shall constitute part 
of, the SOFTWARE for purposes of this EULA.  By 
acceptance of this EULA, you consent to such 
update/modification.

ENTIRE AGREEMENT, WAIVER, SEVERABILITY
This EULA and SONY’ s privacy policy, each as 
amended and modified from time to time, together 
constitute the entire agreement between you and 
SONY with respect to the SOFTWARE.  The failure of 
SONY to exercise or enforce any right or provision of 
this EULA shall not constitute a waiver of such right 
or provision.  If any part of this EULA is held invalid, 
illegal, or unenforceable, that provision shall be 
enforced to the maximum extent permissible so as to 
maintain the intent of this EULA, and the other parts 
will remain in full force and effect.

GOVERNING LAW AND JURISDICTION
The United Nations Convention on Contracts for the 
International Sale of Goods shall not apply to this 
EULA.  This EULA shall be governed by the laws of 
Japan, without regards to conflict of laws provisions.  
Any dispute arising out of this EULA shall be subject 
to the exclusive venue of the Tokyo District Court in 
Japan, and the parties hereby consent to the venue 
and jurisdiction of such courts.

EQUITABLE REMEDIES
Notwithstanding anything contained in this EULA 
to the contrary, you acknowledge and agree that 
any violation of or noncompliance with this EULA 
by you will cause irreparable harm to SONY, for 
which monetary damages would be inadequate, 
and you consent to SONY obtaining any injunctive 
or equitable relief that SONY deems necessary or 
appropriate in such circumstances.  SONY may also 
take any legal and technical remedies to prevent 
violation of and/or to enforce this EULA, including, 
but not limited to, immediate termination of your 
use of the SOFTWARE, if SONY believes in its sole 
discretion that you are violating or intend to violate 
this EULA.  These remedies are in addition to any 
other remedies SONY may have at law, in equity or 
under contract.

TERMINATION
Without prejudice to any of its other rights, SONY 
may terminate this EULA if you fail to comply with 
any of its terms.  In case of such termination, you 
must: (i) cease all use, and destroy any copies, of the 

SOFTWARE; (ii) comply with the requirements in the 
section below entitled “Your Account Responsibilities”.

AMENDMENT
SONY RESERVES THE RIGHT TO AMEND ANY OF THE 
TERMS OF THIS EULA AT ITS SOLE DISCRETION BY 
POSTING NOTICE ON A SONY DESIGNATED WEB SITE, 
BY EMAIL NOTIFICATION TO AN EMAIL ADDRESS 
PROVIDED BY YOU, BY PROVIDING NOTICE AS PART 
OF THE PROCESS IN WHICH YOU OBTAIN UPGRADES/ 
UPDATES OR BY ANY OTHER LEGALLY RECOGNIZABLE 
FORM OF NOTICE.  If you do not agree to the 
amendment, you should promptly contact SONY for 
instructions.  Your continued use of the SOFTWARE 
after the effective date of any such notice shall be 
deemed your agreement to be bound by such 
amendment.

THIRD-PARTY BENEFICIARIES
Each THIRD-PARTY SUPPLIER is an express intended 
thirdparty beneficiary of, and shall have the right to 
enforce, each provision of this EULA with respect to 
the SOFTWARE of such party. 

Should you have any questions concerning this 
EULA, you may contact SONY by writing to SONY at 
applicable contact address of each area or country.

Copyright © 2012 Sony Corporation.

Licenze Open Software

Sulla base degli accordi di licenza fra Sony e i 
detentori dei diritti di copyright del software, 
questo prodotto utilizza software aperto.
Per soddisfare i requisiti stabiliti dai detentori dei 
diritti di copyright sul software, Sony è tenuta a 
informare gli utenti del contenuto di dette licenze.
Per i contenuti di queste licenze, vedere “License1.
pdf” nella cartella “License” del CDROM fornito.



000 7. Appendice107

Specifiche tecniche
Generale

Peso	 Circa 2,0 kg (solo corpo)
Dimensioni (Unità: mm, solo corpo) 1)

159

245,5

247

 
1)	 Le dimensioni indicate sono approssimative.

Requisiti di alimentazione
	 12 Vcc (da 11 Vcc a 16,5 Vcc)
Potenza assorbita
	 Circa 19 W (corpo, obiettivo, registrazione 

XAVC-I QFHD 59.94P, mirino 
acceso)

	 Circa 22 W (corpo, obiettivo, registrazione 
XAVC-I QFHD 59.94P, mirino 
acceso, dispositivo esterno 
connesso)

Temperatura di funzionamento
	 Da 0 °C a 40 °C
Temperatura di immagazzinamento
	 Da –20 °C a +60 °C
Tempo di funzionamento continuato
	 Circa 1 ora e 15 minuti (con pacco batteria 

BP‑U35)
Formato di registrazione video
	 XAVC Intra
		  AVC/H.264 High 4:2:2 Intra Profile

		  QFHD: VBR, 600 Mbps (max.)
		  4K: VBR, 600 Mbps (max.)
		  HD: CBG, 222 Mbps
	 XAVC Long 
		  AVC/H.264 High Profile
		  QFHD: VBR, 150 Mbps (max.),  

4:2:0 Long
		  HD: VBR, 50 Mbps (max.),  

4:2:2 Long
	 MPEG HD 422 
		  MPEG-2 Long GOP
		  Modalità HD422: CBR, 50 Mbps, 

MPEG‑2 422P@HL
	 ProRes 422 HQ 1)

		  Apple ProRes 422 HQ
		  4:2:2, 10-bit, VBR,  

220 Mbps (max.)
	 ProRes 422 1)

		  Apple ProRes 422
		  4:2:2, 10-bit, VBR,  

147 Mbps (max.)
Formato di registrazione audio
	 LPCM 24 bit, 48 kHz, 4 canali
Frequenza di fotogrammi di registrazione
	 XAVC Intra 
		  4096×2160/59.94P, 50P, 29.97P, 24P, 

23.98P, 25P
		  3840×2160/59.94P, 50P, 29.97P, 23.98P, 

25P
		  1920×1080/59.94P, 50P, 59.94i, 50i, 

29.97P, 23.98P, 25P
	 XAVC Long 
		  3840×2160/59.94P, 50P, 29.97P, 23.98P, 

25P
		  1920×1080/59.94P, 50P, 59.94i, 50i, 

29.97P, 23.98P, 25P
	 MPEG HD 422 
		  1920×1080/59.94i, 50i, 29.97P, 23.98P, 

25P
		  1280×720/59.94P, 50P, 29.97P, 23.98P, 

25P
	 ProRes 422 HQ 1)

		  1920×1080/59.94i, 50i, 29.97P, 25P, 
23.98P

	 ProRes 422 1)

		  1920×1080/59.94i, 50i, 29.97P, 25P, 
23.98P

Tempo di registrazione/riproduzione (usando QD-
G128E)

XAVC Intra 
		  4096×2160/3840×2160
	 59.94P
		  Circa 22 minuti
	 50P
		  Circa 26 minuti
	 29.97P
		  Circa 44 minuti
	 23.98P/24P
		  Circa 55 minuti
	 25P
		  Circa 52 minuti
XAVC Intra 1920×1080 
	 59.94P
		  Circa 59 minuti
	 50P
		  Circa 71 minuti
	 59.94i
		  Circa 118 minuti
	 50i
		  Circa 141 minuti
	 29.97P
		  Circa 118 minuti
	 23.98P
		  Circa 147 minuti
	 25P
		  Circa 141 minuti
	
XAVC Long 3840×2160
	 59.94P/50P
		  Circa 87 minuti
	 29.97P/23.98P/25P
		  Circa 131 minuti
XAVC Long 1920×1080 
	 Modalità 50M
		  Circa 262 minuti
	 Modalità 35M
		  Circa 374 minuti

	 Modalità 25M
		  Circa 524 minuti
	 MPEG HD 422 
		  Circa 262 minuti
ProRes 422 HQ 1)

	 59.94i/29.97P
		  Circa 60 minuti
	 50i/25P
		  Circa 72 minuti
	 23.98P
		  Circa 74 minuti
ProRes 422 1) 	
	 59.94i/29.97P
		  Circa 90 minuti
	 50i/25P
		  Circa 108 minuti
	 23.98P
		  Circa 112 minuti
1)	 Quando è connessa l’unità di estensione XDCA-FS7 

(opzione)

[Nota]
I tempi di registrazione e riproduzione potrebbero variare 
a seconda delle condizioni di utilizzo e delle caratteristiche 
della memoria.

Sezione videocamera

Dispositivo di generazione immagine (tipo)
	 Sensore immagine CMOS equivalente Super 

35
Numero di pixel
	 11,6 Megapixel (totale); 8,8 Megapixel@17:9/ 

8,3 Megapixel@16:9 (effettivi)
Filtri ND interni
	 CLEAR: OFF
	 1: 1/4ND
	 2: 1/16ND
	 3: 1/64ND
	 ND a variazione lineare: Da 1/4ND a 1/128ND
Sensibilità
	 Gamma video: T14 @ 24p
	 (2000 lx, 89,9% riflettanza , 3200K)
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Sensibilità ISO
	 S-Log3 Gamma ISO2000
	 (sorgente luminosa D55)
Illuminazione minima
	 0,7 lx (18dB, 23.98P, otturatore: OFF, ND: Clear, 

F1.4)
Attacco obiettivo
	 E-mount (modello con levetta di blocco)
Latitudine
	 14 stop
Rapporto S/N video
	 57 dB (gamma video/soppressione rumore: 

off )
Velocità otturatore
	 Da 1/3 a 1/9000 sec. (23.98P)
Angolo otturatore
	 Da 5,6° a 300°
Slow & Quick Motion
	 XAVC QFHD: Da 1 a 60P, XAVC HD: Da 1 a 180P
Bilanciamento del bianco
	 Modalità preset (da 2100K a 10000K), modalità 

memoria A, B (da 1500K a 50000K)
Guadagno
	 –3, 0, 3, 6, 9, 12, 18 dB
Curva di gamma
	 STD1, STD2, STD3, STD4, STD5, STD6, HG1, 

HG2, HG3, HG4, HG7, HG8, S-Log2, 
S-Log3, USER1, USER2, USER3, 
USER4, USER5

Sezione audio

Frequenza di campionamento
	 48 kHz
Quantizzazione
	 24 bit
Risposta di frequenza
	 Modalità MIC ingresso XLR: Da 20 Hz a 20 kHz 

(±3 dB o inferiore)
	 Modalità LINE ingresso XLR: Da 20 Hz a 20 kHz 

(±3 dB o inferiore)

Gamma dinamica
	 Modalità MIC ingresso XLR: 80 dB (tipico)
	 Modalità LINE ingresso XLR: 90 dB (tipico)
Distorsione
	 Modalità MIC ingresso XLR: 0,08% o inferiore 

(livello di ingresso –40 dBu)
	 Modalità LINE ingresso XLR: 0,08% o inferiore 

(livello di ingresso +14 dBu)
Altoparlante incorporato
	 Mono
Microfono interno
	 Mono

Sezione ingressi/uscite

Ingressi
INPUT 1/2:
	 Tipo XLR, 3 pin, femmina
	 Selezionabile LINE / MIC / MIC+48V
	 MIC: Riferimento –40, –50, –60 dBu

Uscite
SDI OUT 1/2:
	 Tipo BNC, 0,8 Vp-p, non bilanciato (uscita 3G 

HD/1.5G HD)
	 Conforme a standard SMPTE ST424 Level-A/B, 

SMPTE ST425 Level-A/B, SMPTE 
ST292-1

	 Audio a 4 canali
Cuffie (mini jack stereo):
	 –16 dBu (livello di uscita di riferimento, 

volume di monitoraggio massimo, 
impedenza 16 Ω)

HDMI:
	 Type A, 19 pin

Altro:
DC IN:
	 Conforme a EIAJ, da 11 Vcc a 16,5 Vcc

Connettore dell’unità di estensione:
	 Tipo proprietario (144 pin)
Slitta Multi-interface
	 Tipo proprietario (21 pin)
REMOTE:
	 Tipo sub mini, dia. 2,5, 3 poli
USB:
	 Conforme allo standard 2.0, tipo mini AB per 

memoria di massa (1)
	 Tipo A per connessione W-LAN (1)
VF:
	 Tipo proprietario (40 pin)

Sezione display

Monitor LCD
Dimensione schermo
	 8,8 cm (3,5 pollici) in diagonale
Rapporto di aspetto
	 16:9
Numero di pixel
	 960 (orizz.) × 540 (vert.)

Sezione slot supporti di memoria

Slot schede XQD per registrazione video (2)
Slot scheda SD UTILITY (1)

Accessori forniti

Mirino (dotato di oculare, coppa oculare, asta, 
morsetto)
Paraluce del mirino (1)
Inserto del morsetto a sezione circolare (2)
Impugnatura di telecomando

Modulo LAN wireless USB (IFU-WLM3)
Telecomando a infrarossi (RMT-845)
Adattatore CA/Caricabatterie
Attacco pacco batteria (1)
Cavo di alimentazione (1)
Cavo mini USB (1)
Staffa di montaggio opzione (1)
Coperchietto di protezione del corpo (1)
Coperchietto di protezione del connettore della 
maniglia (incluse due viti M2) (1)
Coperchietti del connettore modulo LAN wireless 
USB (2)
Riserva coperchio del connettore W-LAN (1)
Riserva coperchio del connettore dell’unità di 
estensione (1)
Kit per attacco accessori (attacco accessori (1), 
piastra dell’attacco (1), viti (4))
Gancio per metro a nastro (1)
Prima di usare l’apparecchio (1)
Istruzioni per l’uso (CD-ROM) (1)

Design e le specifiche tecniche passibili di 
cambiamenti senza preavviso.
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ˎˎ SONY NON SARÀ RESPONSABILE DI DANNI 
DI QUALSIASI TIPO RISULTANTI DALLA 
MANCATA IMPLEMENTAZIONE DI MISURE DI 
PROTEZIONE ADEGUATE SUI DISPOSITIVI DI 
TRASMISSIONE,  DA INEVITABILI DIFFUSIONI DI 
DATI RISULTANTI DALLE SPECIFICHE TECNICHE 
DELLA TRASMISSIONE O DA PROBLEMATICHE 
RELATIVE ALLA SICUREZZA DI QUALSIASI TIPO.
ˎˎ Il contenuto trasmesso può essere intercettato 
inconsapevolmente da terze parti non 
autorizzate che si trovano in prossimità dei 
segnali. Quando si utilizza la comunicazione 
LAN wireless, implementare misure di 
protezione per proteggere il contenuto della 
comunicazione.

Note
ˎˎ  Eseguire sempre una registrazione di prova, e 
verificare che il contenuto sia stato registrato 
correttamente. 
LA SONY NON SARÀ RESPONSABILE DI DANNI 
DI QUALSIASI TIPO, COMPRESI, MA SENZA 
LIMITAZIONE A, RISARCIMENTI O RIMBORSI A 
CAUSA DI GUASTI DI QUESTO APPARECCHIO 
O DEI SUOI SUPPORTI DI REGISTRAZIONE, 
SISTEMI DI MEMORIZZAZIONE ESTERNA O 
QUALSIASI ALTRO SUPPORTO O SISTEMA 
DI MEMORIZZAZIONE PER REGISTRARE 
CONTENUTI DI QUALSIASI TIPO.
ˎˎ Verificare sempre che l’apparecchio stia 
funzionando correttamente prima di usarlo. 
LA SONY NON SARÀ RESPONSABILE DI DANNI 
DI QUALSIASI TIPO, COMPRESI, MA SENZA 
LIMITAZIONE A, RISARCIMENTI O RIMBORSI A 
CAUSA DELLA PERDITA DI PROFITTI ATTUALI 
O PREVISTI DOVUTA A GUASTI DI QUESTO 
APPARECCHIO, SIA DURANTE IL PERIODO 
DI VALIDITÀ DELLA GARANZIA SIA DOPO 
LA SCADENZA DELLA GARANZIA, O PER 
QUALUNQUE ALTRA RAGIONE.
ˎˎ SONY NON SARÀ RESPONSABILE PER 
RICHIESTE O RICORSI DI NESSUN TIPO 
PRESENTATI DA UTENTI DI QUESTO APPARATO 
O DA TERZI.
ˎˎ SONY NON SARÀ RESPONSABILE PER LA 
PERDITA, RIPARAZIONE O RIPRODUZIONE 
DEI DATI REGISTRATI SUL SISTEMA DI 
MEMORIZZAZIONE INTERNO, SU SUPPORTI 
DI REGISTRAZIONE, SU SISTEMI DI 
MEMORIZZAZIONE ESTERNI, O SU QUALSIASI 
ALTRO TIPO DI SUPPORTO O SISTEMA DI 
MEMORIZZAZIONE.
ˎˎ SONY NON SARÀ RESPONSABILE PER 
LA CANCELLAZIONE O LA MANCATA 
CONTINUAZIONE PER QUALSIASI CAUSA 
O CIRCOSTANZA DI SERVIZI CORRELATI A 
QUESTO APPARATO.

Prevenzione delle interferenze da 
telefoni cellulari ed altri dispositivi 
wireless

L’uso di telefoni cellulari e dispositivi wireless 
nelle vicinanze del camcorder potrebbe causare 
malfunzionamenti o influenzare negativamente la 
registrazione audio e video. Se possibile, disattivare 
eventuali telefoni cellulari e dispositivi wireless 
presenti nelle vicinanze del camcorder.

Download del software

Quando l’unità viene utilizzata in collegamento 
con un PC, scaricare driver, plug-in e software 
applicativo necessari del dispositivo dai seguenti 
siti web.

Sito web per i prodotti business di Sony:

Stati Uniti	 http://pro.sony.com
Canada 	 http://www.sonybiz.ca
America Latina 	 http://sonypro-latin.com
Europa 	 http://www.pro.sony.eu/pro
Medio oriente,	 http://sony-psmea.com
Africa
Russia 	 http://sony.ru/pro/
Brasile 	 http://sonypro.com.br
Australia 	 http://pro.sony.com.au
Nuova Zelanda 	 http://pro.sony.co.nz
Giappone 	 http://www.sonybsc.com
Asia e Pacifico 	 http://pro.sony-asia.com
Corea 	 http://bp.sony.co.kr
Cina 	 http://pro.sony.com.cn
India 	 http://pro.sony.co.in

Software Sony Creative, pagina di download del 
software:
http://www.sonycreativesoftware.com/download/
software_for_sony_equipment
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Marchi di fabbrica

ˎˎ XDCAM è un marchio di Sony Corporation.
ˎˎ XAVC e  sono marchi registrati di Sony 
Corporation.
ˎˎ XQD e  sono marchi di Sony 
Corporation.
ˎˎ I termini HDMI e HDMI High-Definition 
Multimedia Interface e il logo HDMI sono 
marchi o marchi registrati di HDMI Licensing 
Administrator, Inc. negli Stati Uniti e in altri paesi.

Altri nomi di società o prodotto sono marchi o 
marchi registrati dei rispettivi detentori. In questo 
documento i marchi non sono contrassegnati dai 
simboli TM o ®.
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